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Introduction

What is KBPublisher?

KBPublisher is a knowledge base which allows you to share information with employees,
customers and partners.

A fully featured knowledge base that combines powerful WYSIWYG editing with easy to use
functionality
Unique design and workflow enables you to create and approve articles and files before
they are made available to other users
The separate File feature means that your existing documentation can be easily inserted
Can be integrated into your company intranet or internet
Repeatable, reusable content through templates, file attachments and categories
KBPublisher is highly customizable
Full control of users, what they can do, and what they can see
Can be configured to work in almost any language
Import facility allows you to import users and articles from your old system in bulk
Remote authentication allows you to integrate your current user authentication system
with KB Publisher.
An area to post announcements
Subscription facility allows users to be notified of changes
Version history that allows you to keep track of changes to articles
Export facility allows you to export articles or whole knowledgebase to PDF or html
Reports that provide statistics on users and articles

Public area

Where site visitors, staff read articles, view files, supply/request
feedback
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KBPublisher navigation gives you quick access to:

Articles - read articles in the knowledgebase• 
Files - view attached files• 
News - read announcements• 
Feedback - ability to contact administrator• 
Glossary - a glossary of terms• 
Comments - users can add comments to articles• 
Ratings - users can rate content• 
RSS feeds• 
Email notifications - users can be notified when an item is changed• 

Administration area

Where staff create, edit and publish articles, upload files, moderate the
knowledgebase and manage users

Public area 3
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Where those who prepare and approve the content:

Create articles• 
Have them approved and published (or publish them direct)• 
Schedule them to go live at on a specified date• 
See history of changes to articles and revert back to earlier versions if required• 
Upload files• 
Automatically add any file uploaded to you server to the knowledgebase• 
Moderate feedback• 
Manage comments• 
Bulk import articles from other sources• 
Manage categories• 
Manage users• 
Import users• 
Generate statistical reports• 
Access log files• 
Export articles as PDF or HTML files• 

Administration area 4
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KBPublisher Uses

Attach it to your company web site or use it standalone in order to:

Share information with customers and partners• 
Provide support for products• 
Answer a list of frequently asked questions• 
Create a user manual, technical reference or APIs for your software• 

Use it with your intranet or standalone in order to:

Share information with employees or other team members• 
Set up and use policies and procedures• 
Use it as a support help desk• 
Manage project documents and other content• 
Provide training materials• 
Share other company information• 

The three different category types allow you to display the knowledgebase in a standard
knowledgebase format, as FAQs on a page, or as a table of contents for a book or online help.

KBPublisher is highly customizable. You can use it straight out of the box, or you can customize
it to match your company design and requirements. The ability to create your own categories
means you can organize your topics any way you wish. You also have complete control over
who sees content, and when they see it.

KBPublisher can be pretty much anything you want it to be

It's a knowledgebase

First and foremost, KBPublisher is a knowledgebase. Use it to share knowledge with others.
Articles, white papers, user manuals, business processes, FAQs, online help, APIs and any
other type of information you need to share.

It's a content management system

This user manual was written in KBPublisher.

We created repeatable, reusable chunks of content with templates and inserted them into
articles where needed. We used the link and attach features to link to articles and files. We
used categories to place each article exactly where we wanted it to be in multiple sections of
the manual. We used privileges and types to control who could edit and who could view which
sections of the manual. Had we wanted to, we could have used templates to create standard
page formats to force our authors to use a consistent style throughout. Lastly, we used content
type 'Book' to display the articles as a table of contents.

A help desk

You can use the Feedback option to create a simple help desk request system where the user
logs a support request and you supply an answer either by emailing them back, posting an
answer on the knowledgebase, or both. Other users can add comments to any postings. You
can use the Supervisor function to route different requests to different people to answer. If you
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are really keen (and know a bit about HTML forms), you could set up forms in templates and
have the user post these as help desk requests.
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Public Area (front-end)

The public area in KBPublisher is what people who are reading the articles or looking at the
files see (as opposed to the admin area, which is what authors, editors, moderators and
administrators see).

Whether or not a user has to log in to view the public view depends entirely on how you have
set up your knowledgebase. It can be set up in any of the following ways:

Everyone who accesses your site can read the knowledgebase• 
Anyone who wants to read the knowledgebase must register and login• 
Part of the knowledgebase is available to anyone who visits your site while you must log
on to view other parts.

• 

Below is a screenshot of the public view.

Login details are in the top right-hand corner

If you are a registered user you can login. Once you are logged in this section shows
who you are logged in as, and the option changes to logout. If your login has author,
contributor, editor or administrator privileges, this will also include a link to the admin
view.

If you knowledgebase administrator allows it, you can also register as a user to get
access to non-public areas of the knowledgebase.

This area also contains My Account, which is where you can change your password and
user name, manage subscriptions and personalize some settings.

1. 

Menu options (table of contents) can on the left-hand side, on the top menu or above the listed
articles, depending on how the knowledgebase is set up. In this case, it has been set up so that
menu options are in tabs across the top of the page.

Public Area (front-end) 7
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When you first enter the screen the Knowledgebase tab is highlighted, meaning that
articles are displayed. Articles are content that people have authored directly to the
knowledgebase.

2. 

Click on Downloads to display a list of files instead.  These files have been uploaded
and may be text (e.g. Word documents, PDF files), graphics or other file.

3. 

Click on News to see a full list of news items4. 
Click on Glossary to display items in the glossary. While you are reading articles you
will come across red words. These words have been defined in the glossary.

5. 

Ask a question allows the reader to contact the knowledgebase administrators. You
might do this if, say, you couldn't find the information you were looking for, had
problems using the system, or even if you had an idea for an article.

6. 

Add article

If you have contributor or author access, you will also have an Add article link at the
top of the screen. This allows you to quickly add articles.

7. 

Search

The knowledgebase has both quick search and advanced search. Type text or an article
ID into the search field for a quick search, or you can search on other options using the
advanced search. You can find out more in Search Explained.

The question mark (?) to the right of the search screen is a help tool. Hover your mouse
over the ? to find out more about the field.

8. 

Categories

The Categories section is the table of contents. The user clicks on category items to
see sub-categories. Articles in each category are displayed in the main part of the
screen.

9. 

Breadcrumb trail

The breadcrumb trail at the top of the screen shows you where in the article or file
hierarchy. You can click on this links to move back to a higher level.

10. 

The actual content is in the main screen

News is displayed at the top of the screen11. 
Categories may also be displayed on the main screen. They can be on the left menu, on
the main screen or on both

12. 

When you first enter Public View, or click on Knowledgebase or Downloads, the main
screen contains two columns. The first column lists the five articles or files that have
been viewed most often

13. 

The second column lists the last five articles or columns added. You can click on any of
the articles to open the article to read it.

14. 

When you click on an actual article the article is displayed in the main screen, and the article
that you are viewing is highlighted in the left menu.

The detailed article block displays actions and options you can do to this article.  It may
be placed on the right-hand side of the screen, as in this example, or at the bottom of
the text.

15. 
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As a viewer you can print the article, send it to a friend, view it as a PDF, add a
comment or be notified of changes. Print brings up a clean copy of the text
without associated headings and menus which you can then print using your
print button. Email to friend allows you to email a link to the article to one or
more others. You can include your own message with the email.  Subscribe
allows you be notified of any changes to the article.

You may also see other information in this panel. Who wrote the article, the date
it was written, who last updated it and when and whether or not the article is
public or private.

If you have author or editor access you may also update the article, or see all
other articles in that category.

There are more options at the bottom of the screen. You can rate the article here. When
you add a rating, a comment box opens allowing you to say why you rated this article
the way you did.

16. 

Other users' comments are displayed at the bottom of the screen. The full comment may
be displayed, or just a link to it.

17. 

Public Area (front-end) 9
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Admin Area (Back-End); Common Actions

This article describes the Admin area home page and reviews the standard information you see
and actions you can perform throughout the Admin area.

Home page

When you log in to the Admin area you see the Home page:

This page has three tabs: Dashboard, Statistics, and Set Up Tests.

To adjust the information that appears on the Dashboard or Statistics tab, select that tab,
then click the Customize this Page button. In the form that appears check the check boxes
beside the information that you want to display. Any changes you make take effect when you
dismiss the form.

Dashboard tab

This tab displays a summary of content created by or assigned to you, including your articles
and files in draft form, published articles, and articles and files assigned to you for approval.
The content is grouped within each category by status. Click any link to see a detailed list of
the content in that category and status.

Statistics tab

This tab displays counts of articles, files, and users in various categories. Click on any link to
see more details. If you are logged in as an Admin user, you see information for the whole
knowledgebase; otherwise you see statistics for your own articles and files only.

Set Up tests tab

The Set Up tests tab lets you review how your knowledgebase is set up, and test that all
elements are working as they should. See Set Up tests.
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Common actions in the Admin area

This section reviews information you can see and actions you can take in the Admin area of
KBPublisher. The image shows the article screen because it has the most functionality, but the
explanations are applicable for working with files and feedback in the knowledgebase as well.

The main section of the display is a list, in this case of the articles in your knowledgebase.

Right-click any item in a list in the Admin area to display a context menu. From that menu you
can select options like opening the link you clicked in a new window.

For many columns, you can sort the list by the values in that column by clicking the column
header. Click again to reverse the sort order.

You can filter the list using one or all of the fields at the top of the tab:

Category - select a category to display only records in that category. Check the check
box to the right of the field to also display records in subcategories of the category you
select.

• 

Status - select a status to see only records with that status.• 
Type - select:

All types (the default)♦ 
a type to see records with that type assigned.♦ 
Any type assigned to see records which have any type assigned to them.♦ 
No type assigned to see only records that do not have a type assigned to them.♦ 

• 

Search - enter keywords to search for content with that text in their title or body. Put *
as a wildcard before and/or after the string you enter to broaden the search ("*health*")
would return content with "health", "unhealthy", and "healthcare", among other words.

• 

Click the > button to filter the list. To return to the full list, remove entries to all filter fields
and click > again.

To create a new record, click Add new and complete the form that appears.
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You can adjust how many items appear on each page by changing the number in the Records
per page field. You can browse from page to page using the << and >> buttons, or by
choosing a number from the Pages dropdown list.

The display gives you information about each article (in this example), including:

Item ID.• 
If the article is scheduled a clock icon.• 
If the article is private, a key icon.• 
The article's type, if it has one.• 
When the article was created and most recently updated.• 
The article's title. Click the title to see the article.• 
The article's category. If it is in more than one category, the number of categories also
appears in square brackets. Click the category name to see just the articles in that
category.

• 

The number of views the article has had.• 
If readers have rated the article, its rating and the number of votes received.• 
If the article has attachments, the number of attachments.• 
The article's status, indicated by a block of color. Hover the mouse pointer over the
color to see what the color represents.

• 

If past versions of the article are available, a history icon appears. Hover the mouse
pointer over it to see the number of past versions, or click the icon to learn more about
past versions or to read them.

• 

You can perform certain actions on the articles in the list. Click the icon in the Action column
for an article and choose from the available options, such as Preview and Edit.

You can also perform some actions, such as Set Status, on several articles at the same time. To
do this, check the check box at the left end of the row for each article you want to act on, and
pick the action from the Actions with selected menu at the bottom of the list.
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Searching for Articles

You can browse for articles by clicking on category headings and then selecting the article
title, or you can search for articles using the search tool.

Searching the knowledgebase is easy and powerful.

Search functionality is provided by MySQL full-text searching. This is a natural language
search that allows you to type in a question or sentence that describes the information you are
searching. The program uses logic to determine the keywords in the sentence.

Search allows you to search for the title of the article, for text within the article, for any meta
information such as keywords and for the article ID. The advanced search allows you to further
refine your search to a specific article type or category.

If you still cannot find the information, KBPublisher has a feature whereby you can ask a
question. As you type the question, KBPublisher will display articles that might answer your
question. If you still can't find an answer in that list, click OK to email your question to the
knowledgebase administrator. Questions can be targeted too, so that a specific questions will
be sent to different users in your knowledgebase.

Searching for Articles 13



User privileges

Any user can read articles, but in order to create articles and to publish them to the
knowledgebase, users must have certain privileges.
For example, to actually write articles a user must have author or contributor privileges.

To publish the article for other users to read, they must be in the author, editor or moderator
privilege groups. KBPublisher comes with five default privilege groups, and you can also create
your own.

There are five default privilege groups.

Administrator sets up the system, controls user accounts, designs the site and so on• 
Moderator has access to every part of the system except Settings and Import/export.
The moderator generally creates users, organizes categories and manages the
knowledgebase on a day to day basis

• 

Editor can add, edit and delete their own and other users articles, files, comments and
visitors' questions. This is the person responsible for the overall content of the
knowledge base.

• 

Author provides the actual content. An author can add, edit, delete or publish their own
articles and files. When they have completed an article and published it, the article
appears immediately in the article list

• 

Contributor also provides content, and can add edit or delete their own articles and
files but the articles and files do not appear in the knowledgebase immediately. They
must be approved by an editor or a moderator. Once an article or file is approved, the
contributor can no longer edit it.

• 

You can also create your own privilege groups.

Here is a quick chart of default user types in KBPublisher
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Privilege levels

Each user type has a privilege level. The privilege level defines who can edit users of this
level. Users cannot edit other users with a privilege level lower than or equal to their own.

Admin users always have a privilege level of 1. They can edit any other user.  In the standard
setup editors have a privilege level of 3, while authors have a privilege level of 4 and
contributors 5. This means that an editor could--if he had edit user access--edit author and
contributor users while a contributor could not edit any users except other contributors (again,
and only if he had edit user access).  None of them can edit admin users.
This gives an extra level of security when editing users.

* Adding comments, rating articles and sending emails to the administrator are all options that
can be turned on or off in the settings. Hence while these options are available, they must also
be turned on if you wish to use them.
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User roles

Roles allow you to set up a hierarchy of users and to control which articles users can see.

Roles are set up as tree structures, and when you mark an entry as private to a specific role
then users with this role and with parent roles have access to the article. Any role below it in
the tree, and roles that do not belong to 'current tree', will not be able to access the article.

For example, suppose you have the following roles:

In the above tree the Contractors role has a sub-role of Manager, and below that sub-sub-roles
of Beta Tester, Tech Writer and Programmer.

Users can be assigned to multiple roles.  Thus your programmer could also be an employee. 

If you mark an article private read and assign to it a role of 'Programmer', then contractor
managers and programmers will be able to access the entry. No one else will have access to
this article.

Note:

Users with administrator privilege have access to any article in any category.• 
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Category types

Category type controls how articles in this category are displayed in the public view.
There are four category types:

The Standard (default) type displays a list of articles, along with one or two lines of
text.
If the category has sub-categories, these are displayed above the list.

• 

The book type displays items as a table of contents.• 

The Quick FAQ type displays all articles in the category on the same page.• 
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While the Quick FAQ (interactive) type displays all articles in the category on the
same page as well, but with only the titles displayed initially. Click on the title to display
the article, click on it again to hide it. 

• 
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Quick Response

By "connecting" your contact form with your knowledge base, your visitors can get instant
answers to questions that they would normally send you via email.

If a user clicks on Ask a question, when they start typing their query into the
Question/Comments field, KBPublisher checks what they are typing and searches for articles
that may answer the question.
It presents the five best matches at the bottom of the screen under a heading called 'Do these
answers help?'

The five articles returned change as the user types more words.

Turning off quick response

This option can be turned off in Settings if you prefer a basic feedback form without this
feature.

Go to Admin Area• 
Click on the Settings menu• 
On the  Common tab, under Feedback, uncheck Enable 'quick response'.• 
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Subscriptions

Subscriptions allow you to be notified when:

A single article is changed• 
Any article in a specified category is changed, or when new articles are added to the
category

• 

A single file is changed• 
Any file in a specified category is changed, or when new files are added to the category• 
News is added or changed• 
A comment has been added to an article or file.• 

When you set up a subscription for a specified item or category, then KBPublisher sends you an
email when that file or category is changed.

You can see what you have subscribed to on the Subscriptions tab under My Account.

----------------------------------------------------------------------
This functionality works in version 3.5 and above
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Article history

KBPublisher keeps a history of all changes you make to the content of an article. 
When you update an article, you can add revision comments to easily track changes.

You can view earlier versions and compare them against the current version to see what has
changed.
You can roll back to earlier versions.
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Export articles

You can also purchase our optional plug-in that allows you to export articles in your
knowledgebase to PDF or to html pages.

You can do this for the complete knowledgebase or for only one category• 
You can tailor the export to be generic or to display only those articles a specific type of
user/customer can see

• 

Note:

This plugin is an optional extra. It must be purchased separately.• 
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Custom Fields

You can customize your knowledgebase by adding custom fields.

These custom fields can be defined for:

Articles• 
Files• 
News items• 
Feedback form• 

For articles, the custom fields can:

Be displayed at the top of the article• 
Be displayed at the bottom of the article• 
Be displayed after the rating block• 
Or they can be hidden, for internal use only• 

For files, fields are for internal use only.  That is, you can see them when you add the file, but
the user cannot see them.

Depending on where the field is displayed, you can also include text around the field.  For
example, the field may be 'Department', and the valid value in the field might be 'Sales', but
the user might see this as 'Contact the Sales Department for further information'.

Bulk actions available depend on your user access.
For example if your privilege does not allow you to delete items, or allows you to only delete
articles that you have created, then there is no 'Delete' action in the list of options. If your
privilege does not allow you to update items, or allows you to only update items you have
created, then this menu will not be available for you at all.
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Mobile View

Mobile View is specially optimized working with KBPublisher on your mobile devices -
smartphone or tablet. All news and articles are shown as a list to simplify access. Also you can
easily switch view mode from mobile version to full view. Mobile View is enabled for Public
Area only.

Some screenshots below.

The KBPublisher home page has two banners for navigation and to manage your
account: News and Recent Articles.

Main menu opens by clicking on first button. You can choose any module or return to home
page.
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Settings opens by clicking on second button. You can switch to the full view or go to your
account.

You can view articles within a category via Browse by category

----------------------------------------------------------------------
This functionality works in version 5.0 and above
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Automations

Use automations (automated tasks) to check your content regularly and perform certain
actions as needed. You can make sure your articles are up to date, and alert staff to review
them when they are not. You can let authors know when articles have been approved for
publication, or let managers know when articles are ready for review.

To access your automations, select Tools from the menu bar. Then select the Automations
sub-tab.

Essential facts for automations

Automations are time-based: they act when a time-based event occurs, such as the time
since an article was edited exceeding a specified maximum time.

• 

Automations run daily, at midnight.• 
An automation must contain a condition that is true only once, or an action that nullifies
at least one of the conditions; otherwise, the automation will run daily, possibly sending
unwanted duplicate alerts every time it runs.

• 
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Workflows

Workflows automate processes for reviewing, approving, and publishing articles. This can save
you time and make sure articles that may be ready to publish, but need approval, are not
overlooked. If the item requires review and approval before it is published, a workflow can
transfer the item to the worklist of the person who is responsible for approving it. That person
can approve the article or send it back for further edits.

Workflow Flowchart

The image below shows the path the draft of an article or file might have to follow if, after the
author has written or uploaded it, one or more people have to review and approve it before
publication.

Essential facts for workflows

Workflows are applied to drafts of articles and files only • 
You cannot delete or edit a workflow which in use (is applied to some drafts).• 
You can have as many approval steps in a workflow as your project's process requires.• 
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Drafts

The Drafts module lets users create new articles, or modify existing published articles, without
interfering with live publications. Users can create and modify drafts in a separate area until
each draft is finished and ready to go live.

The Drafts module lets you require specific contributors to create drafts that must be approved
before publication, rather than publishing their material directly.

To learn about creating and managing your drafts, see Manage drafts.

Essential facts about drafts

Users with admin privileges can create, approve, reject, or delete any draft at any stage
in the approval process. 

• 

If a draft has been sent for approval, the author cannot update it until the review is
complete. 

• 

Your knowledgebase records approval decisions in a log for future reference.• 

Drafts and Workflows

When a draft is ready to publish, an approval workflow can route the document or item to the
assignees, one or more people assigned to review such material before publication.

Assignees can approve the article for publication or send it back to the author for more work.
They can also provide feedback on an article. The feedback is compiled and sent to the person
who initiated the workflow.

Possible scenarios when a user adds a draft

There is a matching workflow
The author of a draft can save the draft repeatedly while working on it until the material
is ready to submit. When the user submits the draft for approval, the workflow assigns it
to appropriate assignees. The user has no further access to the draft until it is approved
for publication or returned for further edits.

1. 

There is no matching workflow and the user's privileges do not permit adding
articles
The author of a draft can save the draft repeatedly while working on it. However, the
user cannot publish the draft, and there is no way to send the draft for approval. 

2. 

There is no matching workflow, and the user's privileges permit adding articles
The author of a draft can save the draft repeatedly while working on it. When the draft
is ready to publish, the user can publish it. 
Once the draft is published it no longer appears on the list of drafts, and does appear on
the list of articles.

3. 
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Installation

System Requirements

KBPublisher has minimal requirements and should work on any modern server.

Client Side:

Operating System: Windows, Mac or Linux• 
Web Browser: Internet Explorer 8.0+ or Chrome, Firefox, Safari.• 

Server side

Operating System: Linux, Unix, Windows, Mac• 
Web Server: Apache Web Server / IIS6 or above• 
Database: MySQL 4.1 or above• 
Scripting Language: PHP 5.3 - 5.6 (it will not work with PHP 7.0)• 
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Installing KBPublisher

The easiest way to install KBPublisher is to use the installation wizard.

The install script is extremely simple. The only action required on your part is to click the next
button when each step is completed and you will be prompted for each action that is required
from your side to proceed with installation. However, there are some things you need to do
before you start to ensure the process runs smoothly.

Before you start

Check that:

PHP is installed on your server• 
MySQL is installed on your server• 

If any of these are not, install these first.

Install KBPublisher using the wizard

Unpack the distribution package1. 

Place it somewhere in your web-server's document root, preferably the parent directory
of your root web directory. Usually the root directory will be public_html, httpdoc or
www.

2. 

You can rename "kb" folder as you wish (it will be a part of your URL for knowledge
base)
For example if you rename it to "kbbase" and place it in document root directory
(document root/kbbase)
the URL for knowledge base will be www.youdomain.com/kbbase/

3. 

Type http://yourdomain.com/kb/setup/index.php into your browser address line, where
is your domain name, and is either 'kb', if you retained the default, or whatever folder
you renamed it to. For example, if you used the domain name in step 3, this would be
www.yourdomain.com/kbbase/setup/index.php.
The installation wizard comes up.

4. 

Follow the installation wizard instructions.5. 

After the wizard finishes

Once the wizard completes, you need to set up scheduled tasks to ensure the knowledgebase
works smoothly.
If you don't set up scheduled tasks then some functionality in KBPublisher will not work.

Check that everything is installed properly

Use the Setup Tests tab on the Home screen of the Admin area to ensure that everything is
installed properly.

Notes

We recommend the following directory structure (and this is what the installation• 
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wizard creates).

kb_file - for uploads via "Files" module
kb_cache - for cache files
kb - knowledgebase code (rename it as you wish, it will be a part of your URL for
knowledge base)
kb_upload - for uploads via HTML editor

The kb_file, kb_cache and kb_upload directories must be writeable by PHP. The
installation wizard creates these directories if you run a Windows. If you have errors
that directorues are not writeable you need to set up Write permissions, see this
article. However, if you are a Linux user it may fail due to access problems. In this case
you will need to create the directories manually and CHMOD them to 0777.

• 

We recommend that you place the kb_upload directory in the parent directory of your
root web directory. If you later decide to move your knowledgebase to new location it
will help you to keep paths correct for uploaded images.

• 

Wizard will try to create database for you, if it can't do it you need to create it
manually. 
At the MySQL console, run the following commands:

CREATE DATABASE db_name [DEFAULT] CHARACTER SET [=] charset_name |
[DEFAULT] COLLATE [=] collation_name;
GRANT ALL ON db_name TO 'username'@'host' IDENTIFIED BY 'password';
e.g. 

mysql> CREATE DATABASE kbp DEFAULT CHARACTER SET utf8 COLLATE
utf8_general_ci;
mysql> GRANT ALL ON kbp TO 'me'@'mydomain.com' IDENTIFIED BY
'xda44f54fddGHRECT';

• 

Don't forget to set up scheduled tasks.  If you don't set this up you can still create
articles and manage your knowledgebase, but you will lose some of the advanced
features. You won't be able to schedule articles, users won't receive alerts and you
won't get any reports.

• 
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Installing KBPublisher manually

If you don't want to install KBPublisher using the install wizard, you can install it manually as
follows:

Unpack the distribution package.1. 

Place the distribution package somewhere in your web server's document root,
preferably the parent directory of your root web directory. For many systems, this will
be the public_html directory.

2. 

By default, the distribution package is in a folder called kb, and this link will be
included in the URL of the knowledgebase. For example, the default URL of the
knowledgebase will be www.your_domain/kb/, where your_domain is your domain
name.
You can rename the 'kb' folder as you wish. If, for example, you rename the folder to
'kbbase' and place it in the document root directory, the URL for the knowledge base
will be www.your_domain/kbbase/.

3. 

Create an empty MySQL database to be used by KBPublisher, or use an existing
database.

To create a new database run the following commands in the MySQL console:

CREATE DATABASE db_name [DEFAULT] CHARACTER SET [=] charset_name |
[DEFAULT] COLLATE [=] collation_name;
GRANT ALL ON db_name TO 'username'@'host' IDENTIFIED BY 'password';

e.g. 

mysql> CREATE DATABASE kbp DEFAULT CHARACTER SET utf8 COLLATE
utf8_general_ci;
mysql> GRANT ALL ON kbp TO 'me'@'mydomain.com' IDENTIFIED BY
'xda44f54fddGHRECT';

4. 

Create your directory structure:
Create a directory to store files users upload with the File option. We
recommend that you name the directory kb_file and place it somewhere outside
your document root directory. It should not be accessible to web browsers via
http.

1. 

Create a directory to store files users upload through the HTML editor. We
recommend that you name the directory kb_upload and place it in document
root directory.

2. 

Create a directory to store cache files. We recommend that you name it
kb_cache and place it somewhere outside your document root directory. It
should not be accessible via http (web browser).

The structure of directories should look like this:

3. 

5. 
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If you are installing a new version of KBPublisher:
Create tables using the db dump file at kb/setup/db/install.sql.♦ 
Create an admin user using the file at kb/setup/db/create_user.sql.♦ 

6. 

If you are upgrading from a previous version of KBPublisher:
Back up your existing database before upgrading!♦ 
Use the DB dump file kb/setup/db/upgrade_[version]_to_[version].sql.♦ 

7. 

Configure your kb/admin/config.inc.php configuration file.

If you installed KBPublisher in document_root/kb/ directory:
$conf['admin_home_dir'] = '/kb/admin/';
$conf['client_home_dir'] = '/kb/';

If you installed KBPublisher in document_root directory:
$conf['admin_home_dir'] = '/admin/';
$conf['client_home_dir'] = '/';

8. 

In some cases you have to configure your kb/index.php file to set the correct path for
the admin directory and the kb/rss.php, kb/captcha.php files to set the correct path
to the kb installation directory. Normally these will work without any modifications.

9. 

Give your kb_upload, kb_file, kb_cache directory full write permissions.
In unix you can type "chmod 777 ". On Windows you must go through your webserver to
give it write permissions.

10. 

Set up scheduled tasks to enable scheduling, reporting and subscriptions.11. 
You're done.

The public area screen will be available at www.your_domain/kb/
The admin area will be available at www.your_domain/kb/admin/

Login: admin
Password: demo

DO NOT FORGET TO CHANGE THE PASSWORD!

12. 

Log in to KBPublisher and select the Settings tab to configure settings.
Make sure you set the correct email address at Setting -> Email .

13. 

Read the FAQ14. 
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Upgrading KBPublisher

Before you start
Please note that upgrading via the wizard is possible only for version 2.0 and above.
If you are currently using an older version of KBPublisher upgrade to version 2.0 first.

Option 1 (retain current installation until you have tested the upgrade)

Make a copy of your previous KBPublisher installation database. This database will be
modified during the upgrade.

1. 

Unpack the distribution package to a directory with a different name to that of your
current knowledgebase directory, for example to "kb_new".  This ensures that the
previous installation is not overwritten.

2. 

Open your browser and go to
http://<your_domain>/<kb_installation_path>/setup/index.php, where
<your_domain> is your domain name, and <kb_installation_path> is the path where
KBPublisher is installed that you created in step 2. e.g.
http://mydomainname.com/kb_new/setup/index.php. The installation wizard comes
up.

3. 

Follow the installation wizard instructions.4. 
After testing the new installation, rename your current (old) KBPublisher installation
directory to something appropriate, for example to "kb_old".

5. 

Rename new KBPublisher installation directory to your previous installation directory
name.

6. 

Update configuration file <kb_installation_path>/admin/config.inc.php by setting new
values for $conf['admin_home_dir'] and $conf['client_home_dir'].

7. 

Note that this option creates a new database. If you wish to continue to use the original
database, then once you have tested that everything is working, backup the old database,
rename the new one and change the database name in config.inc.php to match the name of the
original.

Option 2 (upgrade directly into the current knowledgebase)

Rename your current KBPublisher installation directory. For example to "kb_old".1. 
Backup your database.2. 
Unpack the distribution package to the directory where the previous version of
KBPublisher was installed.

3. 

Open your browser and go to
http://<your_domain>/<kb_installation_path>/setup/index.php, where
<your_domain> is your domain name, and <kb_installation_path> is the path where
KBPublisher is installed. e.g. http://mydomainname.com/kb/setup/index.php. The
installation wizard comes up.

4. 

Follow the installation wizard instructions.5. 

Option 3 (replace modified files only)

With some small KBPublisher upgrades, we supply a quick upgrade option called a "Modified
Files Only" package. For example, this package is available to upgrade from v3.0 to v3.0.1 This
allows you to simply replace modified files rather than doing a full upgrade. You can download
it from your client area in the same way you can download a full upgrade package.

The modified files package contains:
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A kbp folder that contains all modified files to be copied. The structure of the folder and
sub-folders is the same as the KBPublisher directories/files structure

• 

A My-SQL script to run, called db_upgrade_from_[version]_to_[version].sql, that
updates the version number of your database

• 

A file called how_to_upgrade.txt that tells you what you need to do to upgrade• 
A list of updated files in updated_files.txt.• 

Standard steps to upgrade:

Backup your current KBPublisher installation, directory and database (recommended).1. 
Copy the contents of the kbp folder found in downloaded "Modified Files Only"
package to your current KBPublisher installation directory.  We recommend that you
copy the files by folder, rather than all at once. 
(ATTENTION: Mac OS users. You should copy file by file. Do not copy folder by folder. It
does not work for you and will replace entire folder(s) and delete non modified files). 

2. 

Upgrade your database by running the db_upgrade_from_[version]_to_[version].sql file
found in downloaded "Modified Files Only" package. If your KBPublisher tables prefix is
not "kbp" then you should update sql file and set you tables prefix.
For example from:
UPDATE `kbp_setting` SET `input_id` = '5' WHERE `id` = 46;

To:
UPDATE `your_prefix_setting` SET `input_id` = '5' WHERE `id` = 46;

3. 

Notes:

The original installation will already have kb_file and kb_upload directories. Check
where these are, and during the upgrade make sure that your kb_file and kb_upload
directory paths are the same as for original installation

• 

Here is a recommended directory structure for KBPublisher

kb_file - is for uploads via 'Files' module
kb_cache - is for cache files
kb_upload - is for uploads via the HTML editor

kb_file, kb_cache and kb_upload directories must be writeable by PHP.
On a Windows system this generally is not a problem, but on Linux systems you will
need to CHMOD these directories to 0777.

• 

If you using Remote Authentication please keep your file
(kbp_directory/admin/lib/custom/remote_auth.php) and copy it to new installation.

• 

If you using language other then en please keep directory
(kbp_directory/admin/lang/your_lang) and copy it to new installation.

• 
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Installing ionCube loader

For KBPublisher  v4.0.2 and lower ionCube loader must be installed.

On many web servers the Loader can be enabled automatically with no changes to the php.ini
file and no server restart required.

If your server does not have ionCube support already enabled, you can obtain Loaders for your
server platform from here. Instructions for installing Loaders can be found here.

You can also you can run the ioncube helper file distributed with kBPublisher.
Run your browser to http:////ioncube/ioncube-loader-helper.php

If you install IonCube loader in the php.ini file you can check if loader installed in phpinfo.

Please see this article for how to create the phpinfo file.
If the loader installed correctly you should see it in the Additional Modules section in phpinfo.
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Setting Up Folder Permissions in Internet Information Services (IIS)

This article explains how to set up write permissions in the required folders for configuring IIS
7.0, 7.5, or 8.0 for KBPublisher.

Using the standard folders structure for IIS and KBPublisher set write permissions for
following folders:

C:/interpub/wwwroot/kb_upload - for uploads via HTML editor• 
C:/interpub/kb_file - for uploads via "Files" module• 
C:/interpub/kb_cache - for cache files• 

*Note: this is the default category structure. Your configuration might be different. 

For each of the above folders, do the following:

Right-click the directory, then choose Properties1. 
Go to the Security tab2. 
Find the IUSR account
(If IUSR is not in the list, add it by clicking Edit, then clicking Add, and then
typing "IUSR" in the "Enter the object names to select" field.)

3. 

Highlight the user in the list, click Edit, and grant the account Modify and Write
permissions

4. 
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Setting up scheduled tasks

Important: You must schedule tasks

Some parts of KBPublisher simply will not work if you do not schedule tasks. This includes:

Reports. You will not be able to run reports• 
Subscription processing. Users will not be notified when items are added or changed  • 
Scheduling. You will not be able to schedule article, news or files• 
Optimization. Database tables will not be checked/repaired/optimized• 
Synchronization. Article and file hits will not be synchronized• 
Search suggest will not work • 
Administration. Some system jobs will not run.• 

How do I schedule tasks?

You can configure scheduling through the Unix crontab command, through scheduled tasks
in Windows, or through  the Control Panel provided by your service provider.

When scheduling tasks for KBPublisher there are several files you must
run periodically. 

The files to be scheduled are:

admin/cron/freq.php - every 5 minutes• 
admin/cron/hourly.php - hourly• 
admin/cron/daily.php - daily, just after midnight• 
admin/cron/weekly.php - weekly• 
admin/cron/monthly.php - monthly• 

1. By 'crontab' on Unix

# every 5 minutes
*/5 * * * *   /usr/local/bin/php [KBP_DIRECTORY]/admin/cron/freq.php

# hourly
0 * * * *    /usr/local/bin/php [KBP_DIRECTORY]/admin/cron/hourly.php

# daily, after midnight
01 0 * * *    /usr/local/bin/php [KBP_DIRECTORY]/admin/cron/daily.php

# weekly
10 0 * * 0   /usr/local/bin/php [KBP_DIRECTORY]/admin/cron/weekly.php

# monthly
20 0 1 * *   /usr/local/bin/php [KBP_DIRECTORY]/admin/cron/monthly.php

where /usr/local/bin/php is the path to the PHP interpreter, it could differ on your
system (you can get it by running 'which php' on command shell),
and [KBP_DIRECTORY] is the absolute path to your KBPublisher installation directory (e.g.
'/home/user_name/www/kb').  Replace it with your value.
OR
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# every 5 minutes
*/5 * * * *   /usr/bin/curl -s http://example.com/kb/admin/cron/freq.php

# hourly
0 * * * *    /usr/bin/curl -s http://example.com/kb/admin/cron/hourly.php

# daily, after midnight
01 0 * * *    /usr/bin/curl -s http://example.com/kb/admin/cron/daily.php

# weekly
10 0 * * 0   /usr/bin/curl -s http://example.com/kb/admin/cron/weekly.php

# monthly
20 0 1 * *   /usr/bin/curl -s http://example.com/kb/admin/cron/monthly.php

You can insert these crontab records by executing 'crontab -e' and editing cron jobs
manually, or you can create a file (kbp_cron.txt) containing these lines and execute 'crontab
kbp_cron.txt' from shell (WARNING: all existing records in crontab will be removed!).

2. By 'Scheduled Tasks' on Windows

Instead of cron on Windows you can use Scheduled Tasks. Contact your system administrator
or hosting provider for additional details.
To set up Scheduled Tasks on Windows XP, Vista and 7, as well as Windows 2003 Server and
later, you can use schtasks.exe. Open command line and type in following commands:
schtasks /create /ru "System" /sc minute /mo 5 /st 00:00:00 /tn "KBPublisher freq task" /tr
"[PHP_DIR]\php.exe [KBP_DIRECTORY]\admin\cron\freq.php"

schtasks /create /ru "System" /sc hourly /st 00:00:00 /tn "KBPublisher hourly task" /tr
"[PHP_DIR]\php.exe [KBP_DIRECTORY]\admin\cron\hourly.php"

schtasks /create /ru "System" /sc daily /st 00:01:00 /tn "KBPublisher daily task" /tr
"[PHP_DIR]\php.exe [KBP_DIRECTORY]\admin\cron\daily.php"

schtasks /create /ru "System" /sc weekly /st 00:10:00 /d SUN /tn "KBPublisher weekly task" /tr
"[PHP_DIR]\php.exe [KBP_DIRECTORY]\admin\cron\weekly.php"

schtasks /create /ru "System" /sc monthly /st 00:20:00 /tn "KBPublisher monthly task" /tr
"[PHP_DIR]\php.exe [KBP_DIRECTORY]\admin\cron\monthly.php"
Where: [PHP_DIR] - full path to php.exe, [KBP_DIRECTORY] - full path to KBPublisher
directory. Replace it with your values

Example: schtasks /create /ru "System" /sc minute /mo 5 /st 00:00:00 /tn "KBPublisher freq
task" /tr "C:\php\php.exe C:\www\kbpublisher\admin\cron\freq.php"

3. By Control Panel

This depends very much on your hosting provider. You should consult their documentation.

Notes:

admin/cron/freq.php should be run every 5 minutes• 
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admin/cron/daily.php should be run just after midnight.• 

----------------------------------------------------------------------
This functionality works in version 3.5 and above
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Enable searching in files

Text-based file searching/indexing (txt, html, etc.) is enabled by default. If you want to include
searching PDF or Word documents then you need to do the following.

Searching in PDFs

 To enable search in PDFs you need to:

Install a program called xpdf• 
Ensure Settings points to where you installed it• 
Ensure that PHP has access to your xpdf directory. (Check your open_basedir PHP
setting in php.ini)

• 

Ensure that PHP can run the system  function.  (Check
your disable_functions, safe_mode_exec_dir PHP settings in php.ini)

• 

Install xpdf

xpdf is available from www.foolabs.com/xpdf/download.html• 
Download and install it.• 

Update the setting to point to xpdf

Once you have installed xpdf, you also need to set the correct path it in the Settings.

You can find this under Settings menu, Settings -> Admin -> XPDF installation path• 
Make sure that this points to the directory where you installed xpdf. For example:
/usr/local/bin/ or c:/wwwroot/xpdf/

• 

Set this to 'off' to de-activate this option.• 
When you click "Save", test pdf file will be parsed/indexed and error occurs if it failed. • 

Test xpdf from command line

Test to see if xpdf is working by running the following command from the command line:

$ /path_to_xpdf/pdftotext -raw file_read.pdf file_write.txt;
Test  xpdf from command line using PHP and included test file:

$ cd /path/to/kbp_directory
$ php -r "system('/path_to_xpdf/pdftotext -raw admin/extra/file_extractors/extract_test.pdf
file_write.txt');"

Searching in Word 2007/2010, Excel 2007/2010 or Open Office
document files

To enable search in .docx, .xslx and .odt documents you need to:

Install a PHP Zip extension if you do not have one• 
You can see if you have it installed in Home -> Setup Tests tab  in your KBPublisher
installation

• 
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Searching in Word 2003 and below files

 To enable search in Word documents you need to:

Install either catdoc or Antiword• 
Ensure Settings points to where you installed it• 
Ensure that PHP has access to your catdoc directory. Check your open_basedir PHP
setting in php.ini.

• 

Ensure that PHP can run the exec function.  Check
your disable_functions, safe_mode_exec_dir PHP settings in php.ini. 

• 

Install catdoc

catdoc is available from http://www.wagner.pp.ru/~vitus/software/catdoc/• 
Download and install it.• 

Install Antiword

Antiword is available from http://www.winfield.demon.nl/• 
Download and install it.• 

Update the setting to point to catdoc

Once you have installed catdoc, you also need to set the correct path it in the Settings.

You can find this under Settings menu, Settings -> Admin -> catdoc installation
path

• 

Make sure that this points to the directory where you installed catdoc. For
example: /usr/local/bin/ or c:/wwwroot/catdoc/

• 

When you click "Save", test pdf file will be parsed/indexed and error occurs if it failed. • 

Test catdoc from command line

Test to see if catdoc is working by running the following command from the command line:

$ /path_to_catdoc/catdoc -w file_read.doc;
Test catdoc from command line using PHP and included test file:

$ cd /path/to/kbp_directory 
$ php -r "system('/path_to_catdoc/catdoc -w admin/extra/file_extractors/extract_test.doc');"

Test antiword from command line

Test to see if antiword is working by running the following command from the command line:

$ /path_to_ antiword/antiword -t file_read.doc;
Test antiword from command line using PHP and included test file:

$ cd /path/to/kbp_directory 
$ php -r "system('/path_to_ antiword/antiword -t admin/extra/file_extractors/extract_test.doc');"
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Turning PDF or Word search off

If you don't want to allow searching on PDF or Word documents, change the setting in XPDF
installation path or catdoc installation path to OFF. 
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Enable Exporting to PDF

To export multiple articles to PDF or HTML files you need to:

Install a program called HTMLDOC• 
Ensure Settings points to where you installed it• 
Ensure that PHP has access to your HTMLDOC directory. (Check
your open_basedir PHP setting in php.ini)

• 

Ensure that PHP can run the proc_open function. (Check
your disable_functions, safe_mode_exec_dir PHP settings in php.ini)

• 

Buy the export plugin  or try it in Demo mode• 
Add the plugin key to your KBPublisher settings• 

Install HTMLDOC

Note: At this time there is no commercial support for the HTMLDOC. The windows binaries
can be found here.

HTMLDOC is available from https://www.msweet.org/projects.php?Z1• 
Download it and install it• 

Update the setting to point to HTMLDOC

Once you have installed HTMLDOC, you also need to set the correct path it in the Settings.

You can find this under Settings menu, Settings -> Plugins -> HTMLDOC
installation path

• 

Make sure the HTMLDOC installation path points to the directory where you
installed HTMLDOC. For example: /usr/local/bin/.

• 

When you click "Save", test HTML file will be parsed and error occurs if it failed. • 

Buy the plugin

Export functionality is not available with the default KBPublisher package. You must purchase
it separately.
Please see this article how to buy the plugin.

Add the plugin key to KBPublisher

You should have received an email with you plug-in key. If you can't find the email,
you can also get this from the My Licenses tab in your client area on the KBPublisher
website.  

Copy the license key from your client area or the email• 
Log on to your knowledgebase• 
Go to the Admin Area• 
Click on the Settings menu• 
Click on the Plugins tab• 
Paste your key into the Plugin key field• 
Save.• 

Test HTMLDOC from command line

To convert a single web page type:
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$ /path_to_htmldoc/htmldoc --webpage -f output.pdf filename.html

Test using PHP and included test file:

$ cd /path/to/kbp_directory 
$ php -r "system('/ path_to_htmldoc/htmldoc --webpage -f output.pdf
admin/extra/plugin/export/template/export_test.html');"

Tip:

If you want to try the export plugin before you buy, use demo mode to get an idea of
how it works.

• 

----------------------------------------------------------------------
This functionality works in version 4.0 and above
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Enable searching spell suggest

To help you avoid typos when entering search terms, you can install and enable one of the
following tools:

Pspell• 
Enchant• 
Bing spell suggest service (free or paid versions)• 

Each of these tools monitors the characters you enter in the search field and suggests words
that match what you have typed so far and that match entries in your system data. You can
then select one of the words or ignore the suggestions and continue typing.

You may find by experimentation that one of the tools works better than the others for your
system and your data.

To enable spell suggest:

Select Settings from the menu bar in the Admin area.1. 
In the form that appears, select the Public Area tab.2. 
Scroll down to the Search section.3. 
Locate the Search Spelling Suggest field and click the "..." button.4. 

The form that appears shows the available spelling tools. If one is already selected and active,
it is marked with a check mark. If no tool is active, you can activate one as described below.

Click Save to save your settings and return to the main form. Click Cancel to abandon your
changes and close the Settings form.

Enchant 

Enchant is the PHP binding for the "Enchant" spelling library. Enchant provides consistency
among any running spell-checkers, and adds certain features that may be lacking in any
individual provider library. Click the information icon beside the tool's name to see more
information.

Click the icon in the Settings column to display the Settings form. 
In the Settings form you can select the spelling library to use from the two "Active Dictionary"
fields at the top of the form.

If you want to exclude some words from Enchant's attention so it does not suggest alternatives,
enter the words, separated by spaces, in the "Exclude word list" field.

To make Enchant the primary spelling suggest tool, check the "Set as Primary" check box. This
will deselect any other tool that is currently selected.

Pspell

Pspell is a spelling-assist tool that will help you enter search terms that will return "hits". Click
the information icon beside the tool's name to see more information.

Click the icon in the Settings column to display the Settings form.
In the Settings form you can select the spelling library to use from the "Active dictionary" field
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at the top of the form.

If you want to exclude some words from Pspell's attention so it does not suggest alternatives,
enter the words, separated by spaces, in the "Exclude word list" field.

To make Pspell the primary spelling suggest tool, check the "Set as Primary" check box. This
will deselect any other tool that is currently selected.

Bing spelling suggestion

This option uses the Bing API to provide suggestions for spelling search terms to match data in
the system. There is a free licensed version with a limited number of uses per month by your
readers, or you can purchase a license that supports more uses per month. Click the
information icon beside the tool's name to see more information, and to learn about obtaining a
license.

Click the icon in the Settings column to display the Settings form.

To activate Bing spelling suggestion, you need to obtain a license. Click the information icon,
as described above, and either get the free license or buy one of the license" allowing higher
use. When you have obtained your license, enter the information you receive in the "Bing API
Account Key" and "Bing request URL" fields.

You may find that your system runs somewhat slower when using the autocomplete feature in
Bing. if so, de-select the "Use in Autocomplete predictions" check box.

If you want to exclude some words from Bing's attention so it does not suggest alternatives,
enter the words, separated by spaces, in the "Exclude word list" field.

To make Bing the primary spelling suggest tool, check the "Set as Primary" check box. This will
deselect any other tool that is currently selected.
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Setup tests

The Setup Tests screen is available as a tab from the home menu. It allows you to check that
your knowledgebase has been set up properly.

To get to the screen:

Log in as an admin user• 
Click Home• 
Click the Setup Tests tab• 

The Setup Tests tab

When you first install KBPublisher the Setup Tests tab doesn't show much. Click Run Test to
get some results.

The Files directory is where files are stored. If this test's status is passed, it means
that the folder exists and can be written to. If you need to check the name of the
directory, click Setting.

• 

The Cache directory is where cached files are stored. This is defined in the php config
file. You normally would not change this. Passed means that the directory exists.

• 

The HTML editor file directory is where images are stored. If the status is passed it
means that the directory exists and you can save images to it. If you need to check or
update the name of the directory, click Setting.

• 

XPDF allows you to search PDF files.
If this setting is disabled, then XPDF has not been installed. If the status is failed or
error, details of the error will be provided.
If the status is passed, your knowledgebase should be able to search PDF documents.
To install XPDF, see Enable Searching in Files.

• 

Catdoc allows you to search Word 2003 files.
If this setting is disabled, then Catdoc has not been installed. If the status is failed or
error, details of the error will be provided.
If it is passed, your knowledgebase should be able to search .doc documents.
To install catdoc, see Enable Searching in Files.

• 

PHP Zip extension allows you to search Word 2007/2010 files and Excel 2007/2010
files and from OpenOffice documents.
If the status is failed or error, then PHP Zip extension has either not been installed or is
not installed properly; details of the error will be provided.
If the status is passed, then your knowledgebase should be able to search docx, xlsx,
and .odt files.
To install PHP Zip extension, see this link.

• 

Spell Suggest helps your knowledgebase users when they search for documents or
files, by suggesting the correct spellings of the words the users are entering as search
terms.
If the status is passed, then Spell Suggest is installed and end users should see helpful
spelling hints. If the status is failed or error, details of the error will be supplied.

• 
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Htmldoc allows you to produce user manuals of your knowledgebase. You can purchase
Htmldoc as a plugin.
If the status is disabled, Htmldoc hasn't been installed. If the status is failed or error,
details of the error will be provided.
If this is passed then you should be able to export your knowledgebase as a PDF
document and/or as HTML.
See enable exporting to PDF for setup and requirements. 

• 

Scheduled tasks tells you if your cron jobs are set up properly.
If the status is disabled, then you will not be able to schedule tasks or run reports, and
users will not be notified of changes they have subscribed to. Some admin tasks will
also not run.
Cron jobs are set up on the server. Click here for how to set them up.
If the status is error, then there is a problem in your setup and some tasks could not
execute. Information about the problem will be listed with the error. 
If the status is passed then your cron jobs have been set up properly and scheduled
tasks should run.

• 

Note:

This set of tests runs as a regularly scheduled task. If there is an error, the
knowledgebase administrator is notified by email.

• 

----------------------------------------------------------------------
This functionality works in version 4.0 and above
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Getting started

Summary

Welcome to KBPublisher. This section tells you how to quickly get your knowledgebase up and
running.

If you haven't already done so, install KBPublisher• 
Create one or more categories to post articles under• 
Add some users who will create content and publish it. Use the Default User Privileges
article to hyelp determine which type of user(s) to create. If you already have a list of
users in another database, consider importing them in to KBPublisher rather than
adding each one individually.

• 

Add some articles. Likewise, if you have a lot of articles that already exist in another
database, consider a bulk import of articles instead of typing them in individyally.

• 

That's it. Your knowledgebase is ready.
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Add a Category

The quickest way to add a category is to use the Shortcuts menu at the top of your screen.

Click on the drop-down menu in the top right of the screen and choose Add new
category.

• 

Or you can do it via the Categories tab in the Admin Area

Click on the Articles menu• 
Choose the Categories tab• 
Click on Add New.• 

You can also add a category while you are in the middle of adding an article or a file

Edit the article or file• 
Click on the assign categories button (+)• 
Click on Add New Category.• 

Once you are on the category screen you must complete the following sections:

Add a Title. This is the name that will be displayed on the left menu or in any table of
contents.

• 

Define where it fits in the category hierarchy by choosing a Parent category and an
Order. If you don't change these you will add a new top-level category and it will be
placed last.

• 

You may also:

Change how articles are displayed by specifying a category type• 
Control read and write access through Private and Active• 
Allow users to comment on or rate articles in the category• 
Assign a person to approve articles (Supervisor) for the category• 

You can find out more about each of these fields and how they work in the Category screen
explained.
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Add an Article

If you are in the Public area, the quickest way to add an article is via the button in the top right
of your screen:

Click on Add article• 

If you are in the Admin area, another fast way is to to use the Shortcuts menu at the top of
your screen:

Click on the drop-down menu in the top right of the screen and choose Add new
article.

• 

Or you can do it via the Articles tab.

Click on the Articles menu• 
Choose the Articles tab• 
Click on Add New.• 

Once you are on the article screen you must complete the following sections:

Choose where you want the knowledgebase article to be displayed by
adding a Category or categories

• 

Add a Title. This is the heading displayed on the knowledgebase screens and in any
menus/table of contents.

• 

Type your article in the Article editing box.• 

The following items are optional:

To help users search within your database, include a Type and Meta Keywords• 
To optimize web search add Meta Keywords/Tags and a Meta Description• 
To add links to other web sites, include External links• 
To add links to other articles in the KBPublisher database, include them as Related
articles

• 

To add links to files, include then as Attachments• 
To force users to log on to read an article, mark it as Private Read. To restrict who can
read the article mark it as private read and then assign specific roles which can access
it.  To restrict who can edit the article, mark it as Private Write.

• 

To say where in the list the article is placed, specify the Order• 
Use the Status field to make the article available to read.• 

You can find out more about each of these fields and how they work in The
Article Screen Explained.

Once your article is complete:

Click Save.• 

Tips:

If you have a number of articles to add from another database, say, you may want to
import articles instead of adding them.

• 
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Add a glossary item

The glossary gives your readers quick definitions or explanations of words or phrases
important to your application, but which the reader might not know.

There are two ways to add a glossary item:

Click the Add icon  at the top right of the Admin screen and select Glossary item.1. 
On the Articles tab select the Glossary sub-tab, then click the Add new button.2. 

Either method displays the Add new form. Provide the required information for the new item:

Word/phrase - This is the word or phrase that may puzzle your reader. This text will be
highlighted in red in articles. 

• 

Definition - Explain the word or phrase. In an article, the definition appears in a yellow
box when the reader clicks a word highlighted in red.

• 

There are two optional settings:

Highlight once - Select to have the word or phrase highlighted only the first time it
appears in an article. Repeated highlighting may make the article more difficult to read.

• 

Published - This is selected by default. De-select to have this item not display in the
glossary.

• 

Click Save to save the new item. Click Cancel to abandon your edits and close the form. Click
Preview to see how the item will appear.
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Add a user

To add a new user

Click on the Users menu• 
Click on Add New.• 

Once you are on the Users screen you must complete the following sections:

Give the user a First Name and a Last Name• 
Add their Email• 
Give them a Username. If you prefer, you can set their email as their user name.• 
Set up a Password• 

The following items are optional:

Assign a Privilege. If you do not assign a privilege the user will have standard read
access to the public area.

• 

To classify the user, and provide another level of access, include a Role. • 
You can include extra user details such as a Middle Name, Phone and Company• 
You can add comments about the user or registration• 
You can automatically subscribe them so that they receive changes to news, articles or
files

• 

To give the user immediate access to the system, make this user Active• 
To send an email to the user after then that their user ID has been created, check
Notify User.

• 

You can find out more about each of these fields on the User screen and how
they work in the User Screen Explained

Once your user has been set up:

Click Save.• 

Tips:

If you have a number of users to add from another database, say, you may want to
import users instead of adding them

• 

Or you may choose to allow users to register, which effectively allows them to create
their own user.

• 
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Final steps

You now have a simple, working knowledgebase. Now users can read your articles.

 From here, you may like to:

Experiment with different category types to see what effect each one has• 
Consider adding roles to users so that you can control what individual users see• 
Add items to your glossary• 
If you have lots of pre-existing documentation that can't be imported as articles, why
not upload them as files.

• 

If you are an administrator, you can also fine-tune the system:

Modify the look and feel of your knowledgebase• 
Add some templates to make creating your articles easier• 
Take a look at the email templates to see what's in the mails going out from and coming
in to the knowledgebase

• 

Manage the RSS feeds• 
Create your own user privileges and roles• 
Set some initial user defaults.• 
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Remote Authentication

LDAP Authentication

Using Remote Authentication

Remote authentication allows you to integrate your organization's authentication system with
KBPublisher.
Configuration requires only a few simple steps.

Steps to enable Remote Authentication

Set the config variable $conf['auth_remote'] in the file admin/config.inc.php to 1• 
Click on Settings• 
Click LDAP Authentication  • 
Set up LDAP settings and authentication options, see this article for details• 
In case if youy want to use Auto Authentication, you set it up, see this article for details• 

Quick summary of the process

End user goes to site• 
Remote Authentication checks for valid user credentials

If auto-authentication is set, does this automatically♦ 
If auto-authentication is not set, user logs in first♦ 

• 

KBPublisher authenticates the user .• 
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Tracking logins

You can see how your remote authentication works in logs Logs/Logins

For debugging every last login is logged to a file called last_remote_login.log in the
KBPublisher cache directory (APP_CACHE_DIR in admin/config.inc.php ).
For example: /home/username/ kb_cache/last_remote_login.log
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Setting up Remote Authentication

LDAP Authentication is accessible by administrator in Settings > Ldap Authentication tab in
Admin Area.

Settings

Remote Authentication. Enabled/disabled remote authentication and set the path to
file with remote settings. To enable remote authentication set $conf['auth_remote'] = 1; 
in file [kbp_dir]/admin/config.inc.php.

• 

LDAP Options. Identify host name of your LDAP server and the port for the protocols.
The default port for LDAP over SSL is 636, for LDAP over TCP, UDP, or for TLS it
is 389. You can specify Base DN for LDAP server and user DN and password. Leave
User DN and Password fields empty for anonymous binding.

• 

Configuration. Set up the IP addresses for local authentication, specify whether to
rewrite user data on login in "Rewrite user on login" field: 0 - once user created
the data in KB will never been updated; 1 - on every authentication request, the user
data in KB will be rewritten. You also can set up the options for updating user profiles
and reseting password.

• 

Configuration Auto Authentication. In this section you can determine whether or not
auto authentication is allowed and specify the path to the file where the auto
authentication is defined.

• 

Group Mapping. Here you can set up LDAP group mapping behavior.  LDAP groups
can be either static or dynamic. A static group entry contains a list of its users. A
dynamic group is where the user entry contains a list of groups it belongs to.

• 

User Mapping Fields. Define the LDAP attributes - first name, last name, email,
remote user id and attributes for privileges and roles (optional). In your expression use
the round bracket to identify the specific characters to parse out the records as the
field. 
For user's privilege and role mapping you can give users privileges based upon their
group attributes. Click [...] button to map LDAP groups to KBPublisher Privileges and/or
Roles. 

Please note, if you set mapping LDAP groups to the KBPublisher privileges, all matched
users will be assigned the specified privilege. In case you do not have an  Unlimited
license,  the number of allowed admin users could be exceeded and privilege will not be
assigned to user.

Important!  If you leave this field blank, roles and privileges assigned for users in
KBPublisher will not be updated upon login.

• 

Test / Debug Options (optional). Set up data to test / debug authentication for actual
LDAP user.

• 
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Using Auto Authentication

Auto authentication allows you to automatically authenticate users.

Steps to enable Auto Authentication

Set the setting Auto authentication to 1 - ON, user will be logged in
automatically  in the Settings > LDAP Authentication tab

• 

Set the setting File path to where your _remoteAutoAuth defined, set it to default for
default file (admin/lib/custom/remote_auth_auto.php) 

• 

Customize the _remoteAutoAuth function to catch current user data and return it• 
Rename the function _remoteAutoAuth to remoteAutoAuth• 

Customizing the remoteAutoAuth function

In your installation there is a folder admin/lib/custom. Within that folder is a file called
remote_auth.php. This file contains the _remoteAutoAuth function. Customize this function to
get the current user's credentials.

On success, the function remoteAutoAuth should return an associative array with keys
(username, password) for the user.  For example: array('username'=>'John',
'password'=>'Test').

Here is a simple example of the function customized using HTTP authentication:

function remoteAutoAuth() {

    $user = false;

    if(isset($_SERVER['PHP_AUTH_USER']) && isset($_SERVER['PHP_AUTH_PW'])) {
         $user = array();
         $user['username'] = $_SERVER['PHP_AUTH_USER'];
         $user['password'] = $_SERVER['PHP_AUTH_PW'];
    }                

    return $user; 
}

Debugging auto-remote authentication

You can debug auto-authentication by setting Auto authentication to 2 - ON, debug mode
in the Settings > LDAP Authentication tab, which allows you to continually try relogging in so
that you can fix any problems without having to start over every time.

Important: Don't forget to reset this back to 1 (or 0) when you have finished debugging.
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Advanced Authentication (and in version 4.5 and below)

Using Remote Authentication

Remote authentication allows you to integrate your organization's authentication system with
KBPublisher. Configuration requires only a few simple steps.

Before you start:

We assume that you have some experience with PHP and with the system you are
connecting to.

• 

Steps to enable Remote Authentication

Set the config variable $conf['auth_remote'] in the file admin/config.inc.php to 1• 
In version 5.0 and above only
Click on Settings -> LDAP Authentication and check Use file for Remote
Authentication checkbox

• 

Set required values for constants in file admin/lib/custom/remote_auth.php• 
Customize the _remoteDoAuth function in the file admin/lib/custom/remote_auth.php
to authenticate the username and password passed to it against your own
authentication system

• 

Rename the function _remoteDoAuth to remoteDoAuth• 

Quick summary of the process

End user goes to site• 
Remote Authentication checks for valid user credentials

If auto-authentication is set, does this automatically♦ 
If auto-authentication is not set, user logs in first♦ 

• 

KBPublisher authenticates the user .• 
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Customizing the remoteDoAuth function

In your installation there is a folder admin/lib/custom. Within that folder is a file called
remote_auth.php. This file contains the _remoteDoAuth function. Customize this function to do
authentication against your internal system by using the username and password provided.

Here is a simple example of the function customized to authenticate against a MySQL
database:

function remoteDoAuth($username, $password) {

    $user = false;
    $db = &DBUtil::connect($conf);

    $sql = "SELECT 1 FROM ss_user WHERE username = '%s' AND password = '%s'";
    $sql = sprintf($sql, $username, $password);
    $result = &$db->Execute($sql) or die(db_error($sql, false, $db));
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    // if found
    if($result->RecordCount() == 1) {
        $user = 1; // assign a user id, this user id should exists in kb user table
    }

    return $user;
}

 Also see examples in attached files.

Tracking logins

You can see how your remote authentication works in logs Logs/Logins

For debugging every last login is logged to a file called last_remote_login.log in the
KBPublisher cache directory (APP_CACHE_DIR in admin/config.inc.php ).
For example: /home/username/ kb_cache/last_remote_login.log
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Using Active Directory for Remote Authentication

It is possible to use Remote Authentication with your LDAP server.

Before you start:

We assume that you have some experience with remote authentication, with PHP, and
with lightweight directory access protocols (LDAP).

• 

Requirements

LDAP support in PHP is not enabled by default. You will need to enable it. For more details
check PHP documentation at http://php.net/ldap.

You may want to use Active Directory/PHP Helper library from http://adldap.sourceforge.net. If
you do want to use it, download the library and place it into the
kb_installation_dir/admin/lib/custom directory.

Here is an simple example of the function customized to authenticate against a LDAP server:

function remoteDoAuth($username, $password) {

    require_once 'custom/adLDAP.php';

    $auth = false;
    if(empty($username) || empty($password)) {
        return $auth;
    }

    //create the AD LDAP connection
    $adldap = new adLDAP();

    $user = array();
    $ldap_user = $adldap->user_info($username, array(*));

    // if found, populate $user array 
    if($adldap->authenticate($username, $password)){
        $user['first_name'] = $ldap_user[0]['givenname'][0];
        ...
    }

    return $user;
}

You can find more examples in kb_installation_dir/admin/lib/custom directory.
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Different ways for Remote Authentication

There are two different types of remote authentication. It is controlled by the KB_AUTH_TYPE
constant:

Adding/refreshing remote user data to KBPublisher and authenticate user.1. 
Authentication by existing KBPublisher user.2. 

Adding/refreshing remote user data to KB and authenticate user

KB_AUTH_TYPE = 1

On success, the authentication function remoteDoAuth should return an associative array
with the following keys:

first_name• 
last_name• 
email• 
username• 
password-- as the user types when they login, that is, not encrypted• 
remote_user_id -- a unique userID stored in your system• 
role_id - (optional)• 
priv_id - (optional) privilege for user. If user has a privilege, he will have access to
Admin Area

• 

Authentication by existing KBPublisher user

KB_AUTH_TYPE = 2

On success, the authentication function remoteDoAuth should return.

the user_id of the user in the KBPublisher USER table  (kbp_user)
OR

• 

Associative array with keys (user_id, username), for example: array('user_id'=>7,
'username'=>'Test').

• 

There are also other configuration variables

KB_AUTH_AREA
1 - Enabled for Public area only, remote authentication allowed on Public Area login
screen
2 - Enabled for Public and Admin areas

• 

KB_AUTH_LOCAL
0 - never try to authenticate by KBPublisher built in authentication
1 - always try to authenticate by KBPublisher built in authentication first
2 - will try to authenticate by KBPublisher built in authentication if Remote
Authentication failed

• 

KB_AUTH_LOCAL_IP
Only users with specified IP(s) are allowed to be authenticated by KBPublisher's built in

• 
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authentication
it only matters when KB_AUTH_LOCAL = 1 or 2.
You can set a specific IP or an IP range. Use an "-" to separate IP ranges, and a";" to
separate individual IP addresses.
For example: 127.0.0.1;210.234.12.15;192.168.1.1-192.168.255.255

KB_AUTH_REFRESH_TIME
The time, in seconds, to rewrite user data, (3600*24*30 = 30 days), works if
KB_AUTH_TYPE = 1
0 - never. Once the user is created, data in kb table never updated by script
1 - on every authentication request user data in the knowledgebase will be synchronized
with data provided by script.

• 

KB_AUTH_RESTORE_PASSWORD_LINK
Here you may provide a link where your remote users can restore their password.
Set to false not to display the restore password link at all.
KBPublisher will determine whether to set your link or the built-in one.

• 

KB_AUTH_AUTO (Using Auto Authentication)
This variable controls whether or not the user sees a login screen and has to log in to
KBPublisher, or whether they are automatically logged in.
0 - Disabled, user gets login screen
1 - Enabled, user doesn't see login screen
2 - Enabled, in debug mode. User doesn't see login screen. It allows not to block "Auto
Auth" if authentication failed.  
     Use only for debugging and don't forget to change back to 1 or 0 when you have
authentication working.

• 
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Remote Authentication scenarios

Here are some examples/scenarios for Remote Authentication:

On the first authentication request the remote user is added to KBPublisher table of
users.
On the second and subsequent requests he/she is authenticated by KBPublisher's built
in authentication.
KB_AUTH_LOCAL = 1
KB_AUTH_TYPE = 1
KB_AUTH_REFRESH_TIME = 1.

1. 

Always authenticate by Remote Authentication and rewrite user data in the
knowledgebase.
KB_AUTH_LOCAL = 0
KB_AUTH_TYPE = 1
KB_AUTH_REFRESH_TIME = 1

2. 

On the first authentication request the remote user is added to KBPublisher users.
On the second and subsequent requests the user is authenticated by remote
authentication and his/her KBPublisher data is synchronized with data provided by your
script, depending on the KB_AUTH_REFRESH_TIME.
KB_AUTH_LOCAL = 0
KB_AUTH_TYPE = 1
KB_AUTH_REFRESH_TIME = 3600*24*30 (30 days).

3. 

KBPublisher tries to authenticate the user by built-in Authentication first.On failure
KBPublisher tries to authenticate the user by Remote Authentication.
KB_AUTH_LOCAL = 1
KB_AUTH_TYPE = 2

4. 

If user IP matches KB_AUTH_LOCAL_IP range, then KBPublisher tries to authenticate
the user by built-in Authentication first. If the IP does not match, or built-in
authentication fails, KBPublisher tries to authenticate the user by Remote
Authentication.
KB_AUTH_LOCAL = 1
KB_AUTH_LOCAL_IP = '192.168.1.1-192.168.255.255';
KB_AUTH_TYPE = 2

5. 

Adding KB_AUTH_AUTO = 1 to any of these means the user will not be asked to type in their
username and password.
System will get that information automatically. See this article how to set up Auto
Authentication.
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Using Auto Authentication

Auto authentication allows you to automatically authenticate users.

Steps to enable Auto Authentication

Set the constant  KB_AUTH_AUTO in the file admin/lib/custom/remote_auth.php to 1• 
Customize the _remoteAutoAuth function in the file
admin/lib/custom/remote_auth.php to catch current user data and return it

• 

Rename the function _remoteAutoAuth to remoteAutoAuth• 

Customizing the remoteAutoAuth function

In your installation there is a folder admin/lib/custom. Within that folder is a file called
remote_auth.php. This file contains the _remoteAutoAuth function. Customize this function to
get the current user's credentials.

On success, the function remoteAutoAuth should return an associative array with keys
(username, password) for the user.  For example: array('username'=>'John',
'password'=>'Test').

Here is a simple example of the function customized using HTTP authentication:

function remoteAutoAuth() {

    $user = false;

    if(isset($_SERVER['PHP_AUTH_USER']) && isset($_SERVER['PHP_AUTH_PW'])) {
         $user = array();
         $user['username'] = $_SERVER['PHP_AUTH_USER'];
         $user['password'] = $_SERVER['PHP_AUTH_PW'];
    }                

    return $user; 
}

Debugging auto-remote authentication

You can debug auto-authentication by setting KB_AUTH_AUTO = 2, which allows you to
continually try relogging in so that you can fix any problems without having to start over every
time. Important: Don't forget to reset this back to 1 (or 0) when you have finished debugging.
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Importing

Import users

You can import users in bulk. You might want to do this if you are changing over to
KBPublisher from an old system, or if you have signed up a new company or organization and
the company provides you with a list of users to create.

The process is:

Create a file of users to import• 
Upload a test sample to the system• 
Import.• 

Create a file of users to import

First, you need to create your file of users. This is a comma-separated (CSV) text file that
consists of some or all of: first name, last name, email, username, user ID, date registered,
middle name, telephone number and an active flag.

The first five fields (highlighted bold) must be included. You can include some, all or
none of the others as required.

• 

They do not have to be in the same order as above, but each line in the import file must
contain the same fields in the same order.

• 

The password is encrypted. You cannot import plain text passwords; they must be
encrypted in MD5 format. Ensure that the person providing you with the list encrypts
the passwords.

• 

The active flag defaults to '1', which is active, so the only time you would set this is if
you don't want the users to be active.

• 

Place the data for each user onto a single line, and separate each field by a comma. Do
not include spaces before or after the comma.

• 

The TestImportUsers.csv file is a sample that shows what your upload file should look
like. This file includes the five default fields only.

• 

Field sizes and types are specific, as per the table below. Your data must fit within these
parameters or the upload will fail.

• 

Field Type/size M/O Comments

first_name varchar(50) compulsory

last_name varchar(100) compulsory

email varchar(100) compulsory

username varchar(50) compulsory

imported_user_id int(10)
unsigned optional

date_registered date optional
Format YYYY-MM-DD.
If not supplied will use
current date.
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middle_name varchar(50) optional

phone varchar(20) optional

active tinyint(1) optional Default = 1

Create a test file

Don't try to upload the whole file without testing it first. If something goes wrong you may then
have to delete all those half-imported users and try again. Create a test file and run that first.

Copy the first, say, three lines of your text import to a separate file• 
Either:

Save the file to a local drive (e.g. somewhere on your c: drive)♦ 
Upload the file to the server♦ 

• 

Import the test file

You are now ready to import the test file to KBPublisher.

Click on the Import/Export menu• 
This brings up the Import Users tab• 
If the import file is on your c: drive (or another local drive),

Choose Load Data Local File in the SQL Load Command field♦ 
Browse for the CSV file on your drive and open it♦ 

• 

If the import file is on the server,
Choose Load data file♦ 
Type the address where the file is located into the Path to file field on CSV file
line

♦ 

• 

Move the CSV fields around to specify which fields are in the file and what order they
are in.
Do this by clicking on the name of the field you want to move and dragging and
dropping it into the appropriate place.

For example, suppose you only want the five mandatory fields included. You need to
move the date_registered and imported_user_id fields out of the Fields in CSV box and
into the Available table fields box. Let's start with the date_registered field.

Click on the date_registered field and hold the mouse down♦ 
While holding the mouse down, drag the date_registered field over to the
Available table fields box

♦ 

Drop the field into the box by releasing the mouse

Make sure that you place it in the order it appears in the file.

♦ 

• 

Change CSV options if required.• 
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Click Load.• 

Once the load is complete you are returned to the Import Users tab. At the top of the screen
you see a message telling you whether the import was successful and how many users were
imported.

If the import reports as successful, click on the Users tab to check the result for
yourself.

• 

Fix any problems

All going well, you should now have three new users. Check them carefully and ensure that
everything worked as you expected.
If you had problems, delete these three users, fix the test file and run it again. Keep fine-tuning
until it works, and then update the real file to match the fixes you made in the test file.
You are now ready to import the rest of the users.

Import users

Import the rest of the users using the same process as for the test file, only this time using the
real data file.

Note:

Imported users have no roles or privileges.• 
If any unique keys will be duplicated during import, records from cvs file will be
ignored.

• 

Use the bulk actions option to change roles, privileges, etc.• 
Temporary password generated for imported users, they should to reset it using "Forgot
Password" option.

• 
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Import articles

You can import articles in bulk.
You might want to do this, say, if you are changing over to KBPublisher from another system.

The process is:

Create a file of articles to import• 
Upload a test sample to the system• 
Import.• 

Create a file of articles to import

First, you need to create your file of articles. This is a comma-separated (CSV) text file that
consists of some or all of: title, body, date_posted, id, author_id, updater_id, meta_keywords,
meta_description, entry_type, external_link, date_updated, hits, sort_order, private and an active flag.

The first three fields (title, body and date_posted) must be included. You can include
some, all or none of the others as required.

• 

They do not have to be in the same order as above, but each line in the import file must
contain the same fields in the same order.

• 

The active flag defaults to '1', which is active, so they only time you would set this is if
you don't want the users to be active.

• 

Place the data for each user onto a single line, and separate each field by a comma. Do
not include spaces before or after the comma.

• 

Place quotes (") around text fields such as body, and be sure to check that your text
does not have quotes within the text. If your body, or other text field, does contain
quotes, choose a different delimiter and update the fields optionally enclosed by field
to match.

• 

The TestImportArticle.csv file shows a sample of what your upload file should look like.
This file includes the three default fields only.

• 

Field sizes and types are specific, as per the table below. Your data must fit within these
parameters or the upload will fail.

• 

Field Type/size M/O Comments

title text M Enclose text in quotes (")

body mediumtext M Enclose text in quotes (")

date_posted datetime O Format 0000-00-00 00:00:00

id int(10) O
Record ID. If this record ID already
exists in the database KBPublisher
will skip the record. It will not
overwrite an existing ID.

author_id int(10) O
If not supplied, the user currently
logged in and importing the articles
is set as the author.

updater_id int(10) O
If not supplied, the user currently
logged in and importing the articles
is set as the updater.

meta_keywords text O
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Enclose text in quotes ("). Format
should be the same as if you are
adding the keywords in add new
article.

meta_description text O Enclose text in quotes (").

entry_type tinyint(3) O Type.

external_link text O Enclose text in quotes (").

date_updated timestamp O Defaults to time imported to
knowledgebase.

hits int(10) O Defaults to 0.

active tinyint(1) O Defaults to 1.

Create a test file

Don't try to upload the whole file without testing it first. If something goes wrong you may then
have to delete all those half-imported articles and try again. Create a test file and run that first.

Copy the first, say, three lines of your text import to a separate file• 
Either:

Save the file to a local drive (e.g. somewhere on your c: drive)♦ 
Upload the file to the server♦ 

• 

Import the test file

You are now ready to import the test file to KBPublisher.

Click on the Import/Export menu• 
Click on the Import Articles tab• 
If the import file is on your c: drive (or another local drive),

Choose Load Data Local File in the SQL Load Command field♦ 
Browse for the CSV file on your drive and load it♦ 

• 

If the import file is on the server,
Choose Load data file♦ 
Type the address where the file is located into the Path to file field on CSV file
line

♦ 

• 

Move the CSV fields around to specify which fields are in the file and what order they
are in.
Do this by clicking on the name of the field you want to move and dragging and
dropping it into the appropriate place.
For example, suppose you want the three mandatory fields included, plus the author ID.
You need to move the user_ID field from the Available table fields box into the Fields
in CSV file box.

Click on the user_ID field and hold the mouse down♦ 
While holding the mouse down, drag the date_registered field over to the Fields
in csv file box

♦ 

Drop the field into the box by releasing the mouse♦ 

• 
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Make sure that you place it in the order it appears in the file.
Change CSV options if required.• 
Click Load• 

On completion of the load, you will see a message at the top of the Import Articles screen
telling you how many files were imported successfully and how many were skipped.

If the upload was successful, click on the Articles tab to check out the articles.• 

Fix any problems

All going well, you should now have three new articles in your knowledgebase. Check them
carefully and ensure that everything worked as you expected. If you had problems, delete these
three articles, fix the test file and run it again. Keep fine-tuning until it works, and then update
the real file to match the fixes you made in the test file.
You are now ready to import the rest of the articles.

Import articles

Import the rest of the articles using the same process as for the test file, only this time using
the real data file.

Note:

Articles are imported with a category name of Imported. If this category does not exist
it will be created as part of the upload process.

• 

If any unique keys will be duplicated during import, records from cvs file will be
ignored.

• 

Use the bulk actions option to change the categories, etc.• 
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Import glossary

If you already have a list of terms and definitions that you would like to use in your
knowledgebase, you can upload these terms in bulk.

The process is:

Create a file of glossary items to import• 
Upload a test sample to the system• 
Import.• 

Create a file of glossary items to import

First, you need to create your file of articles. This is a comma-separated (CSV) text file that
consists of a phrase, followed by a definition.

Both fields must be included, and they must be in the order of glossary item name
(phrase) first, and then the text that explains it

• 

Place the data for each glossary item onto a single line, and separate each field by a
comma. Include a space after the comma. If you choose to use something else other
than a comma, update the field terminated by field under CSV options to match.

• 

Field Type/size M/O Comments

phrase varchar(100) M The maximum size of a phrase is 100
characters

definition text M

id int(10) O
Record ID. If this record ID already exists in
the database KBPublisher will skip the
record. It will not overwrite an existing ID.

Highlight
once tinyint(1) O Defaults to 0.

Create a test file

Don't try to upload the whole file without testing it first. If something goes wrong you may then
have to delete all those half-imported glossary items and try again. Create a test file and run
that first.

Copy, say, the first three lines of your text import to a separate file• 
Either:

Save the file to a local drive (e.g. somewhere on your c: drive)♦ 
Upload the file to the server♦ 

• 

Import the test file

You are now ready to import the test file to KBPublisher.
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Click on the Import menu• 
Click on the Import Glossary tab• 
If the import file is on your c: drive (or another local drive),

Choose Load Data Local File in the SQL Load Command field♦ 
Browse for the CSV file on your drive and load it♦ 

• 

If the import file is on the server,
Choose Load data file♦ 
Type the address where the file is located into the Path to file field on CSV file
line

♦ 

• 

Change CSV options if required.• 
Click Load• 

On completion of the load, you will see a message at the top of the Import Articles screen
telling you how many files were imported successfully and how many were skipped.

If the upload was successful, click on the Articles tab to check out the articles.• 

Fix any problems

All going well, you should now have three new glossary items in your knowledgebase. Check
them carefully and ensure that everything worked as you expected. If you had problems, delete
these, fix the test file and run it again. Keep fine-tuning until it works, and then update the real
file to match the fixes you made in the test file.

You are now ready to import the rest of the glossary.

Import articles

Import the rest of the glossary using the same process as for the test file, only this time using
the real data file.

Note:

If the glossary item already exists, a new item will still be uploaded.  We recommend
you do not duplicate.

• 

If any unique keys will be duplicated during import, records from cvs file will be
ignored.

• 

----------------------------------------------------------------------
This functionality works in version 4.0 and above
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Add a Local File

When you want to add files to the knowledgebase, you can upload files from your local
computer, or you can link to files that are already on your server. In KBPublisher such files are
known as "local files". If the file already exists on the server it saves space to reference it
rather than uploading a second copy specifically for the knowledgebase. By adding a reference
to a file that may be also be available through your corporate website or some other site
(forms, disclaimers, fair-use and privacy policies, product disclosure statements, catalogues,
printable manuals, and so on) you can make the knowledgebase richer and more useful without
taking up additional space.

To add a local file (a reference to a file already on your server):

Select the Files menu• 
Choose the Add Local Files tab to display the Local add form:• 

Complete the form's fields:

Directory -- Enter the name of the directory on your server which holds the files you
want to link to. Then click Get files to display the file or files.
By default all files in the directory are selected. Un-check the check box for each file
you do not want to link to.

• 

Category -- Add one or more categories for the files by clicking the + icon to the right
of the Category field and selecting from the list of categories provided.

• 

Title -- Add a title. If you are linking to more than one file in this operation, all files will
have the same title.

• 

Description -- Add a description. If you are linking to more than one file in this
operation, all files will have the same description.

• 

Author -- By default you are identified as the author of the files. Click the Delete link to
the right of your name to remove it.

• 

Add a Local File 76



Private -- You can opt to restrict either or both read and write access to the files. If
you check either check box another field appears where you can specify which roles
users must have to be able to read and/or update the file.

• 

Schedule -- Check the Yes check box and use the fields that appear to set a date when
the status of the current files changes from unpublished to published. Check the And
check box to set a date after which the status of the current files changes from
published to unpublished.

• 

Status -- You  can set the file status as Published or Unpublished.• 

When the form is complete, click Add files to add the files to the list on the Files tab.

If you have the correct permissions, you can add the files as drafts.Click Add as Drafts to add
the files to the list on the Drafts tab. Use this option for files that you do not want to publish
yet, or for files that require further review or approval before becoming available. 

Tips:

The files that are found are controlled by the Allowed/Denied extensions setting on
Admin tab under Settings. If you have said there are no restrictions, then all files in
the directory are found. If you have said only image and text files are loadable, then
only image and text files will be found. See Files tab explained for more information
about this.

• 

Files listed are only those in the directory specified. It does not find files in
sub-directories within the current directory.

• 

The PHP open_basedir setting determines where KBPublisher searches for the files. If
you find that Get Files only searches the directories under the knowledgebase itself,
then check your settings to see if PHP restricts it to this.

• 
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Automatically Add Local Files

The Directory Rules screen allows you to set up the knowledgebase so that KBPublisher
automatically checks the specified directory on the server every day and adds in KBPublisher
links to any new files.

Standard allowed and denied extension rules apply, based on your denied and allowed
extensions set in the Files Settings tab. 

Note: a directory rule doesn't move files it identifies as new: it adds links in KBPublisher to
files on your server. If you move a file from the location KBPublisher linked to, the links to that
file in the knowledgebase will be broken.

To see and manage your directory rules, select Files in the main menu, and then the
Directory Rules tab:

If you have a long list of directory rules, you can filter the list by rule status or by the directory
the rule applies to, using the fields above the list of rules.

Managing directory rules

Check the check box in the Active column for a rule to enable that directory rule. Un-check the
checkbox to disable the rule.

Click the gear icon in the Action column of a row to perform one of these actions on the
directory rule in that row:

Edit - update the rule's information. The fields are the same as when you add a new
directory rule--see the descriptions below.

• 

Delete - delete the directory rule.• 

Adding new directory rules

To add a directory rule, click the Add New button. Complete the form that appears:
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Rule options:

Directory -  Provide the directory on the server that the directory rule should monitor.
The directory name should be the full server path. Click Read directory to verify that
the path is correct. If the path is correct, you see a list of all files in that directory.

• 

Parse child directories - Check this option to have the rule monitor all sub-directories
in the directory. This is selected by default.

• 

Description - A description is not required, but you can add one to describe the files
that normally appear in the directory, or information about the directory rule that may
be useful to other team members.

• 

Active - This field is selected by default, and once you save the new directory rule it will
run at the next scheduled opportunity. Un-check this check box to disable the rule (you
can also enable and disable a directory rule from the full list of rules, as described
above).

• 

File options:

Category - Add one or more categories to which the links to the new rules this directory
rule finds will be added. Click the + icon to the right of the field to add a category.

• 

Author - By default the current user's name appears in this field, and will be associated
with the link to any file the directory rule adds to the knowledgebase. You can select a
different user's name as the author, or opt to have no author name.

• 

Private - By default the links the directory rule creates are public. Check one or both
check boxes to control read and write access to the linked file to users with the roles
you specify. See private read and write.

• 

Schedule - Check the Yes check box to display fields where can control when the
newly-linked files become available in the knowledgebase, and, optionally, when they
become unavailable again. See Schedule an item.

• 

Status - By default, files are set to a status of published, but you can change this to
unpublished.

• 

To test the settings click Test.
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Click Save to save the new directory rule. Click Cancel to abandon your edits and close the
form.

Automatically Add Local Files 80



Exporting

Enable Exporting to PDF

To export multiple articles to PDF or HTML files you need to:

Install a program called HTMLDOC• 
Ensure Settings points to where you installed it• 
Ensure that PHP has access to your HTMLDOC directory. (Check
your open_basedir PHP setting in php.ini)

• 

Ensure that PHP can run the proc_open function. (Check
your disable_functions, safe_mode_exec_dir PHP settings in php.ini)

• 

Buy the export plugin  or try it in Demo mode• 
Add the plugin key to your KBPublisher settings• 

Install HTMLDOC

Note: At this time there is no commercial support for the HTMLDOC. The windows binaries
can be found here.

HTMLDOC is available from https://www.msweet.org/projects.php?Z1• 
Download it and install it• 

Update the setting to point to HTMLDOC

Once you have installed HTMLDOC, you also need to set the correct path it in the Settings.

You can find this under Settings menu, Settings -> Plugins -> HTMLDOC
installation path

• 

Make sure the HTMLDOC installation path points to the directory where you
installed HTMLDOC. For example: /usr/local/bin/.

• 

When you click "Save", test HTML file will be parsed and error occurs if it failed. • 

Buy the plugin

Export functionality is not available with the default KBPublisher package. You must purchase
it separately.
Please see this article how to buy the plugin.

Add the plugin key to KBPublisher

You should have received an email with you plug-in key. If you can't find the email,
you can also get this from the My Licenses tab in your client area on the KBPublisher
website.  

Copy the license key from your client area or the email• 
Log on to your knowledgebase• 
Go to the Admin Area• 
Click on the Settings menu• 
Click on the Plugins tab• 
Paste your key into the Plugin key field• 
Save.• 

Test HTMLDOC from command line
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To convert a single web page type:

$ /path_to_htmldoc/htmldoc --webpage -f output.pdf filename.html

Test using PHP and included test file:

$ cd /path/to/kbp_directory 
$ php -r "system('/ path_to_htmldoc/htmldoc --webpage -f output.pdf
admin/extra/plugin/export/template/export_test.html');"

Tip:

If you want to try the export plugin before you buy, use demo mode to get an idea of
how it works.

• 

----------------------------------------------------------------------
This functionality works in version 4.0 and above
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The Export to PDF and HTML Screens Explained

The export to PDF or HTML screen allows you to export your knowledgebase articles to html
pages or PDF files.

The Summary screen

When you first enter the screen you see a summary of any current exports that have been set
up.

Export functionality is provided as a plug-in and is purchased separately. If you have not
purchased the plug-in you will get a message telling you that the plug-in works in demo
mode--with some restrictions--but otherwise doesn't work.

1. 

Add New allows you to set up a new export2. 
The records information line contains the usual information, like how many records
there are, and how many pages of records there are

3. 

Title is the name of the export4. 
Category to export is the top-level category that will be exported. Any sub-categories
will be exported as well

5. 

Last generated shows the last time you generated documentation to export6. 
The Details action allows you to view details of the specific export7. 
The Update action allows you to update the export8. 
The Delete action allows you to delete the specific export.9. 

When you click on Add New, you are taken to the Add New Export screen.

The Add New Export screen
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Again, if you have not purchased the plug-in, you will get the message at the top of the
screen.

1. 

Export options

The export options define what data you are actually going to export.

Title is the name you are giving to this particular export.2. 
The description is displayed on the Export Details screen. Use it for information about
how and why this particular document template was set up.

3. 

Category to export. You can only export one category at a time but, but all
sub-categories are exported as well.
Click on the + to the right of the Category to export field to select the category.

4. 

Export for user controls which articles are exported. That is, the audience for the
published document.

5. 

To export all articles in the category and in any sub-categories, irrespective of roles or
privileges, choose Admin user. You might use this for internal documents, or even for
proofing.
To export only those articles that the user sees in the Public view, without logging on, select
Not logged user
To export articles that a user in a specified role will see, select Logged user. If you select this
option, you also need to assign a role.

The with role field is only displayed if you if you choose to export for a logged user.
Click on the + to the right of the with role box to select the role. Again, you can only
select one role.

6. 

If you need help filling out a specific field, click on the ? for that field.7. 

Document options

The rest of the screen is devoted to how the output is produced.
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The Title is the title of the document. If you are creating a PDF this will be the front
page. If you are creating an HTML page this is the name on the browser tab.

8. 

Check Add to header if you want your title on every page of your PDF.9. 
The title image is the image that goes on the front page of your PDF document. We
recommend that this image be no larger than 500x500 pixels.

10. 

These images must be in the HTML settings folder on the server.  To upload an image from you
local drive, click on the folder icon next to the Title image field.
Once the image is on the server, select it, and attach. Then close the image load browser to
return to the Export screen.

When you check the PDF button extra fields are displayed for you to complete. These
fields are specific to the PDF output.

11. 

Orientation allows you to set the page as portrait or landscape.12. 
If you intend to print the document on a double-sided printer, select two sided. This
gives mirror-image page headings.

13. 

If you want your document to have a logo in header, add a logo image.

To add the logo, click on the folder icon next to the Title image field. Again, you can
browse and upload it from a local drive if you wish. 
Once the image is on the server, select it, and attach. Then close the image load
browser to return to the Export screen.
We recommend that the logo image be no larger than 200 pixels wide by 100 pixels
high.

14. 

You can also password protect your document by adding a password15. 
If you choose HTML (one page) your document is produced as one big HTML
document.

16. 

If you choose HTML (many pages) each article gets its own HTML page.17. 
Click Save to save the template without generating the document.18. 
Click Save and Generate to create documents as well as saving the template.19. 

To actually view the generated document you need to go back to the Export screen and click on
the template you have saved.

The Export to PDF and HTML Screens Explained 85



Export Articles to PDF or HTML

What does export articles do?

Our export functionality allows you to export all or part of your knowledgebase to a PDF or to
HTML files. This is ideal if you want to create a user manual or place some of your content
elsewhere.

You can export the whole knowledgebase or a single category and sub-categories, and you can
use roles to tailor the articles for a specific audience.

Producing an exported document is a two-part process. First, you create an export template by
defining what articles you want included and the document format.  Then you generate the file.
The two-part process allows you to set up the document once and regenerate any time you
want to include updated content.

To create a new export template

To export:

Click on the Export to PDF or Export to HTML menu• 
Choose Add New.• 

This takes you to the Export screen where you choose the following export options:

Provide a title for the export.• 
We recommend that you add a description, Once you have a number of exports set
up this will help to identify them.

• 

Select a category to export. You can only select one category. Sub-categories will be
exported as well.
If you wish to select the whole knowledgebase, select the topmost parent category.
To select a category, click on the + to the right of the category to export field,
double-click on the category to move it down to the assigned category box, and OK.

• 

Choose which user type to export for in export for user.
To export all articles in the category and in any sub-categories, irrespective of roles or
privileges, choose Admin user.
To export only those articles that the user sees in the Public view without logging on,
select Not logged user.
To export articles that only users in a specific role will see, select Logged user. If you
select this option, you also need to specify a role as well.

• 

If you are creating a PDF

Add a title. This is displayed on the title page of the document.• 
If you want the title to be displayed on the header of each page, check Add to header.• 
If you want an image on the title page, click on the folder to the right of Title image.
This takes you to the load image page.
If you need to, load the image from your local drive by clicking Add New and browsing
for the file to upload it.  Once your image is in the list, click Attach, and then close the
load image popup.

• 

Check the PDF option. This opens up some new fields specific to PDF documents.• 
Use the orientation to choose whether the document is to be in portrait or landscape
mode. Default is portrait mode.

• 
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If you intend to print the document double-sided, check two sided. This sets up left and
right pages.

• 

To add a logo to the header on each page, click on the folder to the right of logo image
and select your logo from the list. Again, if the logo you want is not in the list, you can
upload it from a local drive. Once you have selected the logo, Attach it and close the
load image popup to return to the Export screen.

• 

If you wish to password protect the PDF document, add a password.• 

If you are creating an HTML page or pages.

Add a title. This is displayed as the tab name on html documents.• 
If you want an image to be added to the title page (index.html), click on the folder to the
right of Title image. This takes you to the load image page.

• 

If you want each article as a separate HTML file, check HTML (many files). If you
everything in a single html file, check HTML (one file).

• 

Save your settings.

Click Save and Generate to save your template setup. You can reuse this setup as
often as you like to generate new documents for these settings. At the same time a first
copy of the document is generated.

• 

This returns you to the Export screen with the new export template listed• 

Tip:

You are not limited to saving in one particular format. You can check all three options if
you wish.

• 

If you just want to set up the export rather than generate it right now, click Save rather
than Save and Generate when you have completed all the fields. This sets up the export
file but doesn't generate it.

• 

HTML files are zipped.• 

----------------------------------------------------------------------
This functionality works in version 4.0 and above
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Export Articles to CVS, Excel or XML

To find the Export Articles tab, select Export from the menu bar. Then select Export Articles
from the three tabs available:

What does export articles do?

The Export Articles tab lets you export the articles and information about the articles, in
spreadsheet form. You could then review and work with the material in Excel or any other
spreadsheet tool, or use the file to import the data into a database.

To manage your exports

The tab displays a list of your export templates. Click the Action button to the right of an entry
for the action options:

Details - Review the details of exports using this template, including the date and
status of the most recent export.

Click Generate beside any export type to regenerate the export files.♦ 
Click the export type name (CSV, EXCEL, or XML) to download a ZIP file of the
exported files.

♦ 

Click Update to move from here to the Update action, or click Back to return to
the list of export templates.

♦ 

• 

Update - Update the selections or description for the export, following the information
for creating a new export, below. Click Save to save your changes; click Save and
Generate to export the data for this export again; click Cancel to abandon your
changes and close the form. 

• 

Delete - When you select this option, a confirmation form appears to make sure you
really want to delete this export template. Click OK to remove the record; click Cancel
to keep the template and end the process.

• 

To create a new export template

To create a new export template, click Add new to open the Export options form. Complete
the form to export the articles you want, and the metadata about them you select.

Title - Required. Provide a title for this template.• 
Description - Optional. Provide a description for this template.• 
Category to export - You must select at least one category. Click the + button and
select from the options available. If you need to export all KB, choose "All categories (All
KB)".

• 
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Export for user - Some articles may be invisible to certain user types. Select the user
type to filter the categories you chose to include just the content that user type can see.
Options are:

Admin User - Export includes all content in the selected categories. The system
ignores any private attributes for the user.

♦ 

Not logged in user - Export includes content a user who is not logged in can
see.

♦ 

Logged in user - When you choose this option you can specify roles to limit the
export to the content a user with a selected role can see. To add a role, click the
+ button and select from the options. If you specify no role, then the export
includes all content a logged-in user can see.

♦ 

• 

Columns - Select the columns to include in the export by dragging the names of the
columns you want from the "Columns not included in table" list to the "Columns
included in table" list. To remove columns from the export, drag the column names back
to the left-side list. You can rearrange the columns in the export table by dragging the
column names higher or lower in the right-side list.

• 

Encode images - Select this option to encode any images included in the export in
base64 format.

• 

Export published articles only - Select this option to include in the export only
published articles.

• 

Document options - You can select one or more of the export options: CSV, XML, and
EXCEL.
For CSV you can accept the defaults for the following fields, or edit the field contents to
suit your needs:

Fields terminated by - Default is a comma (,).♦ 
Fields optionally enclosed by - This allows you to include the field terminator,
such as a comma, within the text of a field. The default is double quotation marks
(").

♦ 

Lines terminated by - The default is \n.♦ 
Include field names row - Select to include a header row of all field names.♦ 

• 

Click Save to save this template; click Save and Generate to save the template and generate
files in the formats you have selected with the required data; click Cancel to close the form
without creating a template.

...
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Generate file from export template

Once you have saved an export template, you can use it at any time to generate or regenerate a
document. The new export takes the latest copy of each article from your knowledgebase.

Click on the Export menu• 
Click on the tab with the required export format to display the export templates you
have for that format.

• 

For the template you want to use, click the icon in the Action column. Then select
Details.

• 

In the Details screen you can review information about the template and, in the
Downloads row, information about files it has been used to generate. This row has
different sections depending on the export format:

Export KB to PDF - one section♦ 
Export KB to HTML - a section for single-file export and another for multiple
file export.

♦ 

Export Articles - up to three sections for Excel, CSV and XML export,
depending on how the template is set up.

♦ 

• 

If articles have already been generated, you can click the file type to download them.• 
Click Generate for the format in which you want to generate or regenerate documents.
If there is an export date, it updates to reflect the date and time of this export.. 

• 

Click the file type to download the newly-generated documents.• 

----------------------------------------------------------------------
This functionality works in version 4.0 and above
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Export Articles from the Public Area

If you have purchased the export plugin, then you can set your knowledgebase up so that users
can export a whole category of articles as a PDF document, or print it, from the Public Area.

To allow public export of articles

Purchase the export plugin and install it• 
On the Settings menu choose the Plugins tab• 
Check allow category exporting.• 

To generate a PDF file or print a category from the Public Area

Once allow category exporting is set, users will find an Options button on their screen
when they view a category

• 

Click on the Options button• 
This opens a new options panel which allows a user to:

Search for items specifically within the category they are looking at♦ 
Create a PDF document♦ 
Create a printable html page.  This contains basic text without all the headings
and left menu and right information block.

♦ 

• 

The information covers all articles in the category.  The user can then print or save this
as required. 

• 

----------------------------------------------------------------------
This functionality works in version 4.0 and above
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Export articles to PDF in demo mode

KBPublisher ascribes the "try before you buy" philosophy. 

You can try the export plugin by using a key of demo key instead of a purchased key.
This allows you to set up, create and test the export plugin and to work out if you want to buy
it.

There are some limitations with the demo model:

Only the first three articles for each category will be exported.• 
A watermark is added to the page background.• 
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News
News functionality in KBPublisher 

The News Input Screen Explained

The blue line at the top of the screen denotes whether you are adding a new news item
or editing an existing one.

1. 

The Date is the news date displayed on the Public area screen.2. 
The Title is the news heading.3. 
Body is the news article itself.

Note that on the Public area home page the user only sees the first 200 characters of
this. They click on the news heading to open the news item and see the rest..

4. 

Checking the Private Read option allows you to force users to log on to see the news
item.  Checking Private Write allows you to control who can edit the news item.
 Checking both gives you control over who can read it, whether they have to log on, and
who can update it.

Designating that a news item is private brings up a list for you to choose Access for
selected roles only. This allows you to assign which groups of users (users in which
roles) can actually read the news item. Choose None if you just wish to make the news
private (so they have to log on) but still want everyone to be able to read it.  Otherwise,
choose the role(s) that can see or update this item.

5. 

Checking the Schedule option allows you to dictate a date and time for when a news
item is published and when it drops off the news list.

When you check Yes to the Schedule option it brings up a date and time, and allows you
to determine whether the news item is to be published or not published at that time. An
And option allows you to specify a second date/time and status to schedule.

6. 

Use the Published option to specify whether users can read the article or not.

You would often use this in conjunction with scheduling. For example, you may set a
news item so it is not (Published option not checked) and schedule it to be published
on a specific date and time.

7. 

The OK and Cancel buttons are standard. OK means save the news item, Cancel
means exit and don't save.
Save as new means save the news item as a new one. This is effectively a copy.

8. 
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----------------------------------------------------------------------
This functionality works in version 3.5 and above
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Add News Item

The quickest way to add a news item to use the Shortcuts menu at the top of your screen:

Click on the drop-down menu in the top right of the screen and choose Add News .• 

Or you can do it via the News tab in the Admin Area.

Click on the News menu• 
Click on Add New.• 

Once you are on the news screen you must complete the following sections:

Add a Date for your news item• 
Add a Title. This is the heading displayed on the public screen• 
Type your news item in the Body editing box• 
Specify whether the news item is Published or not.• 

The following items are optional:

To force users to log on to read the news item, mark it as Private• 
To publish or change to not published at a future date, Schedule it• 

You can find out more about each of these fields and how they work in The News
Screen Explained.

Once your news item is complete:

Click Save.• 

----------------------------------------------------------------------
This functionality works in version 3.5 and above
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Edit news item

To edit a news item, including changing the date, changing the text, schedule and whether an
article is published or not published and private or not private:

Choose News menu• 
Click the Options icon under Actions to display the dropdown list, and then click Edit.• 

You can find out more about each of these fields and how they work in The News Screen
Explained.

If you wish to simply change the news item to published or not published:

Choose News menu• 
Check or uncheck the Status option.• 

You can also use the bulk update option to set a news item as private/not private and
published/not published or to delete it. Using this feature, you can update more than one news
item at a time.

----------------------------------------------------------------------
This functionality works in version 3.5 and above
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Delete news item

To delete a single news item:

Choose News menu• 
Click on the News tab• 
Click Delete from the options dropdown menu.• 

To delete one or more news items:

Choose News menu• 
Click on the News tab• 
Check the Actions with selected check box to the left of each article you wish to delete• 
Choose Delete from the Actions with selected box at the bottom of the screen• 
Click OK• 
OK again to confirm that you really do want to delete these articles.• 

----------------------------------------------------------------------
This functionality works in version 3.5 and above
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Bulk update news items

KBPublisher allows you to bulk update news items to:

Publish news items or set them to not published• 
Make news items private or public• 
Schedule news items• 
Set custom fields• 
Set news status• 
Delete news items• 

You can do this direct from the News menu, News tab.

To update the news items:

Check one or more news items to update• 
Choose the appropriate action from the drop down list of actions with selected• 
This brings up further options to select from according to the action chosen. Choose the
appropriate selection

• 

Click OK.• 

Note:

Bulk actions available depend on your user access.
For example if your privilege does not allow you to delete items, or allows you to only
delete articles that you have created, then there is no 'Delete' action in the list of
options. If your privilege does not allow you to update items, or allows you to only
update items you have created, then this menu will not be available for you at all.

• 

----------------------------------------------------------------------
This functionality works in version 3.5 and above
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Subscribe to news

To be notified when news items are added to the knowledgebase:

Click on My Account• 
Click on the Subscriptions tab• 
Choose Subscribe/Unsubscribe for News.  This brings up a subscribe button.  • 
Click Subscribe• 

You will be notified daily of changes to news items.

----------------------------------------------------------------------
This functionality works in version 3.5 and above
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Unsubscribe from news

To no longer receive notifications about updates to the news area of the knowledgebase:

Click on My Account• 
Click on the Subscriptions tab• 
Choose Subscribe/Unsubscribe for News.  This brings up a subscribe button.  • 
Click Unsubscribe• 

----------------------------------------------------------------------
This functionality works in version 3.5 and above
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Schedule an Item

Scheduling an article, news or file allows you to set a date that the item is made visible to
users in your knowledgebase and/or a date that it stops being visible.

For example, suppose your company is closed for the Christmas/new year holiday
periodaâ�¬"say it is closed from 12 noon on 24 December and re-opens at 9 am on the 2nd of
January.

You add a news item to say that you will be closed over this period. When you create it
(on 18 December, say), you set its status to "Not Published"

• 

You schedule this news item to change status to "Published" at 12 noon on 24
December, and to change status again to "Not Published" at 9am on 2 January.

• 

Or suppose you have a new software release being implemented. You can create new articles
for the new functionality in the software before the release. Give these articles a status of 'Not
published', and then schedule them to be published on the assigned release date.

To schedule the item:

Create or edit the article, file or news• 
If you are scheduling an article, click on the Advanced tab (you don't need to do this for
files or news items)

• 

Check Yes to the Schedule option• 
This expands the Schedule options• 

Add a date and time to the On the Date fields to set the date and time that the item is
to change status

• 

Use the Change Status To for  dertermining whether the item is to be published or not
published. (Articles have two further statuses, pending and draft.)

• 

Add a Note to explain why this item was scheduled on this date.  Use it as a reminder
or as a record of what happened.

• 

If you wish, you can set a second date and time to change to another status:

Check the And checkbox• 
This brings up a second set of date and status options• 

Add a date and time to the second On the Date fields to set the date and time that the
item is to change status

• 

Use the second Change Status To for  assigning the new status• 
Add a second note if required.• 

Items that are scheduled have a small clock next to the article/file/news ID on the list screens.
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Tip:

You can also use bulk actions to schedule or remove schedules.• 

----------------------------------------------------------------------
This functionality works in version 3.5 and above
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Remove scheduling

To remove scheduling from an article, file or news:

Edit the item• 
Uncheck the Schedule checkbox• 

You can also use the bulk actions option to remove scheduling from multiple articles or files:

Select each item to be un-scheduled• 
Choose remove schedule from the Actions with selected options at the bottom of the
screen.

• 

----------------------------------------------------------------------
This functionality works in version 3.5 and above
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Articles

Articles

Information about Articles, how they work and how to add and update them. 

The Article Input Screen Explained

The article screen is divided into two tabs. A Main tab, which is what you use to create the
article, and an Advanced tab, where you set external links, the order of the article inside a
category and whether or not the article is published. The Advanced tab also allows you to
schedule articles for publication.

The Main tab

The blue line at the top of the screen denotes whether you are adding a new article, or
editing an existing one.

1. 

If this is an existing article, it will have an Article ID. This is the record number under
which the article is stored in the database. This line also contains a link to public area,
so you can see the article as a user sees it, and a link to the history, where you can view
prior versions.

2. 

It will also show the date the original article was created in Date Posted, and who
created the article

3. 

The Date Updated field shows the last time the article was updated, and who updated
it

4. 

Type is has two purposes. It is used to group records for searching and it can also
provide a default template for the article. It is not compulsory. If you want to remove a
type you have already included, set the Type back to the first item in the drop-down list
(___).
Articles types can be managed in Tools -> Lists -> Article Type.

5. 
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Category controls where the article will be placed in the knowledgebase. It is,
effectively, the menu or the table of contents. Note the red '*' to the right of the word
'Category'. This means that this field is compulsory. Note also that some of the
categories are red. These categories are private categories. When you select a private
category, KBPublisher lists roles and restrictions beneath the category list so that you
know which users can access the article.

6. 

You add or remove categories by clicking on the + and - buttons7. 
Title is the heading that goes on the page, and also the link that is displayed under the
category (table of contents). It, too, is compulsory.

8. 

The Article is the content that people read. Again, it's compulsory. Type your article
into the edit box. Move your mouse over each of the icons in the edit toolbar to see what
each one does, or you can read about each function in edit toolbar explained.

9. 

Templates can be inserted into the text by choosing the template from the drop-down
list and then clicking on Insert, Replace or Include template. Using templates in articles
describes how templates work and how to use them.

10. 

Meta Keywords / Tags are search words. If you define a keyword here and a user then
searches using that keyword, this article is displayed. Use a comma to separate each
keyword.
Some external search engines may also use this for search engine optimization.

11. 

The Meta Description is a brief summary of what is on the page. This description is
often used by search engines when displaying details of a page.

12. 

You can easily cross reference other articles in your KBPublisher database by choosing
Related articles. You can link to text within the article, or you can add a link that is
displayed under the heading 'Also read' at the bottom of the page. How do I add a link
to an article explains the process in more detail.

13. 

You can link to files in your KBPublisher database by choosing Attachment. Again, you
can add it as a link to text within the article, or you can add the link at the bottom of the
page under the heading 'Attached files'. Attach a file to an article explains this in more
detail.

14. 

Use the Status to specify whether this article is published, meaning users can read it,
not published, or pending (approval required).
Articles statuses could be managed in Tools -> Lists -> Article Status.

15. 

The Revision comments box is only displayed once you start editing the content of the
article.  Use this to add comment version history information. When you look at the
history, these comments will help you remember what was changed for this verison.

16. 

The OK and Cancel buttons are standard. OK means save the article, Cancel means
exit but don't save.
Save as new means save the article a new one. This is effectively a copy.

17. 

The Advanced tab
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Again, the blue bar tells you whether you are editing an existing article or creating a
new one.

1. 

You can add links to other web sites by adding them to the External links field. Type or
paste the address (URL) of the page you want to link into the field. These then appear at
the bottom of the article under the heading 'External Links'.

You can append an optional title to each link using a pipe symbol to separate the url and
title.
Use an to separate links. Links must begin with http://.

e.g. http://kbpublisher.com | KBPublisher

2. 

The categories you have selected for the article are listed in the Order field, along with
a drop-down list of where to place the article within the category. There is one order list
for each category you have chosen.

3. 

Checking the Private Read option means that the user must log on to read the article. 
Checking the Private Write option allows you to restrict who can edit the article.

Designated that an article is private brings up a list for you to choose Access for
selected roles only. This allows you to assign which groups of users (users in which
roles) can actually read the article. If you just wish to make the article private but still
want everyone to be able to read it, choose None.

4. 

You can Schedule articles to be published or not-published at a specified date and
time.

Checking the Schedule box brings up date, time and status fields. Fill these in to
schedule that the article will change status on that date. You can specify one or two
schedule dates. Schedule an item explains this in more detail.

5. 

You can save your article on the Main tab or on the Advanced tab. The OK and Cancel
buttons are standard. OK means save the article, Cancel means exit but don't save.
Save as new means save the article a new one. This is effectively a copy.  Save and
continue editing allows you to save the document but remain on the edit page to make
more changes.

6. 
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Add an Article

If you are in the Public area, the quickest way to add an article is via the button in the top right
of your screen:

Click on Add article• 

If you are in the Admin area, another fast way is to to use the Shortcuts menu at the top of
your screen:

Click on the drop-down menu in the top right of the screen and choose Add new
article.

• 

Or you can do it via the Articles tab.

Click on the Articles menu• 
Choose the Articles tab• 
Click on Add New.• 

Once you are on the article screen you must complete the following sections:

Choose where you want the knowledgebase article to be displayed by
adding a Category or categories

• 

Add a Title. This is the heading displayed on the knowledgebase screens and in any
menus/table of contents.

• 

Type your article in the Article editing box.• 

The following items are optional:

To help users search within your database, include a Type and Meta Keywords• 
To optimize web search add Meta Keywords/Tags and a Meta Description• 
To add links to other web sites, include External links• 
To add links to other articles in the KBPublisher database, include them as Related
articles

• 

To add links to files, include then as Attachments• 
To force users to log on to read an article, mark it as Private Read. To restrict who can
read the article mark it as private read and then assign specific roles which can access
it.  To restrict who can edit the article, mark it as Private Write.

• 

To say where in the list the article is placed, specify the Order• 
Use the Status field to make the article available to read.• 

You can find out more about each of these fields and how they work in The
Article Screen Explained.

Once your article is complete:

Click Save.• 

Tips:

If you have a number of articles to add from another database, say, you may want to
import articles instead of adding them.

• 
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Quick add an Article

The Quick Add feature is a shortcut that will significantly reduce the time it takes for you to
add a new article to  Knowledgebase.
You will see an article the same as published article. Inline HTML editor will help you ...[add
some words]

Using the "Quick Add" feature

Adding an article to the Knowledgebase can be done simply and easily by following these steps:

Sign in to your Knowledgebase.1. 
Click on2. 
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Update an article

There are two ways to get to the update article screen.

One way is to:

Choose Articles menu♦ 
Click on the Articles tab♦ 
Click the Options icon under Actions to display the dropdown list, and then click
Edit.

♦ 

The other way is to

Click on the article to view it♦ 
Click on Edit Article if you wish to update the article contents and/or other
information such as categories, meta tags and private. Or if you simply wish to
update the text, click on Quick Edit.

♦ 

You can find out more about each of these fields and how they work in The Article
Screen Explained.

You can also use the bulk update option to update the categories, type, meta tags,
status and description. Using this feature, you can update more than one article at a
time.
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Delete an Article

To delete a single article:

If you are in the Public area, click on the Admin Area link♦ 
Click on the Articles tab♦ 
Click Move to Trash from the options drop down menu.♦ 

To delete one or more articles:

If you are in the Public area, click on the Admin Area link♦ 
Click on the Articles tab♦ 
Check the Actions with selected check box to the left of each article you wish to ♦ 
Choose Move to Trash from the Actions with selected box at the bottom of
the screen

♦ 

Click OK♦ 
OK again to confirm that you really do want to delete these articles.♦ 
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Add a Picture to an Article

Graphics must be uploaded to the server before you can display them on the page. You
can upload them as part of adding the image.

Add or edit the article you wish to add the picture to♦ 
Place your cursor where you want to add the picture♦ 
Click on the Insert/Edit Image icon in the Article edit box♦ 

Click on Browse Server♦ 

Go to the directory on the server where the image is now, or where you want to
place it if you haven't uploaded it yet

♦ 

If you have not yet uploaded the picture

Click on the Browse button at the bottom of the screen♦ 

Browse to find the file you want to upload♦ 
Click on the file and then click on Open♦ 

This brings you back to the upload screen. Click Upload♦ 

The name of the picture appears in the list of files♦ 
Once the picture is loaded onto the server

Click on the name of the file you want to upload♦ 

This takes you back to the Image Properties box with the address of the file in
the URL line. You will see a preview of the picture in the Preview window.

♦ 

This is the minimum you need to do to add the picture. You can optimize it by
adding alternative text, resizing it, adding borders or margins, adding links or
modifying the style.

♦ 

Click OK to add the picture to the article.♦ 
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Tip

You can "drag and drop" an image to the HTML editor, it will added to cusror
position of an  editor.

♦ 
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Assign category to article

Assigning a category to an article is a two-part process. First you assign the category,
and then you define the order the item is displayed in that category.

To assign the category

Create or edit the article♦ 
Click on the plus (+) button on the right-hand side of the category field.
This opens the Assign Category screen.

♦ 

Select the Category from the list of categories (1)♦ 
Click on the plus (+) button at the right-hand side to add this category to the list
of assigned categories (2)

♦ 

If you wish this category to be the default category, then select the category in
the Assigned list and then click on the Set Default button (3) to make this the
default category

♦ 

Click OK to save your changes and exit from the Assign Category screen♦ 
You can add multiple categories.

On the Assign Category screen you can also:

Filter the list to reduce the number of categories displayed♦ 
Add a new category by clicking the Add New Category button♦ 
Remove existing categories by clicking on them in the Assigned Categories
box, and then clicking on the minus (-) button.

♦ 

Tips:

To quickly assign a category you can:

Double-click on the category, or♦ 
Click on the categorgy, then press <Shift> and <Enter>♦ 

To quickly unassign a category you can:

Double-click on the assigned category.♦ 
To display only top categories you can:

Type top: in filter field♦ 

To order the category

When you exit from adding the category you return to the article screen. 

Click on the Advanced tab♦ 
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This will now contain a list of each category you have assigned, and an order.  By
default, articles are placed at the end of the category.

♦ 

Click on the order drop-down list beneath the category you wish to re-order♦ 

Select a new position from the list♦ 
Click OK to save and exit from editing the article, or if you wish to continue
editing the article, return to the Main tab,

♦ 
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Link to another article (related articles)

To add a link inside the text, like this:

Add or edit the article to which you wish to add the link♦ 
Highlight the text to be linked♦ 
Click on the add new Related articles icon♦ 
Find the record you wish to link to♦ 
Click on Insert (this is in the Action column).♦ 

To attach a link to the article. This link appears at the bottom of the screen, under the
sub-heading 'Also read'.

Add or edit the article to which you wish to add the link♦ 
Click on the add new Related articles icon♦ 
Find the record you wish to link to♦ 
Click on Attach (this is in the Action column).♦ 

Once you have attached a link to an article at the bottom of the screen you can also
quickly add the link into your text as well.

Open the article which has the attached link♦ 
Highlight the text to be linked♦ 
Click on Insert under Related articles.♦ 

Tip

When you add a link to another page, the page that you link to also includes a
link back to this page under the 'Also Read' heading by default. However, you
can turn this back link off by removing the tick from the cross reference
checkbox for that link.

♦ 

If you have problems inserting a link, check that you are not trying to attach an
article. If you highlight text you should be inserting, rather than attaching. If you
want to do both, attach first, and then highlight your text and use the Insert
under Related Articles.

♦ 
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Attach a file to an article (attachment and inline link)

Once you have uploaded files, you can add links to them in your articles, much the same
way as you can link to other articles. This allows you to load a file once, but refer to it as
many times as you wish.

To add a link to the file inside the text, like this:

Add the file♦ 
Add or edit the article to which you wish to add the link♦ 
Highlight the text to be linked♦ 
Click on the add new Attachment icon♦ 
Find the file you wish to link to♦ 
Click on Insert (this is in the Action column).♦ 

To add a link to the file so that the link appears at the bottom of the screen, under the
sub-heading 'Attached Files'.

Add the file♦ 
Add or edit the article to which you wish to add the link♦ 
Click on the add new Attachment icon♦ 
Find the file you wish to link to♦ 
Click on Attach (this is in the Action column).♦ 

Once you have attached a file at the bottom of the screen you can also quickly link it to
your text as well.

Open the article which has the attached file♦ 
Highlight the text the file is to be linked to♦ 
Click on Insert under Attachments.♦ 

Tip

If you have problems inserting a file, check that you have not highlighted text
and are trying to attach the file. If you highlight text you should be inserting, not
attaching. If you want to do both, attach first, and then highlight your text and
use the Insert under Attachments.

♦ 
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Article history

KBPublisher keeps a history of all changes you make to the content of an article.  You
can view earlier versions and compare them against the current version to see what has
changed and you can roll back to earlier versions

By default, version control is turned on, and set to store up to ten revisions.

To turn off version control

Click on Settings menu♦ 
Choose the Admin tab♦ 
Set the maximum number of revisions to 0♦ 

To change the maximum number of versions stored

Click on Settings menu♦ 
Choose the Admin tab♦ 
Set the maximum number of revisions to the number of versions you want
retain.

♦ 

To recognize if an article has prior versions

Click on the Articles menu♦ 
Choose the Articles tab♦ 
Find the article in the list♦ 
You will see a history icon under Actions on the articles tab. ♦ 

If you move your mouse over the history icon, it will tell you how many versions
this article has.

♦ 

To view earlier versions of an article

Click on the history icon♦ 
This takes you to the article History screen, where you can view and manage
versions.

♦ 

Tip

Only changes to content are stored.  If you modify the category or title, or update
metadata, this is not stored in the version history.

♦ 

----------------------------------------------------------------------
This functionality works in version 4.0 and above
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The article history screen explained

The History screens shows all versions of an article.  From here you can compare earlier
versions with the current one, revert to earlier versions, delete versions and you can
download a copy of a specific version.

Live Revision shows information about the current version.  Version number,
date it was last created and any revision comments.  When comparing versions,
this is the version you compare against.

1. 

Revision number is a sequentially allocated number.  Each time you save the
article, this number increments.

2. 

Date added is the date and time the version was created.3. 
And who it was created by.4. 
When you create a version you also add a revision comment.5. 
View changes opens the version and compares it side-by-side against the live
version. Changes in each document are highlighted.

6. 

Rollback allows you to revert to a previous version. This then becomes the live
version, while the formerly current version becomes another historical version.

7. 

Load revision to update opens the article for editing.  When you save the
edited article this becomes the new current version.

8. 

Download allows you to save the article (live version and an historical one) to
your hard drive and compare it in your favorite compare tool. The file is saved as
HTML.

9. 

Public view displays the current live article in the public view.10. 
Edit article opens the current live article for editing.11. 
Delete all revisions deletes all historical versions, leaving only the current
version.  Note that if you wish to delete an historical version, load the revision to
update.

12. 

----------------------------------------------------------------------
This functionality works in version 4.0 and above
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Autosave

Articles are saved automatically at intervals.  

For example, suppose you are called away from your desk in the middle of creating a
new article. You don't expect to be away long, so you don't save. An hour later you come
back to your desk to find your session has timed out.  All that work lost.

Not quite.

Provided the administrator has turned autosave on, you can get your changes up to the
last time the article was autosaved.

If you have not yet saved the article

If you were creating a new article and had not yet saved it, you can see it on the Articles
tab

Log on and go to the Admin area♦ 
Click on the Articles menu♦ 
Choose the Articles tab♦ 
If there are any unsaved autosaved documents you will see a note at the top of
the articles tab telling you that there are unsaved drafts.

♦ 

Click on the click here link to view the autosaved document(s).♦ 

Only the author can see the autosaved document♦ 

If you are editing an existing article

If you open an existing article for editing and for some reason the article was not saved
correctly, or an error occurs on the save, then when you next open the article for
editing you will see the following message:

If you want to use the auto-saved version, click on Yes, open autosaved
version.  

♦ 

If you want to revert back to the old version, click on No, ignore autosaved
version, which opens the version without your edits

♦ 

When you Save the article this new version becomes the current version and the
autosave history is deleted.

♦ 

Autosave 119

http://www.kbpublisher.com/images/image/manual/Articles/AutosavedDraftsAvailable_40.gif
http://www.kbpublisher.com/images/image/manual/Articles/AutosavedData_40.gif


Articles being edited by another user

When you open an article that is already being edited by another user you get a warning
message telling you that someone else is working on the same document and that there
are unsaved changes.

From here you can choose to:

Wait until later to edit the article.  
If you want to do this, click Cancel and come back at another time.

♦ 

Try again, to see if the user has since closed the document. 
If the document is still being edited, you will get the same message.
If you wish to contact the person who was editing the article and to ask them if
they are finished and if so will they please save the document the Opened By
information tells you who is currently editing the article.

♦ 

Or you can ignore lock and proceed with editing which overwrites anything
the other user has done.  
Be aware when you do this that other author can also save over your work. The
person who saves last is the one whose article becomes the final article. 

♦ 
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Schedule an Item

Scheduling an article, news or file allows you to set a date that the item is made visible
to users in your knowledgebase and/or a date that it stops being visible.

For example, suppose your company is closed for the Christmas/new year holiday
periodaâ�¬"say it is closed from 12 noon on 24 December and re-opens at 9 am on the
2nd of January.

You add a news item to say that you will be closed over this period. When you
create it (on 18 December, say), you set its status to "Not Published"

♦ 

You schedule this news item to change status to "Published" at 12 noon on 24
December, and to change status again to "Not Published" at 9am on 2 January.

♦ 

Or suppose you have a new software release being implemented. You can create new
articles for the new functionality in the software before the release. Give these articles a
status of 'Not published', and then schedule them to be published on the assigned
release date.

To schedule the item:

Create or edit the article, file or news♦ 
If you are scheduling an article, click on the Advanced tab (you don't need to do
this for files or news items)

♦ 

Check Yes to the Schedule option♦ 
This expands the Schedule options♦ 

Add a date and time to the On the Date fields to set the date and time that the
item is to change status

♦ 

Use the Change Status To for  dertermining whether the item is to be
published or not published. (Articles have two further statuses, pending and
draft.)

♦ 

Add a Note to explain why this item was scheduled on this date.  Use it as a
reminder or as a record of what happened.

♦ 

If you wish, you can set a second date and time to change to another status:

Check the And checkbox♦ 
This brings up a second set of date and status options♦ 

Add a date and time to the second On the Date fields to set the date and time
that the item is to change status

♦ 

Use the second Change Status To for  assigning the new status♦ 
Add a second note if required.♦ 
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Items that are scheduled have a small clock next to the article/file/news ID on the list
screens.

Tip:

You can also use bulk actions to schedule or remove schedules.♦ 

----------------------------------------------------------------------
This functionality works in version 3.5 and above
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Remove scheduling

To remove scheduling from an article, file or news:

Edit the item♦ 
Uncheck the Schedule checkbox♦ 

You can also use the bulk actions option to remove scheduling from multiple articles or
files:

Select each item to be un-scheduled♦ 
Choose remove schedule from the Actions with selected options at the
bottom of the screen.

♦ 

----------------------------------------------------------------------
This functionality works in version 3.5 and above
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Add an article as a result of user feedback

Sometimes, feedback from a user generates an idea for another article.
You can create this article direct from the feedback page.

Click on the Feedback menu♦ 
Click on the place question in KB icon (the curved blue arrow) under actions♦ 
This brings up a new article screen for you to start creating the new article.
The text in the email is listed in the article title

♦ 

Create the article as you normally would and save it.♦ 
When you return to the Feedback screen, the Placed in KB box is checked.♦ 
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Bulk Update Articles

KBPublisher allows you to bulk update articles to:

Set categories♦ 
Make the articles public or private♦ 
Schedule article publication♦ 
Set article type♦ 
Add meta keywords/tags and descriptions♦ 
Set external links♦ 
Sort articles (available only when filter for category applied)♦ 
Reset rating♦ 
Set custom fields♦ 
Set article status♦ 
Delete articles.♦ 

You can do this direct from the Articles menu, Articles tab.

To update the article:

Check one or more articles to update♦ 
Choose the appropriate action from the drop down list of actions with selected♦ 
This brings up further options to select from according to the action chosen.
Choose the appropriate selection

♦ 

Click OK.♦ 
Note:

Bulk actions available depend on your user access.
For example if your privilege does not allow you to delete items, or allows you to
only delete articles that you have created, then there is no 'Delete' action in the
list of options. If your privilege does not allow you to update items, or allows you
to only update items you have created, then this menu will not be available for
you at all.

♦ 
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Import articles

You can import articles in bulk.
You might want to do this, say, if you are changing over to KBPublisher from another
system.

The process is:

Create a file of articles to import♦ 
Upload a test sample to the system♦ 
Import.♦ 

Create a file of articles to import

First, you need to create your file of articles. This is a comma-separated (CSV) text file
that consists of some or all of: title, body, date_posted, id, author_id, updater_id,
meta_keywords, meta_description, entry_type, external_link, date_updated, hits, sort_order, private
and an active flag.

The first three fields (title, body and date_posted) must be included. You can
include some, all or none of the others as required.

♦ 

They do not have to be in the same order as above, but each line in the import
file must contain the same fields in the same order.

♦ 

The active flag defaults to '1', which is active, so they only time you would set
this is if you don't want the users to be active.

♦ 

Place the data for each user onto a single line, and separate each field by a
comma. Do not include spaces before or after the comma.

♦ 

Place quotes (") around text fields such as body, and be sure to check that your
text does not have quotes within the text. If your body, or other text field, does
contain quotes, choose a different delimiter and update the fields optionally
enclosed by field to match.

♦ 

The TestImportArticle.csv file shows a sample of what your upload file should
look like. This file includes the three default fields only.

♦ 

Field sizes and types are specific, as per the table below. Your data must fit
within these parameters or the upload will fail.

♦ 

Field Type/size M/O Comments

title text M Enclose text in quotes (")

body mediumtext M Enclose text in quotes (")

date_posted datetime O Format 0000-00-00 00:00:00

id int(10) O

Record ID. If this record ID
already exists in the database
KBPublisher will skip the
record. It will not overwrite an
existing ID.

author_id int(10) O
If not supplied, the user
currently logged in and
importing the articles is set as
the author.

updater_id int(10) O If not supplied, the user
currently logged in and
importing the articles is set as
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the updater.

meta_keywords text O
Enclose text in quotes (").
Format should be the same as
if you are adding the keywords
in add new article.

meta_description text O Enclose text in quotes (").

entry_type tinyint(3) O Type.

external_link text O Enclose text in quotes (").

date_updated timestamp O Defaults to time imported to
knowledgebase.

hits int(10) O Defaults to 0.

active tinyint(1) O Defaults to 1.

Create a test file

Don't try to upload the whole file without testing it first. If something goes wrong you
may then have to delete all those half-imported articles and try again. Create a test file
and run that first.

Copy the first, say, three lines of your text import to a separate file♦ 
Either:

Save the file to a local drive (e.g. somewhere on your c: drive)◊ 
Upload the file to the server◊ 

♦ 

Import the test file

You are now ready to import the test file to KBPublisher.

Click on the Import/Export menu♦ 
Click on the Import Articles tab♦ 
If the import file is on your c: drive (or another local drive),

Choose Load Data Local File in the SQL Load Command field◊ 
Browse for the CSV file on your drive and load it◊ 

♦ 

If the import file is on the server,
Choose Load data file◊ 
Type the address where the file is located into the Path to file field on
CSV file line

◊ 

♦ 

Move the CSV fields around to specify which fields are in the file and what
order they are in.
Do this by clicking on the name of the field you want to move and dragging and
dropping it into the appropriate place.
For example, suppose you want the three mandatory fields included, plus the
author ID. You need to move the user_ID field from the Available table fields
box into the Fields in CSV file box.

Click on the user_ID field and hold the mouse down◊ 
While holding the mouse down, drag the date_registered field over to the
Fields in csv file box

◊ 

Drop the field into the box by releasing the mouse◊ 

♦ 
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Make sure that you place it in the order it appears in the file.
Change CSV options if required.♦ 
Click Load♦ 

On completion of the load, you will see a message at the top of the Import Articles
screen telling you how many files were imported successfully and how many were
skipped.

If the upload was successful, click on the Articles tab to check out the articles.♦ 
Fix any problems

All going well, you should now have three new articles in your knowledgebase. Check
them carefully and ensure that everything worked as you expected. If you had problems,
delete these three articles, fix the test file and run it again. Keep fine-tuning until it
works, and then update the real file to match the fixes you made in the test file.
You are now ready to import the rest of the articles.

Import articles

Import the rest of the articles using the same process as for the test file, only this time
using the real data file.

Note:

Articles are imported with a category name of Imported. If this category does not
exist it will be created as part of the upload process.

♦ 

If any unique keys will be duplicated during import, records from cvs file will be
ignored.

♦ 

Use the bulk actions option to change the categories, etc.♦ 
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Private Articles

What the Private function does

The private option:

Lets you force users to log on to read items♦ 
Allows you to restrict who can read items♦ 
Allows you to restrict who can edit or upload items.♦ 

It works for articles, files and news items, and can be applied at individual item level
and at category level.

Using the Private function  

Force users to log on

If you mark an item as private read and do not assign roles:

Users must log on to read the item♦ 
Any user who is logged on can read it♦ 
In the Public area users will not see the item until they are logged on♦ 
In the Admin area all users will see the item.♦ 

If you mark an item as both private read and private write and do not assign any
roles:

Users must log on to read the item♦ 
Users who are not logged on cannot see the item.♦ 

Restrict read access

If you mark an item as private read and do assign roles:

Users must log on to read item♦ 
Only users who belong to the nominated role can read the item♦ 
In the Public area, users who do not belong to the nominated role cannot see the
item

♦ 

All users in the Admin area can see the item.♦ 
Restrict write access

If you mark an item as private write and do assign roles:

All users can read the item♦ 
Only users who belong to the nominated role can create, edit or update the item♦ 
For articles, users will not see Edit Article and Quick Edit options in the Public
view if they do not belong to the correct role

♦ 

Note that if you mark an item as private write and do not assign roles:

All users can see and read the item♦ 
All users logged in to the Admin area with appropriate privileges can edit the
item.

♦ 

Restrict both read and write access

If you mark an item as both private read and private write and do assign roles:
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Users must log on to read the item♦ 
Only users who belong to the nominated role can see or read the item♦ 
Only users who belong to the nominated role can create, edit or post the item♦ 
In the Public area, users who do not belong to the nominated role cannot see the
item

♦ 

In the Admin area, users who do not belong to the nominated role cannot see the
item

♦ 

Note that private items work in conjunction with privileges. A user who does not have,
say, author privileges, will still not be able to create articles even if they are assigned to
a role that allows them access via private write.

Set up private read and write

To restrict whole categories:

Edit the category♦ 
Choose Private Read if you wish to restrict who can read the articles in this
category or force users to log on to read the articles. Choose Private Write if
you wish to restrict who can create or edit articles in the category. Choose both
if you wish to restrict both reading and writing of articles

♦ 

This brings up another option, Access for selected roles only
By default, this is set to None, which means that users must log on to read
articles in this category, but anyone can read them once they have logged on

♦ 

Select which roles users must belong to in order to read or write the article♦ 
Click OK.♦ 

To restrict access to a single article:

Edit the article♦ 
Click on the Advanced tab♦ 
Choose Private Read if you wish to restrict who can read the article or wish to
force users to log on to read it. Choose Private Write if you wish to allow
everyone to read the article but only writers in a specified role to edit it. Choose
both if you wish to restrict both reading and writing.

♦ 

This brings up another option, Access for selected roles only
By default, this is set to None, which means that the article is private, but all
users can read it once they have logged on

♦ 

Select which roles users must belong to in order to read/write the article♦ 
Click OK.♦ 
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Search

Search for an article

The quick search box will search for the ID, title, content (articles and news
items only) and meta information such as keywords and descriptions. It searches
articles, files and news items.

♦ 

Search functionality is provided by MySQL full-text searching. This is a
natural language search that allows you to type in a question or regular
sentence that describes the information you are looking for, and then uses
programmed logic to determine the keywords in the sentence.

The Advanced search gives you extra options. It allows you to refine the search
by limiting the search to articles, files or news items, and by specifying specific
categories, article types and keywords. It also allows you to search on when an
article, file or news item was created. It also allows you to search attached files
or custom fields.

♦ 

In the Admin area the article and file filter options on the Knowledgebase also
provide a type of search

♦ 

Search tips

Use at least four characters. Search may not return correct results if you type in
less. (Note. The minimum and maximum word length to be searched can be
changed by the MySQL administrator)

♦ 

Use the asterisk (*) as a wildcard character to search for partial words. e.g.
'Excel*' will find articles containing 'Excellent' and 'Excel'. If you don't use the
'*', then knowledgebase searches on full words only. e.g. a search on 'Excel'
would only find articles containing the word 'excel', it would not find articles
containing 'excellent'

♦ 

Use the underscore (_) to replace a single letter in the search. e.g. 'Optimi_e' will
find both 'Optimize' and 'Optimise'. (This option is valid only for File searches
and for Title filter searches on the Article screen in the Admin area.)

♦ 

If you include two or more search words, the search will look for articles that
contain either word. e.g. 'Excellent Fred' will find articles that contain the word
'Excellent' and articles that contain the word 'Fred'

♦ 

To specify that the article must contain all words searched, use a plus sign (+) in
front of each word, or in front of the most important word. e.g. '+Excellent
+Fred' looks for articles that contain both words, while '+Excellent Fred' looks
for articles that contain the word 'Excellent' but rank them slightly higher if they
also contain the word 'Fred'. (Ranking controls where the result appears in the
list. A ranking of 100% will be at the top of the list, and is the most likely match
for what you are looking for.)

♦ 

To specify that the search should ignore articles containing certain words, use
the minus sign (-) before the word to be ignored. e.g. 'Excellent -Fred' looks for
articles with the word 'Excellent' in them, and then excludes any that also
contain the word 'Fred'

♦ 

To find articles that contain the words exactly as you type them, put quotes (")
around the words. e.g. "Bill and Fred's Excellent Adventure" will only find the

♦ 
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article if it contains that exact wording.
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Subscribe to an article

Subscribing to an article means that you receive email notification of any changes to
that article.

To subscribe to a single article

Open the article to read it♦ 
Click on Subscribe in the quick access panel on the right-hand side of the
screen

♦ 

The Subscribe option changes to Unsubscribe, and from now until you unsubscribe you
will receive notification whenever this article is edited.

To subscribe to all articles in a category

Click on My Account, which is in the top right-hand corner of the
knowledgebase screen

♦ 

Click on the Subscriptions tab♦ 
Click on Subscribe / Unsubscribe for Article Categories♦ 
Click on Add New♦ 
Select a category you wish to subscribe to and then click on the plus (+) button
to the right of the category list. This adds the category to the Selected
Categories list. Note, there is also an option to select all categories, if you wish

♦ 

Click OK to save your subscription.♦ 
You can see which articles you have subscribed to in the Subscriptions tab under My
Account.

----------------------------------------------------------------------
This functionality works in version 3.5 and above
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Unsubscribe from an article

To unsubscribe direct from the article

Click on the article to read it ♦ 
Click on Unsubscribe in the quick access panel on the right-hand side of the
screen

♦ 

To unsubscribe via the subscriptions list

You can unsubscribe from single files this way, and whole categories

Click on My account♦ 
Click on the Subscriptions tab♦ 
Click on Subscribe / Unsubscribe next to Articles if it's for a single file, or
from Article Categories if it's for the whole category

♦ 

Click unsubscribe for the article or category you wish to unsubscribe from♦ 
Click OK to the message that asks if you're sure♦ 

----------------------------------------------------------------------
This functionality works in version 3.5 and above
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Add new status

Articles, files, users, rating comments and feedback comments all have default
statuses.  For example, there are four default article statuses: published, pending, draft
and not published.

You don't have to stay with these statuses, you can create your own:

From the Tools menu choose the Lists tab♦ 
Click on Articles (or Files, or Users, or Rating Comments or Feedback)♦ 
Choose Add New♦ 

You must include:

A title. This is the status name. e.g. In review.♦ 
You can also add:

A description, an explanation of what this status is used for.♦ 
A color that is displayed with the status on article summary and list screens.♦ 
Whether or not this status is published. If you check this box, then users will be
able to read articles of this status. If you do not check this box, then only
authors, editors, moderators and administrators can read the article.

♦ 

The order of this item in the status list. This defaults to 1, which places the new
status at the top of the list.

♦ 

Whether or not the status is active. If the status is not active, then you will not
able to assign this status to article.

♦ 

Lastly

Click Save.♦ 
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Add new article type

You can create your own article types:

From the Tools menu choose the Lists tab♦ 
Click on Article Type♦ 
Choose Add New♦ 

You must include:

A title. This is the article type name. e.g. FAQ.♦ 
You can also add:

A description, an explanation of what this article type is used for.♦ 
An article template. This is default text and/or formatting that is created for all
articles of this type. For example, you might create an article type of system
errors. For each article of this type you require three sections: error number,
error message and anexplanation, so you create a System Error type template
with these three headings. When an author creates a new article based on
System Error, these three headings are automatically included in the article, so
all they have to do is fill in the details.

♦ 

The order this item is in the article type list. This defaults to 1, which places the
new type at the top of the list.

♦ 

Whether or not the type is active. If the type is not active, then you will not be
able to choose this as a type.

♦ 

Lastly

Click Save.♦ 

Add new article type 136



Featured Articles

The Featured tab lets you select articles you want to highlight. You can include articles
in the Featured section of your index page, or in the featured section of a category, or
both.

To access the Featured tab click Articles from the main menu bar and select
Featured from the tabs displayed:

The list provides the ID and title of each featured article and the number of views the
article has had. A star appears in the Index Page or Category Page columns, or both,
to indicate where the article is featured. In the Category Page column a number
appears beside the star to indicate how many categories feature the article.

Use the filter at the top of the form, marked in red in the image above, to show only
articles that are featured on the Index page, the Company Specific page, or for a
particular category. Click the > button to filter the display. Clear the fields and click >
again to show all articles.

At the right of each entry is a gear button. Click it to open the Actions menu. From this
menu:

Select Details to see more about the current article. The display changes to the
Details sub-tab of the Articles tab.

♦ 

Select Edit to set how the article is featured.♦ 
Select Remove to remove the current article from the Featured list. ♦ 

Add an article to the Featured list

To add an article to the Featured list, click the Add new button. The popup window
appears and shows all the articles available to add to the list.
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Use the filter fields above the list and then click the > button to show only articles that
match the conditions you set. Clear all fields and click > again to show all articles.

To add an article to the list, select one that does not already have a star in its Index or
Category column. Click the icon to add the article to the list.

Click the icon in the Action column to open the edit form for the article. The form is
described below.

Edit a featured article

To adjust how an article is featured, click the Action icon for the article and select Edit.
The Edit form appears:

Clear the check box to remove the article from the Index Page display.

You can feature an article on one or more category pages. To add the article to a
category page, click the + button to the right of the Category Page field. Select the
category you want from the list that appears. To remove the article from a category
page, select the category in the Category Page field and click the - button to the right of
the field. A confirmation message appears to make sure you want to remove the
category.

Click Save to save your edits. Click Cancel to abandon your edits and close the form.

Remove a featured article

There are three ways to remove articles from the Featured list:

Click the Action icon for the article you want to remove from the list and
select Remove.

1. 

Check the check box at the left of the row for each article you want to remove.
Click the Actions with selected menu at the bottom of the display, and
select Remove. Click OK to confirm that you want to remove the selected

2. 

Featured Articles 138



articles.
   This option is useful when you need to remove several articles from the
Featured list. Check the check box that appears at the top left of the list of
articles to select all articles. De-select it to clear all check boxes at once. 
Click the Add new button to open the list of articles as described above. Articles
that are featured have a star in either or both of their Index Page and Category
Page columns. Click a star to remove that article from being featured in that
page or pages; you can remove the article from one feature and retain it for the
other.

3. 

Configure display options

To learn more about configuring the display of featured articles, see The Public Area tab
explained.
See settings "Featured articles" and "Featured articles in a category".
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Adding Code Snippets

You may want to add code examples, or snippets, to your knowledgebase article to show
your users how to achieve a particular effect or address a common problem.
KBPublisher makes this easy by providing formatting tags to put around the example.
When your readers look at the article, the example code appears, correctly formatted
for the coding language you specify and highlighted as it would appear in a code editor
for that language, in a box to set it off from the rest of the text.

Here's a code snippet showing how to set a cookie in php:

<?php
$value = 'something from somewhere';
setcookie("TestCookie", $value);
setcookie("TestCookie", $value, time()+3600);  /* expire in 1 hour */
setcookie("TestCookie", $value, time()+3600, "/~rasmus/", "example.com", 1);
?>

If you place the code snippet in the formatting tags, it appears in the published article
with the correct formatting and highlighting for the coding language you specify:

<?php 
$value = 'something from somewhere';
setcookie("TestCookie", $value);
setcookie("TestCookie", $value, time()+3600);  /* expire in 1 hour */
setcookie("TestCookie", $value, time()+3600, "/~rasmus/", "example.com",
1);
?>

Adding a code snippet to an article

To add code snippets to an article:

Open the article for editing.1. 
Where you want the code snippet to appear, add the opening and closing tags:2. 

Replace the XXX with the indicator from the list below for the snippet's coding
language.

3. 

Paste the code example between the opening and closing tags.4. 
Preview the article to confirm it appears as you want. Note: code highlighting
appears in the published article, but not in the article preview.

5. 

Available Languages

Find your snippet's coding language on the left side of any pair. Choose one of the
entries that appear on the right side. For AS3, for example, you could use "code=as3" or
"code=actionscript3".

AS3 - as3 AS3 - actionscript3

Bash - bash Bash - shell
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ColdFusion - cf ColdFusion - coldfusion

CSharp - c-sharp CSharp - csharp

Cpp - cpp Cpp - c

Css - css Delphi - delphi

Delphi - pas Delphi - pascal

Diff - diff Diff - patch

Erlang - erl Erlang - erlang

Groovy - groovy JScript - js

JScript - jscript JScript - javascript

Java - java JavaFX - jfx

JavaFX - javafx Perl - perl

Perl - pl Php - php

Plain - plain Plain - text

PowerShell - ps PowerShell - powershell

Python - py Python - python

Ruby - rails Ruby - ror

Ruby - ruby Scala - scala

Sql - sql Vb - vb

Vb - vbnet Xml - xml

Xml - xhtml Xml - xslt

Xml - html
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Drafts

Drafts

The Drafts module lets users create new articles, or modify existing published articles,
without interfering with live publications. Users can create and modify drafts in a
separate area until each draft is finished and ready to go live.

The Drafts module lets you require specific contributors to create drafts that must be
approved before publication, rather than publishing their material directly.

To learn about creating and managing your drafts, see Manage drafts.

Essential facts about drafts

Users with admin privileges can create, approve, reject, or delete any draft at
any stage in the approval process. 

♦ 

If a draft has been sent for approval, the author cannot update it until the review
is complete. 

♦ 

Your knowledgebase records approval decisions in a log for future reference.♦ 

Drafts and Workflows

When a draft is ready to publish, an approval workflow can route the document or item
to the assignees, one or more people assigned to review such material before
publication.

Assignees can approve the article for publication or send it back to the author for more
work. They can also provide feedback on an article. The feedback is compiled and sent
to the person who initiated the workflow.

Possible scenarios when a user adds a draft

There is a matching workflow
The author of a draft can save the draft repeatedly while working on it until the
material is ready to submit. When the user submits the draft for approval, the
workflow assigns it to appropriate assignees. The user has no further access to
the draft until it is approved for publication or returned for further edits.

1. 

There is no matching workflow and the user's privileges do not permit
adding articles
The author of a draft can save the draft repeatedly while working on it. However,
the user cannot publish the draft, and there is no way to send the draft for
approval. 

2. 

There is no matching workflow, and the user's privileges permit adding
articles
The author of a draft can save the draft repeatedly while working on it. When the
draft is ready to publish, the user can publish it. 
Once the draft is published it no longer appears on the list of drafts, and does
appear on the list of articles.

3. 
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Manage Drafts

To manage existing drafts or create a new one, select Articles or Files from the main
menu and select the Drafts tab:

The tab lists all existing drafts. If the list is long, use the filter fields above the list to
show just the drafts of a particular status, or the drafts with a certain word in their
titles.

The Status column shows a color for each draft to indicate its status:

gray = in progress♦ 
yellow = waiting for approval♦ 
red = rejected♦ 

Click the gear icon in the Action column for a draft to perform one of these actions:

For drafts of articles:

Approve - Appears if draft requires approval and you are an assignee (are
allowed to approve or reject the draft).

♦ 

Preview - Display a preview of the draft to review.♦ 
Details - Display details about the darft.♦ 
Edit - Open the draft for editing.♦ 
Delete - Delete the draft.♦ 

For drafts of files some extra options available:

Open - Open the file in a browser if possible.♦ 
Download - Download the file to a location on your computer.♦ 

Adding a draft

To add a draft of an article or file, click Add new on the relevant tab and complete the
form that appears.

For a description of the form for adding a draft of an article, see Add an article.♦ 
For a description of the form for adding a draft of a file, see Add a file.♦ 

Note: When you add a draft there is no Status field. The status is set when the item is
published. You can define article status by selecting Tools from the main menu, and
then Lists >> Article statuses.
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Approve a draft

If you are an assignee for a draft in its current workflow step you can

approve the draft as-is and either publish it or move it to the next workflow step.♦ 
edit the draft and save your changes before approving it, as in the previous
option.

♦ 

reject the draft so it returns to the author for further edits. ♦ 

Manage Drafts 144

http://#entry_423
http://#entry_423


Approve or Reject a Draft

A workflow may assign the draft of an article or file to you for review. You can:

approve the draft. The draft then moves to its next assignment in the workflow,
or (if it requires no further approvals) is published.

♦ 

update the draft and then approve it. The draft then moves to its next
assignment in the workflow, or is published.

♦ 

reject the draft so it is returned to the author for further work.♦ 
To see the drafts assigned to you, select Articles or Files from the main menu and then
select the Drafts tab:

The colors in the article's Status column indicate the article's status. The options are:

Yellow = waiting for approval.♦ 
Red = rejected and returned to the author for further work.♦ 
Gray = in progress; the article is not ready for review.♦ 

Review a draft

To review a draft, select a draft with a "waiting for approval" status indicator, click the
gear icon in the draft's Action column and select Review. The review screen appears:
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Click Preview to display the article or file in a pop-up window so you can evaluate the
material.

In the example above, when the current reviewer approves the draft, it will be
published. If a further step is required in the workflow before publication, the Publish
button would be labeled Approve.

If the material is satisfactory, click Publish, if it is available, to approve the draft
for publication. If the button label is Approve, click it to send the draft to its
next approval step in the workflow.

♦ 

Click Reject if the material is not ready for publication. A form appears where
you can provide notes about additional work the draft requires. After you have
added your comments, click Reject to send the notes and the draft to the author.

♦ 

Click Cancel to close the form without making a decision.♦ 
Note: A user with admin privileges can approve or reject a draft at any stage in the
workflow process, whether or not the draft is assigned to the admin.

Add or remove an assignee

The Assignee section of the Review screen lists those who are assigned to review the
draft.

Remove an assignee from the list by clicking the X to the right of the assignee's
name.

♦ 

To add an assignee, click Click Add new. A popup window appears with a list of
available staff. Click the down-arrow in the Action column for each person you
want to assign the draft to. The down arrow changes to a check mark. Close the
popup window when you have finished adding assignees.

♦ 

You can remove all assignees from the list.

Review the log
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The bottom part of the Review screen shows the workflow log. The author, reviewers,
and admins can add comments when they are submitting, approving, or rejecting drafts,
and the comments are available in this log.

Approve or Reject a Draft 147



Categories

What are categories?

Categories control where information is displayed, how it is displayed and who can see
it.

They control the menu display (sometimes known as the table of contents) on the left
hand side of the screen.

Categories for articles and files are controlled separately.
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Category types

Category type controls how articles in this category are displayed in the public view.
There are four category types:

The Standard (default) type displays a list of articles, along with one or two
lines of text.
If the category has sub-categories, these are displayed above the list.

♦ 

The book type displays items as a table of contents.♦ 

The Quick FAQ type displays all articles in the category on the same page.♦ 
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While the Quick FAQ (interactive) type displays all articles in the category on
the same page as well, but with only the titles displayed initially. Click on the
title to display the article, click on it again to hide it. 

♦ 
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Add a Category

The quickest way to add a category is to use the Shortcuts menu at the top of your
screen.

Click on the drop-down menu in the top right of the screen and choose Add new
category.

♦ 

Or you can do it via the Categories tab in the Admin Area

Click on the Articles menu♦ 
Choose the Categories tab♦ 
Click on Add New.♦ 

You can also add a category while you are in the middle of adding an article or a file

Edit the article or file♦ 
Click on the assign categories button (+)♦ 
Click on Add New Category.♦ 

Once you are on the category screen you must complete the following sections:

Add a Title. This is the name that will be displayed on the left menu or in any
table of contents.

♦ 

Define where it fits in the category hierarchy by choosing a Parent category
and an Order. If you don't change these you will add a new top-level category
and it will be placed last.

♦ 

You may also:

Change how articles are displayed by specifying a category type♦ 
Control read and write access through Private and Active♦ 
Allow users to comment on or rate articles in the category♦ 
Assign a person to approve articles (Supervisor) for the category♦ 

You can find out more about each of these fields and how they work in the Category
screen explained.
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The Category Input Screen Explained

To get to the Category screen, click on the Articles menu, then choose the Categories
tab and then select or edit a category.

The category Title is the title that is displayed on the left menu in the public
view. Title is compulsory.

1. 

The Description is an explanation of what this category is.2. 

The Parent category denotes where this category will come in the menu. A TOP
LEVEL category means that this is a top level menu and will be displayed in the
list when a user first enters the public view.
Categories that are red denote restricted privileges. They may be marked as
'private', or only users with assigned roles can access them.

3. 

Category type controls how articles in this category are displayed in the public
view.
See detailed explanation here.

4. 

The Order defines where the category is placed in the list of categories. By
default, it is added to the end of the list.

5. 

You can assign an owner to a category by assigning it a supervisor. This is the
person who receives emails when pending articles have been created and need
to be approved.

Click on the folder icon to bring up a list of users.◊ 

Assign a user.◊ 

6. 

You can force users to log on to read articles in this category by marking the
category Private Read/Write.
You can restrict authoring of articles in a category by marking the category
Private Write.

Checking either option for Private brings up a list of roles.  Select the role(s) that
you wish to allow to read/write.  Hold the key to select second and further roles.

7. 
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If the category is a sub-category, you can inherit the read privacy from the
parent category by clicking on copy from parent category. This means that if
you change the privacy for the parent category the change will flow on to this
sub-category.

When Allow comments is checked, users can add comments to articles in this
category.

8. 

When Allow rate is checked, users can add a rating to an article in this
category.

9. 

Content in an Active category is published at Public Area. Content that is not
active will be hidden, and the only way you can see it through the Admin screens.

You can use this field to deactivate obsolete content, but you can also use this
field to hide articles until you are ready to display them. It might be useful, for
example, if your knowledgebase is about a system. You decide to add new
functionality to the system but don't want the readers to anything about it until
the release date. You can create articles about the new functionality in an
inactive category, and then after the release, make the category active.

10. 
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Article Templates

What are article templates?

Templates have two functions in KBPublisher--to standardize article design and to add
boilerplate text.

To standardize design

Suppose you want each page in your knowledgebase to have three headings:
'Introduction', 'Steps' and 'Conclusion'. The 'Steps' section should be a simple bulleted
list. You want all your authors to keep to the same format so you set up a template and
ask them to create articles using that template

Or maybe you run a Help Desk. Rather than simply have users type their problem into a
free-format article field, you can set up a form template and ask them to fill it in.

KBPublisher ships with four standard Article templates:

The default template, which is a white background with standard formatting♦ 
Page Content -- This is similar to the default template, but it includes headings
and a numbered list

♦ 

Info Box -- a box with a yellow background, good for displaying information♦ 
Info Box 2 -- similar to Info Box, but the box has a grey background.♦ 

The default template is the base template. You do not need to specify it.

If you do specify a template, you can:

Choose to replace existing content, whereby everything you have written in the
article to date is overwritten, or

♦ 

Simply add the new template where your cursor is currently placed, or♦ 
Include the template in the article. If you choose this option, a special tag (e.g.
[tmpl:include|<template_key>] ) is placed in the text to denote where the
template is to be placed, and the content of the template is included at the
rendering stage. This means that when you edit the article you do not see the
contents that are being included; you just see the special tag.

♦ 

Boilerplate text

If you find yourself continually typing the same content over and over again, you can
use templates to simplify the work.

Maybe you need to add a disclaimer at the bottom of each page. The disclaimer is
exactly the same on every page, and you don't want the bother of typing it in every time.
A template saves time typing the disclaimer initially, but your legal people keep
changing it. You don't want the hassle of changing every page. Not to worry. You can
include a template. If the disclaimer changes, then all you have to do is change the
template and the next time someone views the page they will see the correct disclaimer
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Using templates in articles

The different ways you can add templates

A template is a piece of content (text and pictures and other media) that you can place
into other articles. Common examples of where you might use a template are a
disclaimer paragraph that you add to the bottom of each article, or a series of steps that
are common to many of your instructions.

You can add, replace or include templates in articles.

Insert pastes the content of the template into the article.  Once the content is
added you edit it like any other article content.

♦ 

Replace works the same way except that instead of just placing the template
content into the article at your cursor position, it replaces everything in the
article.

♦ 

Include is different in that it just puts a marker in the article, it doesn't put the
contents in. The template content is pulled in when the reader opens the article
to view it. When you edit the article you don't see the content from the template,
all you see is a code like or [tmpl:includeisclaimer] and you can't edit the
contents of the template in the article, you have to go back to the template to do
it. 
The great thing about include is that if you can update the template as many
times as you like and the changes always flow through to the article. This is not
like add and replace, which place the contents of the template into the article, so
once it's there it doesn't change if you update the template.

♦ 

To add a template to an article

Your template must exist before you can use it in an article.

To add a template to an article:

Add or update the article.♦ 
If you are going to add or link to a template, place the cursor where you want to
include the template.

♦ 

Choose the template from the Template drop-down menu.♦ 

Click on the appropriate insert template icon
If you wish to add the contents of the template to the article, click on the
icon with the blue arrow. This pastes the text of the template where the
cursor is currently positioned. It does not affect any of the text above or
below it.

◊ 

If you wish to replace the contents of the article, click on the icon with
the red arrow. This deletes any text currently in the article and replaces
it with the text in the template.

◊ 

♦ 
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If you wish to include the contents of the template, click on the icon with
the green arrow. This puts a placeholder into the article and when a user
opens the article to read it, the knowledgebase pulls in the text from the
placeholder template.

◊ 

If you have defined a key for your template, you can also include the
template by typing in the special template include command and the
template key into the editor window. i.e. By typing
[tmpl:include|<template_key>] where <template_key> is the template
key

◊ 

Or you can use the article ID in the template include command, i.e.
[tmpl:include|<ID>] where <ID> is the article ID.

◊ 

Alternatively, you can use the Template icon in the editing toolbar, but this only allows
you to add or replace the template; it does not allow you to link the contents.

If you choose this option:

Add or update the article♦ 
Place your cursor where you want to insert the template♦ 
Click on the templates icon (check out the edit toolbar explained to see where
the templates icon is on the toolbar)

♦ 

This opens a pop-up box. If you intend to replace the current contents, check
Replace actual contents

♦ 

Click on the name of the template♦ 
This returns you to the editor with the template inserted.♦ 

Tip:

You can also use the article type as a form of template.♦ 
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Add an Article Template

To add a new article template

Click on the Articles menu♦ 
Choose the Article Template tab♦ 
Click on Add New.♦ 

Once you are on the article screen you must complete the following sections:

Add a Title. This is the name of the template.♦ 
Set up your template in the Template editing box.♦ 

The following items are optional:

You can include a template key to use to easily identify the template when
including it in articles

♦ 

You can add a description to explain what the template is used for♦ 
You can speficy whether the template can be used by marking it active. If you
don't mark the template as active, then authors cannot use it in their articles.

♦ 

Once your article is complete

Click Save.♦ 
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Article types as templates

Another form of template is the article type.

Each article can be assigned a 'type'. Your knowledgebase might contain, for example,
the following types:

Procedures which contain a short summary, plus some steps♦ 
Screen images, with an explanation of each field on the screen♦ 
Common error messages showing the error number, the message, and an
explanation of what it means.

♦ 

You can use article types to set up a base template for each type of article. For example,
the Procedures type may contain one heading called Summary, and another called Steps
with a numbered list below it, while the Error Messages type contains three headings:
Error No, Error Message and Explanation. Set up your article types templates with
these headings.

When you create a new article, choose the appropriate type from the Type drop-down
list, and the headings are automatically included in the article. All you need to do then
is fill in the blanks.
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Glossary

Glossary explained

The glossary allows you to create a list of definitions in your knowledgebase.

Glossary items are highlighted in red in the article. If you hover your mouse over the
glossary item you see a question mark. If you click on the word, the definition is
displayed in a yellow box.

To hide the definition again, move your cursor away from the word.
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Add a glossary item

The glossary gives your readers quick definitions or explanations of words or phrases
important to your application, but which the reader might not know.

There are two ways to add a glossary item:

Click the Add icon  at the top right of the Admin screen and select Glossary
item.

1. 

On the Articles tab select the Glossary sub-tab, then click the Add new button.2. 
Either method displays the Add new form. Provide the required information for the new
item:

Word/phrase - This is the word or phrase that may puzzle your reader. This text
will be highlighted in red in articles. 

♦ 

Definition - Explain the word or phrase. In an article, the definition appears in a
yellow box when the reader clicks a word highlighted in red.

♦ 

There are two optional settings:

Highlight once - Select to have the word or phrase highlighted only the first
time it appears in an article. Repeated highlighting may make the article more
difficult to read.

♦ 

Published - This is selected by default. De-select to have this item not display in
the glossary.

♦ 

Click Save to save the new item. Click Cancel to abandon your edits and close the
form. Click Preview to see how the item will appear.
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Import glossary

If you already have a list of terms and definitions that you would like to use in your
knowledgebase, you can upload these terms in bulk.

The process is:

Create a file of glossary items to import♦ 
Upload a test sample to the system♦ 
Import.♦ 

Create a file of glossary items to import

First, you need to create your file of articles. This is a comma-separated (CSV) text file
that consists of a phrase, followed by a definition.

Both fields must be included, and they must be in the order of glossary item
name (phrase) first, and then the text that explains it

♦ 

Place the data for each glossary item onto a single line, and separate each field
by a comma. Include a space after the comma. If you choose to use something
else other than a comma, update the field terminated by field under CSV
options to match.

♦ 

Field Type/size M/O Comments

phrase varchar(100) M The maximum size of a phrase is 100
characters

definition text M

id int(10) O
Record ID. If this record ID already
exists in the database KBPublisher
will skip the record. It will not
overwrite an existing ID.

Highlight
once tinyint(1) O Defaults to 0.

Create a test file

Don't try to upload the whole file without testing it first. If something goes wrong you
may then have to delete all those half-imported glossary items and try again. Create a
test file and run that first.

Copy, say, the first three lines of your text import to a separate file♦ 
Either:

Save the file to a local drive (e.g. somewhere on your c: drive)◊ 
Upload the file to the server◊ 

♦ 

Import the test file

You are now ready to import the test file to KBPublisher.
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Click on the Import menu♦ 
Click on the Import Glossary tab♦ 
If the import file is on your c: drive (or another local drive),

Choose Load Data Local File in the SQL Load Command field◊ 
Browse for the CSV file on your drive and load it◊ 

♦ 

If the import file is on the server,
Choose Load data file◊ 
Type the address where the file is located into the Path to file field on
CSV file line

◊ 

♦ 

Change CSV options if required.♦ 
Click Load♦ 

On completion of the load, you will see a message at the top of the Import Articles
screen telling you how many files were imported successfully and how many were
skipped.

If the upload was successful, click on the Articles tab to check out the articles.♦ 

Fix any problems

All going well, you should now have three new glossary items in your knowledgebase.
Check them carefully and ensure that everything worked as you expected. If you had
problems, delete these, fix the test file and run it again. Keep fine-tuning until it works,
and then update the real file to match the fixes you made in the test file.

You are now ready to import the rest of the glossary.

Import articles

Import the rest of the glossary using the same process as for the test file, only this time
using the real data file.

Note:

If the glossary item already exists, a new item will still be uploaded.  We
recommend you do not duplicate.

♦ 

If any unique keys will be duplicated during import, records from cvs file will be
ignored.

♦ 

----------------------------------------------------------------------
This functionality works in version 4.0 and above
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Comments

Article comments

Comments allow readers to give feedback on articles.

You can read comments in the public view, or if you have admin access you can also see
them from the comments tab in the knowledgebase.

To add a comment:

Open the article to read it♦ 
Click on Add comment.♦ 
This brings up the screen to add a comment. Type in your comment. Type it in as
plain text. Do not include HTML.

♦ 

If you wish to be notified when someone else adds a comment to this article,
check Subscribe

♦ 

Unless the system administrator has changed the settings, you will then need to
type in a confirmation code. Type the code exactly as you see it. Match upper
and lower case.

♦ 

Click OK.♦ 
Your comment is displayed beneath the article.
By default, it is displayed immediately, but this can be changed in the settings to
require approval first.
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Rating Comments

Users can rate articles to say whether they were helpful or not helpful.

Depending on how you set your knowledgebase up, they can either rate an article as:

Helpful/Not helfpul, or♦ 
Use a star rating system.♦ 

When a user rates an article they can also add a comment saying why they rated the
article the way they did.

These comments are emailed to the supervisor for that category, or if no supervisor is
assigned, to the system administrator.

You can see these rating comments in the Admin area

Choose the Feedback menu♦ 
Select the Rating Comments tab♦ 

----------------------------------------------------------------------
This functionality works in version 3.5 and above

---------------------------------------------------------
Some functionality mentioned on this screen works in version 3.5 only or has been
changed for version 4.0.
For a complete list of changed/new functionality, please see version 4.0 release notes
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Bulk update comments, rating comments and feedback

KBPublisher allows you to bulk update feedback, comments and rating comments to:

Set a status ♦ 
Delete ♦ 

You can do this direct from the Feedback menu, and choose the appropriate tab.

To set the status of a comment or a rating comment:

Click on the approriate tab♦ 
Check one or more comment to update♦ 
Choose the appropriate action from the drop down list of actions with selected♦ 
This brings up further options to select from according to the action chosen.
Choose the appropriate selection

♦ 

Click OK.♦ 
Note:

Bulk actions available depend on your user access.
For example if your privilege does not allow you to delete comments then there
is no 'Delete' action in the list of options.

♦ 
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Files
The Files area of the knowledgebase 

What are files and how do they work?

Files are documents you can add to your knowledgebase. The type of files you can add is
controlled by the settings of your knowledgebase, but in general you can add graphics, text
documents, Microsoft Office documents (Word, Excel, PowerPoint) or PDFs.

The file area is separate to the article knowledgebase, although you can attach the files from
the File area into articles. Note though, that inserting graphics into articles is not the same as
adding a file from the Files area.

Why would you want to have a separate files area? Common examples might be:

It could be a download area of your knowledgebase.• 
You have a whole lot of process documents or user manuals that you wish to upload.• 

The maximum size of a file you can upload depends on PHP settings, default is 2MB.
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Add a File

To add a file from your local computer to the server, select Files from the menu bar to display
a series of sub-tabs. (To link to a file that is already on your server, see Add a local file.)

â��To upload a new file that requires no further approvals before becoming available,
select the Files tab. Then click the Add new button to display the form where you
specify the file.

• 

The form that appears differs in only one detail, explained below, depending on the option you
chose above.

Complete the form's fields:

File -- Select the file to upload.• 
Category -- Add one or more categories for the files by clicking the + icon to the right
of the Category field and selecting from the list of categories provided.

• 

Title -- Add a title.• 
Description -- Add a description.• 
Tags -- You can add one or more tags to help users find the file. Click the Tags link and
then select tags:

Type a few characters of the tag you want in the field that appears, and select
the tag from the options provided.

♦ 

Click the "Choose from your tags" link to display all the tags available. Select the
ones you want to associate with this file.

♦ 

• 

Private -- You can opt to restrict either or both read and write access to the files. If you
check either check box another field appears where you can specify which roles users
must have to be able to read and/or update the file.

• 

Schedule -- Check the Yes check box and use the fields that appear to set a date when
the status of the current files changes from unpublished to published. Check
the And check box to set a date after which the status of the current files changes from
published to unpublished.

• 

Status -- You  can set the file status as Published or Unpublished.• 
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Click Save to upload the file.
Click Cancel to abandon your edits and close the form.

The maximum size of a file you can upload depends on PHP settings. The default is 2MB. 
See here for Files settings (Allowed extension, Max file size, etc).
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Bulk update files

KBPublisher allows you to bulk update files to:

Set categories• 
Make the files public or private• 
Schedule file publication• 
Sort files (available only when filter for category applied)• 
Re-parse files to extract text from the file (to make them searchable) and update the file
size information

• 

Set custom fields• 
Set file status.• 

You can do this direct from the Files menu, Files tab.

To update the file:

Check one or more files to update• 
Choose the appropriate action from the drop down list of actions with selected• 
This brings up further options to select from according to the action chosen. Choose the
appropriate selection

• 

Click OK.• 

Note:

Bulk actions available depend on your user access.
For example if your privilege does not allow you to delete items, or allows you to only
delete articles that you have created, then there is no 'Delete' action in the list of
options. If your privilege does not allow you to update items, or allows you to only
update items you have created, then this menu will not be available for you at all.

• 

Bulk update files 169

http://www.kbpublisher.com/images/image/manual/Files/BulkUpdateFiles_35.gif


Add a Local File

When you want to add files to the knowledgebase, you can upload files from your local
computer, or you can link to files that are already on your server. In KBPublisher such files are
known as "local files". If the file already exists on the server it saves space to reference it
rather than uploading a second copy specifically for the knowledgebase. By adding a reference
to a file that may be also be available through your corporate website or some other site
(forms, disclaimers, fair-use and privacy policies, product disclosure statements, catalogues,
printable manuals, and so on) you can make the knowledgebase richer and more useful without
taking up additional space.

To add a local file (a reference to a file already on your server):

Select the Files menu• 
Choose the Add Local Files tab to display the Local add form:• 

Complete the form's fields:

Directory -- Enter the name of the directory on your server which holds the files you
want to link to. Then click Get files to display the file or files.
By default all files in the directory are selected. Un-check the check box for each file
you do not want to link to.

• 

Category -- Add one or more categories for the files by clicking the + icon to the right
of the Category field and selecting from the list of categories provided.

• 

Title -- Add a title. If you are linking to more than one file in this operation, all files will
have the same title.

• 

Description -- Add a description. If you are linking to more than one file in this
operation, all files will have the same description.

• 

Author -- By default you are identified as the author of the files. Click the Delete link to
the right of your name to remove it.

• 
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Private -- You can opt to restrict either or both read and write access to the files. If
you check either check box another field appears where you can specify which roles
users must have to be able to read and/or update the file.

• 

Schedule -- Check the Yes check box and use the fields that appear to set a date when
the status of the current files changes from unpublished to published. Check the And
check box to set a date after which the status of the current files changes from
published to unpublished.

• 

Status -- You  can set the file status as Published or Unpublished.• 

When the form is complete, click Add files to add the files to the list on the Files tab.

If you have the correct permissions, you can add the files as drafts.Click Add as Drafts to add
the files to the list on the Drafts tab. Use this option for files that you do not want to publish
yet, or for files that require further review or approval before becoming available. 

Tips:

The files that are found are controlled by the Allowed/Denied extensions setting on
Admin tab under Settings. If you have said there are no restrictions, then all files in
the directory are found. If you have said only image and text files are loadable, then
only image and text files will be found. See Files tab explained for more information
about this.

• 

Files listed are only those in the directory specified. It does not find files in
sub-directories within the current directory.

• 

The PHP open_basedir setting determines where KBPublisher searches for the files. If
you find that Get Files only searches the directories under the knowledgebase itself,
then check your settings to see if PHP restricts it to this.

• 
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Automatically Add Local Files

The Directory Rules screen allows you to set up the knowledgebase so that KBPublisher
automatically checks the specified directory on the server every day and adds in KBPublisher
links to any new files.

Standard allowed and denied extension rules apply, based on your denied and allowed
extensions set in the Files Settings tab. 

Note: a directory rule doesn't move files it identifies as new: it adds links in KBPublisher to
files on your server. If you move a file from the location KBPublisher linked to, the links to that
file in the knowledgebase will be broken.

To see and manage your directory rules, select Files in the main menu, and then the
Directory Rules tab:

If you have a long list of directory rules, you can filter the list by rule status or by the directory
the rule applies to, using the fields above the list of rules.

Managing directory rules

Check the check box in the Active column for a rule to enable that directory rule. Un-check the
checkbox to disable the rule.

Click the gear icon in the Action column of a row to perform one of these actions on the
directory rule in that row:

Edit - update the rule's information. The fields are the same as when you add a new
directory rule--see the descriptions below.

• 

Delete - delete the directory rule.• 

Adding new directory rules

To add a directory rule, click the Add New button. Complete the form that appears:
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Rule options:

Directory -  Provide the directory on the server that the directory rule should monitor.
The directory name should be the full server path. Click Read directory to verify that
the path is correct. If the path is correct, you see a list of all files in that directory.

• 

Parse child directories - Check this option to have the rule monitor all sub-directories
in the directory. This is selected by default.

• 

Description - A description is not required, but you can add one to describe the files
that normally appear in the directory, or information about the directory rule that may
be useful to other team members.

• 

Active - This field is selected by default, and once you save the new directory rule it will
run at the next scheduled opportunity. Un-check this check box to disable the rule (you
can also enable and disable a directory rule from the full list of rules, as described
above).

• 

File options:

Category - Add one or more categories to which the links to the new rules this directory
rule finds will be added. Click the + icon to the right of the field to add a category.

• 

Author - By default the current user's name appears in this field, and will be associated
with the link to any file the directory rule adds to the knowledgebase. You can select a
different user's name as the author, or opt to have no author name.

• 

Private - By default the links the directory rule creates are public. Check one or both
check boxes to control read and write access to the linked file to users with the roles
you specify. See private read and write.

• 

Schedule - Check the Yes check box to display fields where can control when the
newly-linked files become available in the knowledgebase, and, optionally, when they
become unavailable again. See Schedule an item.

• 

Status - By default, files are set to a status of published, but you can change this to
unpublished.

• 

To test the settings click Test.
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Click Save to save the new directory rule. Click Cancel to abandon your edits and close the
form.
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Add New File Category

The quickest way to add a category is to use the Shortcuts menu at the top of your screen.

Click on the drop-down menu in the top right of the screen and choose Add new file
category.

• 

Or you can do it via the Categories tab under Files.

Click on the Files menu• 
Choose the Categories tab• 
Click on Add New.• 

Once you are on the category screen you must complete the following sections:

Add a Title. This is the name that will be displayed on the left menu or in any table of
contents.

• 

Define where it fits in the category hierarchy by choosing a Parent category and an
Order. If you don't change these you will add a new top-level category and it will be
placed last.

• 

You may also:

Control access through Private and Active• 
By checking Allow attach files, files from this category will be allowed to be attached• 
Designate an owner (Supervisor) for the category• 

You can find out more about each of these fields and how they work in the Category screen
explained.
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Private Files

What the Private function does

The private option:

Lets you force users to log on to read items• 
Allows you to restrict who can read items• 
Allows you to restrict who can edit or upload items.• 

It works for articles, files and news items, and can be applied at individual item level and at
category level.

Using the Private function  

Force users to log on

If you mark an item as private read and do not assign roles:

Users must log on to read the item• 
Any user who is logged on can read it• 
In the Public area users will not see the item until they are logged on• 
In the Admin area all users will see the item.• 

If you mark an item as both private read and private write and do not assign any roles:

Users must log on to read the item• 
Users who are not logged on cannot see the item.• 

Restrict read access

If you mark an item as private read and do assign roles:

Users must log on to read item• 
Only users who belong to the nominated role can read the item• 
In the Public area, users who do not belong to the nominated role cannot see the item• 
All users in the Admin area can see the item.• 

Restrict write access

If you mark an item as private write and do assign roles:

All users can read the item• 
Only users who belong to the nominated role can create, edit or update the item• 
For articles, users will not see Edit Article and Quick Edit options in the Public view if
they do not belong to the correct role

• 

Note that if you mark an item as private write and do not assign roles:

All users can see and read the item• 
All users logged in to the Admin area with appropriate privileges can edit the item.• 

Restrict both read and write access
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If you mark an item as both private read and private write and do assign roles:

Users must log on to read the item• 
Only users who belong to the nominated role can see or read the item• 
Only users who belong to the nominated role can create, edit or post the item• 
In the Public area, users who do not belong to the nominated role cannot see the item• 
In the Admin area, users who do not belong to the nominated role cannot see the item• 

Note that private items work in conjunction with privileges. A user who does not have, say,
author privileges, will still not be able to create articles even if they are assigned to a role that
allows them access via private write.

Set up private read and write

To restrict whole categories:

Edit the file category• 
Choose Private Read if you wish to force users to log on and/or to restrict who can see
files in this category. Choose Private Write if you wish to allow everyone to see and
open files in the category but only people who have in the specified roles to manage
them (e.g. upload, delete). Choose both Private Read and Private Write if you wish to
restrict who can read the files and also who can manage them.

• 

This brings up another option, Access for selected roles only.
By default, this is set to None, which means that users must log on to see and open files
in this category, but anyone can see them once they have logged on

• 

Select which roles users must belong to in order to read the files• 
Click OK.• 

To restrict access to a single file:

Edit the file• 
Choose Private Read if you wish to force users to log on to read the file or you wish to
restrict who can see or open it. Choose Private Write if you wish to allow everyone to
see and open the file but only people who have the specified roles to manage (e.g.
delete) it. Choose both Private Read and Private Write if you wish to restrict who can
see or open the file and who can manage it.

• 

This brings up another option, Access for selected roles only.
By default, this is set to None, which means that the file is private, but all users can
read it once they have logged on

• 

Select which roles users must belong to in order to read/manage the file• 
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Assign category to a file

Assigning a category to a file is a two-part process. First you assign the category, and then you
define the order the item is displayed in that category

To assign the category

Create or edit the article• 
Click on the plus (+) button on the right-hand side of the category field.
This opens the Assign Category screen.

• 

Select the Category from the list of categories (1)• 
Click on the plus (+) button at the right-hand side to add this category to the list of
assigned categories (2)

• 

If you wish this category to be the default category, then select the category in the
Assigned list and then click on the Set Default button (3) to make this the default
category

• 

Click OK to save your changes and exit from the Assign Category screen• 

You can add multiple categories.

On the Assign Category screen you can also:

Filter the list to reduce the number of categories displayed• 
Add a new category by clicking the Add New Category button• 
Remove existing categories by clicking on them in the Assigned Categories box, and
then clicking on the minus (-) button.

• 

Tips:

To quickly assign a category you can:

Double-click on the category, or• 
Click on the categorgy, then press <Shift> and <Enter>• 

To quickly unassign a category you can:

Double-click on the assigned category.• 

To display only top categories you can:

Type top: in filter field• 
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To order the category

When you exit from assigning the category the new categories are listed at the bottom of the
screen. 

This will now contain a list of each category you have added, and an order.  By default,
articles are placed at the end of the category.

• 

Click on the order drop-down list beneath the category you wish to re-order• 

Select a new position from the list• 
Click OK to save the changes,• 
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Delete a file

To delete a file:

Choose Files menu• 
Click on the Files tab• 
Click Delete from the options dropdown menu under Actions• 
Click OK to confirm that you really do want to delete the file• 
You will be presented with a warning message asking if you wish to delete the file from
disk

Choose No, just delete record from DB if you wish to delete it from the
knowledgebase but leave the file on the server

♦ 

Choose Yes, delete from disk to remove the file altogether.♦ 

• 

Note:

If a file is attached to an article it cannot be deleted.• 
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Enable searching in files

Text-based file searching/indexing (txt, html, etc.) is enabled by default. If you want to include
searching PDF or Word documents then you need to do the following.

Searching in PDFs

 To enable search in PDFs you need to:

Install a program called xpdf• 
Ensure Settings points to where you installed it• 
Ensure that PHP has access to your xpdf directory. (Check your open_basedir PHP
setting in php.ini)

• 

Ensure that PHP can run the system  function.  (Check
your disable_functions, safe_mode_exec_dir PHP settings in php.ini)

• 

Install xpdf

xpdf is available from www.foolabs.com/xpdf/download.html• 
Download and install it.• 

Update the setting to point to xpdf

Once you have installed xpdf, you also need to set the correct path it in the Settings.

You can find this under Settings menu, Settings -> Admin -> XPDF installation path• 
Make sure that this points to the directory where you installed xpdf. For example:
/usr/local/bin/ or c:/wwwroot/xpdf/

• 

Set this to 'off' to de-activate this option.• 
When you click "Save", test pdf file will be parsed/indexed and error occurs if it failed. • 

Test xpdf from command line

Test to see if xpdf is working by running the following command from the command line:

$ /path_to_xpdf/pdftotext -raw file_read.pdf file_write.txt;
Test  xpdf from command line using PHP and included test file:

$ cd /path/to/kbp_directory
$ php -r "system('/path_to_xpdf/pdftotext -raw admin/extra/file_extractors/extract_test.pdf
file_write.txt');"

Searching in Word 2007/2010, Excel 2007/2010 or Open Office
document files

To enable search in .docx, .xslx and .odt documents you need to:

Install a PHP Zip extension if you do not have one• 
You can see if you have it installed in Home -> Setup Tests tab  in your KBPublisher
installation

• 
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Searching in Word 2003 and below files

 To enable search in Word documents you need to:

Install either catdoc or Antiword• 
Ensure Settings points to where you installed it• 
Ensure that PHP has access to your catdoc directory. Check your open_basedir PHP
setting in php.ini.

• 

Ensure that PHP can run the exec function.  Check
your disable_functions, safe_mode_exec_dir PHP settings in php.ini. 

• 

Install catdoc

catdoc is available from http://www.wagner.pp.ru/~vitus/software/catdoc/• 
Download and install it.• 

Install Antiword

Antiword is available from http://www.winfield.demon.nl/• 
Download and install it.• 

Update the setting to point to catdoc

Once you have installed catdoc, you also need to set the correct path it in the Settings.

You can find this under Settings menu, Settings -> Admin -> catdoc installation
path

• 

Make sure that this points to the directory where you installed catdoc. For
example: /usr/local/bin/ or c:/wwwroot/catdoc/

• 

When you click "Save", test pdf file will be parsed/indexed and error occurs if it failed. • 

Test catdoc from command line

Test to see if catdoc is working by running the following command from the command line:

$ /path_to_catdoc/catdoc -w file_read.doc;
Test catdoc from command line using PHP and included test file:

$ cd /path/to/kbp_directory 
$ php -r "system('/path_to_catdoc/catdoc -w admin/extra/file_extractors/extract_test.doc');"

Test antiword from command line

Test to see if antiword is working by running the following command from the command line:

$ /path_to_ antiword/antiword -t file_read.doc;
Test antiword from command line using PHP and included test file:

$ cd /path/to/kbp_directory 
$ php -r "system('/path_to_ antiword/antiword -t admin/extra/file_extractors/extract_test.doc');"
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Turning PDF or Word search off

If you don't want to allow searching on PDF or Word documents, change the setting in XPDF
installation path or catdoc installation path to OFF. 
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Schedule an Item

Scheduling an article, news or file allows you to set a date that the item is made visible to
users in your knowledgebase and/or a date that it stops being visible.

For example, suppose your company is closed for the Christmas/new year holiday
periodaâ�¬"say it is closed from 12 noon on 24 December and re-opens at 9 am on the 2nd of
January.

You add a news item to say that you will be closed over this period. When you create it
(on 18 December, say), you set its status to "Not Published"

• 

You schedule this news item to change status to "Published" at 12 noon on 24
December, and to change status again to "Not Published" at 9am on 2 January.

• 

Or suppose you have a new software release being implemented. You can create new articles
for the new functionality in the software before the release. Give these articles a status of 'Not
published', and then schedule them to be published on the assigned release date.

To schedule the item:

Create or edit the article, file or news• 
If you are scheduling an article, click on the Advanced tab (you don't need to do this for
files or news items)

• 

Check Yes to the Schedule option• 
This expands the Schedule options• 

Add a date and time to the On the Date fields to set the date and time that the item is
to change status

• 

Use the Change Status To for  dertermining whether the item is to be published or not
published. (Articles have two further statuses, pending and draft.)

• 

Add a Note to explain why this item was scheduled on this date.  Use it as a reminder
or as a record of what happened.

• 

If you wish, you can set a second date and time to change to another status:

Check the And checkbox• 
This brings up a second set of date and status options• 

Add a date and time to the second On the Date fields to set the date and time that the
item is to change status

• 

Use the second Change Status To for  assigning the new status• 
Add a second note if required.• 

Items that are scheduled have a small clock next to the article/file/news ID on the list screens.
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Tip:

You can also use bulk actions to schedule or remove schedules.• 

----------------------------------------------------------------------
This functionality works in version 3.5 and above
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Remove scheduling

To remove scheduling from an article, file or news:

Edit the item• 
Uncheck the Schedule checkbox• 

You can also use the bulk actions option to remove scheduling from multiple articles or files:

Select each item to be un-scheduled• 
Choose remove schedule from the Actions with selected options at the bottom of the
screen.

• 

----------------------------------------------------------------------
This functionality works in version 3.5 and above
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Subscribe to a file

Subscribing to a file means that you receive email notification of any changes to that file.

To subscribe to a single file

Click on the Downloads tab to bring up the list of files• 
Browse for the file that you wish to subscribe to• 
Click on Subscribe in the file details box• 

The Subscribe option changes to Unsubscribe, and from now until you unsubscribe you will
receive notification whenever this file is changed.

To subscribe to all files in a category

Click on My account, which is in the top right-hand corner of the knowledgebase
screen

• 

Click on the Subscriptions tab• 
Click on Subscribe / Unsubscribe for File Categories• 
Click on Add New• 
Select a category you wish to subscribe to and then click on the plus (+) button to the
right of the category list. This adds the category to the Selected Categories list. Note,
there is also an option to select all categories, if you wish

• 

Click OK to save your subscription.• 

You can see which files you have subscribed to in the Subscriptions tab under My Account.

----------------------------------------------------------------------
This functionality works in version 3.5 and above
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Unsubscribe from a file

To unsubscribe direct from the file

Click on the Downloads tab to bring up the list of files• 
Browse for the file that you wish to unsubscribe from• 
Click on Unsubscribe in the file details box• 

To unsubscribe via subscriptions 

You can unsubscribe from single files here, or from whole categories

Click on My account• 
Click on the Subscriptions tab• 
Click on Subscribe / Unsubscribe next to Files if it's for a single file, or from File
Categories if it's for the whole category

• 

Click unsubscribe for the file or category you wish to unsubscribe from• 
Click OK to the message that asks if you're sure• 

----------------------------------------------------------------------
This functionality works in version 3.5 and above
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Feedback
How feedback works on KBPublisher. 

User feedback

Users can contact the knowledgebase by sending a feedback request. They can use the
feedback form to ask questions, provide general feedback or even to suggest updates.

Different subjects can be emailed to different moderators.

The feedback request also provides a 'Quick Response' answer. As the user types their
question, KBPublisher searches for articles appropriate to the words typed and brings back the
five articles most likely to match the query. If the answer is in one of the listed articles, the
user doesn't have to send the query at all. They can simply click on the article instead.

The request is sent to an email address defined in the settings.

The person who receives the email can:

Reply by email, or• 
Publish the feedback to the knowledgebase as an article, or• 
Both reply and publish.• 

A user with administrator, moderator or editor access can view the feedback by clicking on the
Feedback menu.

This brings up a list of the feedback that users have sent.

Posted date is the date the user sent the feedback.1. 
Username and Email are those of the user who has sent the feedback.2. 
Subject is the subject area the user chose from the list of subjects when they sent the
mail. The person reading the mail may also change the subject.

3. 

Attach denotes whether or not the user has attached any files with their feedback.4. 
When the Answered box is checked, it means that you (or one of the other
knowledgebase moderators) replied to the user by email.

5. 

When the Placed in KB box is checked it means that you (or one of the other
knowledgebase moderators) posted an answer to the knowledgebase.

6. 

There are three possible Actions:7. 

Click Answer from the options dropdown menu to reply to the user by email♦ • 
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Click post question to KB from the options dropdown menu to post an answer
to the knowledgebase. The question the user asked becomes the title of the
article

♦ 

Click Delete from the options dropdown menu to delete the question.♦ 

It is quite common to both answer the user by email and then post to the
knowledgebase. For example a user might ask a question that you think deserves
to be a knowledgebase article, so you write the article and then email the user
back to say that the answer is now on the knowledgebase.

The templates for the initial email and the reply are controlled in the settings.
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Quick Response

By "connecting" your contact form with your knowledge base, your visitors can get instant
answers to questions that they would normally send you via email.

If a user clicks on Ask a question, when they start typing their query into the
Question/Comments field, KBPublisher checks what they are typing and searches for articles
that may answer the question.
It presents the five best matches at the bottom of the screen under a heading called 'Do these
answers help?'

The five articles returned change as the user types more words.

Turning off quick response

This option can be turned off in Settings if you prefer a basic feedback form without this
feature.

Go to Admin Area• 
Click on the Settings menu• 
On the  Common tab, under Feedback, uncheck Enable 'quick response'.• 
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Reply to feedback from a user

There are two ways to reply to emailed feedback from a user.

The first is to click on the link supplied in the email:

Click on the link after Read and respond to this message at in the email• 
This brings up a mail template for you to reply to.• 

Or you can do it from the feedback option:

Click on the Feedback menu• 
Click on answer icon (email) in the Action list for the feedback you are answering• 
This brings up a mail template for you to reply to• 

Once the email template is open:

Type your answer in the Answer section• 
Click Send• 
You return to the Feedback screen. The answered box is checked.• 
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Add an article as a result of user feedback

Sometimes, feedback from a user generates an idea for another article.
You can create this article direct from the feedback page.

Click on the Feedback menu• 
Click on the place question in KB icon (the curved blue arrow) under actions• 
This brings up a new article screen for you to start creating the new article.
The text in the email is listed in the article title

• 

Create the article as you normally would and save it.• 
When you return to the Feedback screen, the Placed in KB box is checked.• 
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Add New Feedback Subject

You can create your own feedback subjects:

From the Tools menu choose the Lists tab• 
Click on Feedback Subject• 
Choose Add New• 

You must include:

A title. This is the subject the user picks from the drop-down list of subjects when they
are sending feedback.

• 

You can also add:

A description, which is an explanation of what this subject is used for.• 
A supervisor. This allows you to determine which user will receive feedback for this
subject. If you do not assign a supervisor, then the email assigned to recieve Support
email will get the feedback. To assign the supervisor click on the Add New icon, find
the person you want to receive the emails, and click Assign. You can add more than one
supervisor. Each person on the list will receive the emails.

• 

Choose a color that will be associated with this feedback subject.• 
The order this item is in the list of feedback subjects. This defaults to 1, which places
the new type at the top of the list.

• 

Whether or not the feedback subject is active. If the subject is not active, then the user
will not be able to choose this as a subject.

• 

Lastly

Click Save.• 
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Article comments

Comments allow readers to give feedback on articles.

You can read comments in the public view, or if you have admin access you can also see them
from the comments tab in the knowledgebase.

To add a comment:

Open the article to read it• 
Click on Add comment.• 
This brings up the screen to add a comment. Type in your comment. Type it in as plain
text. Do not include HTML.

• 

If you wish to be notified when someone else adds a comment to this article, check
Subscribe

• 

Unless the system administrator has changed the settings, you will then need to type in
a confirmation code. Type the code exactly as you see it. Match upper and lower case.

• 

Click OK.• 

Your comment is displayed beneath the article.
By default, it is displayed immediately, but this can be changed in the settings to require
approval first.
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The article comments screen explained

The Article Comments screen displays a list of the comments users have added to articles.

To get to this screen:

Select the Feedback menu• 
Click on the the Article Comments tab.• 

The Status drop-down list allows you to filter comments by whether they have been
published or are unpublished

1. 

Use the Search field to search for specific text in the comment.2. 
Once you have changed the status or typed in a search command, use the Go button to
get the results back.

3. 

The records line contains information about how many comments are displayed here,
how many pages there are in the list, and the number of records per page. You can use
this to move through the list of comments.

4. 

Information shown for each comment includes:

The date the comment was posted5. 
The first 200 characters of the comment are displayed initially. If there are more than
200 characters, this will be shown by '... more' at the end. You can click on 'more' to
display the full comment. 

6. 

The article for which the comment was made is listed in the Article column, plus the
total number of comments for this article

7. 

Click on Public View to view the article being commented on8. 
Or click on Edit Article to actually edit the article9. 
The status of the comment is shown in the Published field. Articles can be published or
not published. If this field contains a tick then the item is published.

10. 

Click Edit from the options dropdown menu to edit the comment. This includes
changing the status.

11. 

Click Delete from the options dropdown menu to delete a comment.12. 
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Rating Comments

Users can rate articles to say whether they were helpful or not helpful.

Depending on how you set your knowledgebase up, they can either rate an article as:

Helpful/Not helfpul, or• 
Use a star rating system.• 

When a user rates an article they can also add a comment saying why they rated the article the
way they did.

These comments are emailed to the supervisor for that category, or if no supervisor is
assigned, to the system administrator.

You can see these rating comments in the Admin area

Choose the Feedback menu• 
Select the Rating Comments tab• 

----------------------------------------------------------------------
This functionality works in version 3.5 and above

---------------------------------------------------------
Some functionality mentioned on this screen works in version 3.5 only or has been changed for
version 4.0.
For a complete list of changed/new functionality, please see version 4.0 release notes

Rating Comments 197

http://www.kbpublisher.com/images/image/manual/Feedback/CommentFeedbackForm_40.gif


The rating comments screen explained

The Ratings Comments screen displays a list of the comments users have added when they
rated an article 'Not helpful'.

To get to this screen:

Select the Feedback menu• 
Then click on the Rating Comments tab.• 

The Status drop-down list allows you to filter the rating comments list by a single
status, such as new comments, or those for articles in review.

1. 

Use the Search field to search for specific text in the rating comment.2. 
Once you have changed the status or typed in a search command, use the Go button to
get the results back.

3. 

The records line contains information about how many rating comments are displayed,
how many pages there are in the list, and the number of records per page. You can use
this to move through the list of rating comments.

4. 

Information shown for each article includes:

The date the article was posted5. 
The first 200 characters of the comment are displayed initially. If there are more than
200 characters, this will be shown by '... more' at the end. You can click on 'more' to
display the full comment.

6. 

The article about which the comment was made is listed in the Article column, plus the
total number of negative rating comments for this article

7. 

Click on Public View to view the article being rated8. 
Or click on Edit Article to actually edit the article9. 
The current status of the comment is shown in the Status field as a color. Red denotes
a new comment, yellow denotes in progress (the article is being reviewed), blue denotes
that the article is currently being updated and grey denotes a comment that you have
chosen to ignore. (You can change the statuses and the colors from the Settings menu,
Lists tab.)
If you double-click on the status you open the comment to edit it.

10. 

Click Edit from the options dropdown menu to edit the comment. This includes
changing the status.

11. 

Click Edit from the options dropdown menu to delete a rating comment.12. 

----------------------------------------------------------------------
This functionality works in version 3.5 and above
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Users
All about users 

The User input screen explained

You can't have a knowledgebase without users. In KBPublisher we have readers, contributors,
authors, editors, moderators and administrators. Or you can set up your own user types.

First Name, Last Name and Middle Name make up the user's name. First and last
name are compulsory, middle name is not.

1. 

Email is the user's email address. This is the email to which all KBPublisher
communications will be sent. Email is also compulsory. Emails are also unique, so you
cannot have more than one user in the knowledgebase with the same email address.

2. 

Telephone is the user's contact telephone number.3. 
Company is the company the user works for. If you intend to associate a company with
the user, then this company must have first been set up in KBPublisher.

4. 

Roles allow you to group users, and to further control what content a user can see.5. 

To add a role:

Click on the + to the right of the role field. This takes you to a new screen listing all
roles

• 

Double-click on each role you wish to allow the user to take to add the the role to the
list of assigned roles

• 

When you are done, click OK to return to the user screen• 

Privileges control the type of access the user has to KBPublisher.6. 

There are five default privilege groups.

Administrator sets up the system, controls user accounts, designs the
site and so on

♦ 
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Moderator has access to every part of the system except Settings and
Import/export. The moderator generally creates users, organizes
categories and manages the knowledgebase on a day to day basis

♦ 

Editor can add, edit and delete their own and other users articles, files,
comments and visitors' questions. This is the person responsible for the
overall content of the knowledge base.

♦ 

Author provides the actual content. An author can add, edit, delete or
publish their own articles and files. When they have completed an article
and published it, the article appears immediately in the article list

♦ 

Contributor also provides content, and can add edit or delete their own
articles and files but the articles and files do not appear in the
knowledgebase immediately. They must be approved by an editor or a
moderator. Once an article or file is approved, the contributor can no
longer edit it.

♦ 

You can also create your own privilege groups.

Users may also be set up with no defined privilege. These are the public users.

The Username is the name the user uses to log on. If you click set as email here, the
username will be the name you typed into the email field. You must provide a username.

7. 

The Password is the password the user will use to log on. Because this is a password,
the text you type is replaced by dots.  You can also generate a random password
instead, by selecting Generate random password.

8. 

Because there is no way of seeing what you typed into the Password field, you need to
retype the password into the Password (confirm) field.

9. 

User notes are comments the user adds when he or she fills in the form to request user
access

10. 

Private Admin notes are notes that can be added by the administrator when adding or
updating the user. The user does not see these.

11. 

The administrator adding the user can automatically subscribe them to news, files and
articles. The user is then notified of any changes to these.  Click All to subscribe them
to all changes, or click to select individual subscriptions.  Use <Shift> or <Ctrl> to
select more than one. 

12. 

A user must be Active to be able to log on to the system. An inactive user cannot log
onto the system at all, and user who is pending (approval required) has been set up
but is still not able to access the system until a moderator or administrator approves
them.
User statuses could be managed at Tools -> Lists -> User Status.
Note that inactive users can still see any parts of the public area that are open to
everyone. That is, that users don't have to log on to see.

13. 

If Notify user is checked, the user will receive an email once their access has been set
up.

14. 

---------------------------------------------------------
Some functionality mentioned on this screen works in version 3.5 only or has been changed for
version 4.0.
For a complete list of changed/new functionality, please see version 4.0 release notes
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Add a user

To add a new user

Click on the Users menu• 
Click on Add New.• 

Once you are on the Users screen you must complete the following sections:

Give the user a First Name and a Last Name• 
Add their Email• 
Give them a Username. If you prefer, you can set their email as their user name.• 
Set up a Password• 

The following items are optional:

Assign a Privilege. If you do not assign a privilege the user will have standard read
access to the public area.

• 

To classify the user, and provide another level of access, include a Role. • 
You can include extra user details such as a Middle Name, Phone and Company• 
You can add comments about the user or registration• 
You can automatically subscribe them so that they receive changes to news, articles or
files

• 

To give the user immediate access to the system, make this user Active• 
To send an email to the user after then that their user ID has been created, check
Notify User.

• 

You can find out more about each of these fields on the User screen and how
they work in the User Screen Explained

Once your user has been set up:

Click Save.• 

Tips:

If you have a number of users to add from another database, say, you may want to
import users instead of adding them

• 

Or you may choose to allow users to register, which effectively allows them to create
their own user.

• 
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Delete user

The quickest way to delete a single user is to:

Click on the Users menu• 
Click Delete from the options dropdown menu under Actions• 
Click OK to confirm the deletion.• 

The second way allows you to delete more than one user at the same time.

Click on the Users menu• 
Check the box to the left of the user or users you wish to delete• 
Choose Delete from the Actions with selected drop down box• 

Click OK• 
You will be asked if you really want to delete the user. Click OK to confirm.• 
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Bulk update users

KBPublisher allows you to bulk update users to:

Set roles• 
Set privileges• 
Set the user status• 
Assign users to a company• 
Automatically subscribe them to news, articles or files• 
Delete users.• 

You can do this direct from the Users menu, Users tab.

To update the users:

Check one or more users to update• 
Choose the appropriate action from the drop down list of actions with selected• 
This brings up further options to select from according to the action chosen. Choose the
appropriate selection

• 

Click OK.• 

Note:

Bulk actions available depend on your user access.
For example if your privilege does not allow you to delete items, or allows you to only
delete articles that you have created, then there is no 'Delete' action in the list of
options. If your privilege does not allow you to update items, or allows you to only
update items you have created, then this menu will not be available for you at all.

• 
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Import users

You can import users in bulk. You might want to do this if you are changing over to
KBPublisher from an old system, or if you have signed up a new company or organization and
the company provides you with a list of users to create.

The process is:

Create a file of users to import• 
Upload a test sample to the system• 
Import.• 

Create a file of users to import

First, you need to create your file of users. This is a comma-separated (CSV) text file that
consists of some or all of: first name, last name, email, username, user ID, date registered,
middle name, telephone number and an active flag.

The first five fields (highlighted bold) must be included. You can include some, all or
none of the others as required.

• 

They do not have to be in the same order as above, but each line in the import file must
contain the same fields in the same order.

• 

The password is encrypted. You cannot import plain text passwords; they must be
encrypted in MD5 format. Ensure that the person providing you with the list encrypts
the passwords.

• 

The active flag defaults to '1', which is active, so the only time you would set this is if
you don't want the users to be active.

• 

Place the data for each user onto a single line, and separate each field by a comma. Do
not include spaces before or after the comma.

• 

The TestImportUsers.csv file is a sample that shows what your upload file should look
like. This file includes the five default fields only.

• 

Field sizes and types are specific, as per the table below. Your data must fit within these
parameters or the upload will fail.

• 

Field Type/size M/O Comments

first_name varchar(50) compulsory

last_name varchar(100) compulsory

email varchar(100) compulsory

username varchar(50) compulsory

imported_user_id int(10)
unsigned optional

date_registered date optional
Format YYYY-MM-DD.
If not supplied will use
current date.

middle_name varchar(50) optional

phone varchar(20) optional
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active tinyint(1) optional Default = 1

Create a test file

Don't try to upload the whole file without testing it first. If something goes wrong you may then
have to delete all those half-imported users and try again. Create a test file and run that first.

Copy the first, say, three lines of your text import to a separate file• 
Either:

Save the file to a local drive (e.g. somewhere on your c: drive)♦ 
Upload the file to the server♦ 

• 

Import the test file

You are now ready to import the test file to KBPublisher.

Click on the Import/Export menu• 
This brings up the Import Users tab• 
If the import file is on your c: drive (or another local drive),

Choose Load Data Local File in the SQL Load Command field♦ 
Browse for the CSV file on your drive and open it♦ 

• 

If the import file is on the server,
Choose Load data file♦ 
Type the address where the file is located into the Path to file field on CSV file
line

♦ 

• 

Move the CSV fields around to specify which fields are in the file and what order they
are in.
Do this by clicking on the name of the field you want to move and dragging and
dropping it into the appropriate place.

For example, suppose you only want the five mandatory fields included. You need to
move the date_registered and imported_user_id fields out of the Fields in CSV box and
into the Available table fields box. Let's start with the date_registered field.

Click on the date_registered field and hold the mouse down♦ 
While holding the mouse down, drag the date_registered field over to the
Available table fields box

♦ 

Drop the field into the box by releasing the mouse

Make sure that you place it in the order it appears in the file.

♦ 

• 

Change CSV options if required.• 
Click Load.• 

Once the load is complete you are returned to the Import Users tab. At the top of the screen
you see a message telling you whether the import was successful and how many users were
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imported.

If the import reports as successful, click on the Users tab to check the result for
yourself.

• 

Fix any problems

All going well, you should now have three new users. Check them carefully and ensure that
everything worked as you expected.
If you had problems, delete these three users, fix the test file and run it again. Keep fine-tuning
until it works, and then update the real file to match the fixes you made in the test file.
You are now ready to import the rest of the users.

Import users

Import the rest of the users using the same process as for the test file, only this time using the
real data file.

Note:

Imported users have no roles or privileges.• 
If any unique keys will be duplicated during import, records from cvs file will be
ignored.

• 

Use the bulk actions option to change roles, privileges, etc.• 
Temporary password generated for imported users, they should to reset it using "Forgot
Password" option.

• 
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Companies

Companies provide another level of information about users. When you create a user you can
assign the user to a specific company.

Companies are not compulsory in the knowledgebase. You would use them if your users were
from a small number of companies, but if your users came from all around the world and were
a mix of individuals and company users you probably would not bother.

Some examples where you might user them:

Your users come from a finite number of companies and you have multiple users in each
company

• 

When you license the knowledge in your knowledgebase and charge the company for
access

• 

Some examples where you probably wouldn't:

Your users come from all around the world• 
You would have to set up a different company for every user• 
When there is only one company (although you could also set up the company in this
case; it wouldn't matter either way).

• 
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Generating API Keys

For API authentication Public and Private keys are required.
Each user has his own unique keys. 

To generate and assign keys to user:

Login to Admin Area • 
Click User tab• 
Click the Options icon under Actions to display the dropdown list, and then click
Details

• 

Click API Settings, it will open for with API Settings• 
Check API Access to allow user API requests or uncheck to disalow• 
Click Generate API Keys if you assign keys in first time or Reset API Keys if
updating 

• 

Important: if you reset API keys it will affect all current scripts for this user
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Privileges

User privileges

Any user can read articles, but in order to create articles and to publish them to the
knowledgebase, users must have certain privileges.
For example, to actually write articles a user must have author or contributor privileges.

To publish the article for other users to read, they must be in the author, editor or moderator
privilege groups. KBPublisher comes with five default privilege groups, and you can also create
your own.

There are five default privilege groups.

Administrator sets up the system, controls user accounts, designs the site and so on• 
Moderator has access to every part of the system except Settings and Import/export.
The moderator generally creates users, organizes categories and manages the
knowledgebase on a day to day basis

• 

Editor can add, edit and delete their own and other users articles, files, comments and
visitors' questions. This is the person responsible for the overall content of the
knowledge base.

• 

Author provides the actual content. An author can add, edit, delete or publish their own
articles and files. When they have completed an article and published it, the article
appears immediately in the article list

• 

Contributor also provides content, and can add edit or delete their own articles and
files but the articles and files do not appear in the knowledgebase immediately. They
must be approved by an editor or a moderator. Once an article or file is approved, the
contributor can no longer edit it.

• 

You can also create your own privilege groups.

Here is a quick chart of default user types in KBPublisher
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Privilege levels

Each user type has a privilege level. The privilege level defines who can edit users of this
level. Users cannot edit other users with a privilege level lower than or equal to their own.

Admin users always have a privilege level of 1. They can edit any other user.  In the standard
setup editors have a privilege level of 3, while authors have a privilege level of 4 and
contributors 5. This means that an editor could--if he had edit user access--edit author and
contributor users while a contributor could not edit any users except other contributors (again,
and only if he had edit user access).  None of them can edit admin users.
This gives an extra level of security when editing users.

* Adding comments, rating articles and sending emails to the administrator are all options that
can be turned on or off in the settings. Hence while these options are available, they must also
be turned on if you wish to use them.
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Create new user privilege

Privileges control what a user can do on the system. There are five default privilege groups,
but you can also create your own.
You must have administrator access to create new privileges.

To create a new privilege group:

Click on Users• 
Choose the Privileges tab• 
Click Add New• 

Complete the following:

Title is compulsory• 
Privilege level is also compulsory. This controls user security. Users cannot edit users
with a privilege level less than their own, even if the access settings allow them to edit
users.

• 

Check privileges as required. A user will be able to do anything that is checked.
The privilege screen explained tells you how each of the options work.

• 

You may also wish to:

Add a description to explain why this group has been set up and how it should be used• 
Prevent users in this group from logging on by making the group inactive.• 
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Set default user privileges

New users can be created two ways. They can be set up by the knowledgebase administrator,
or users can register themselves.

By default, when users register KBPublisher creates them with no privileges. You can change
this so that new users are created with a specific default privilege by:

From the Settings menu choose the Public Area tab• 
Go to the Security / Privacy / Registering section• 
Select the appropriate Privilege for new registered users from the drop-down list of
privileges

• 

Click Save.• 

All new users who register after this are created with the new default privilege.

You must have administrator access to change the settings.
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The Privilege Screen Explained

Title is the name of the privilege. Title is compulsory.1. 
Description is used to remind you what the privilege is for. For example, when the
administrator creates a new privilege, he or she would use the description to explain
what the privilege does and how it should be used.

2. 

Privilege level denotes the level of security for this privilege.  Users cannot update
other users with a privilege level lower than or equal to their own, even if they have
user update access. This is also compulsory.

3. 

When the privilege is set to Active (that is, active is checked), users with this privilege
can log in. If it is not set, then users with this privilege cannot log in. Thus, with one
click you can prevent all users with a specific privilege from logging in.

4. 

You can control the privileges for each module in KBPublisher separately. This means
you can give access just to one area only if you wish. For example, you may allow access
to the knowledgebase, but not to Files, Feedback, Users, Settings or Import/Export. Or
you may have hired a contractor to import a list of users for you, and you give them
access to the Import/Export section only, but not to other areas of the knowledgebase.

5. 

Privileges can be applied at the top level for the whole module, or they can be specific
to actions in the module. For example, you can apply privileges to the knowledgebase by
checking the appropriate privileges in the Knowledgebase line and then checking Apply
to child to apply these privileges to everything in the module.

6. 

Or you can apply privileges to each sub-module.7. 
Most of the privileges are self-explanatory.8. 

When Read is checked the user can view items. If own records is also
checked, they can only read records they have created. Otherwise they
can read all records. Belong to own records denotes items like
comments, and allows the user to manage comments that belong to items
where own records is checked.

♦ 

When Add is checked they can create new items. if As draft only is
checked, they can add only drafts. 

♦ 

When Update is checked they can change existing ones. If own records
is also checked, they can only update records they have created.
Otherwise they can update any record. If As draft only is checked, they
can update articles as draft only. Belong to own records means that the
user can update comments for items they own.

♦ 
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If status, then the user can only update articles with the assigned status.
(To select more than one status hold the <Ctrl> key down and click each
status you want.) If no status is selected, the user will be able to update
records with any status.

When Delete is checked the user can delete items. If own records is also
checked, they can only delete records they have created. Otherwise they
can delete any record. Belongs to own records means that the user can
delete comments for items that are designated as their own.
If one or more statuses are selected under If status, then the user can
only delete articles with the assigned status(es). 

♦ 

Status allows the user to change the status of an article from, say,
unpublished to published. If own records is checked, then the user can
only change the status of records they have added.
If one or more status is selected under allowed status to set, then the
user can only change items to the selected status(es). If no status is
selected, the user can change the record to any status.

♦ 
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Roles

User roles

Roles allow you to set up a hierarchy of users and to control which articles users can see.

Roles are set up as tree structures, and when you mark an entry as private to a specific role
then users with this role and with parent roles have access to the article. Any role below it in
the tree, and roles that do not belong to 'current tree', will not be able to access the article.

For example, suppose you have the following roles:

In the above tree the Contractors role has a sub-role of Manager, and below that sub-sub-roles
of Beta Tester, Tech Writer and Programmer.

Users can be assigned to multiple roles.  Thus your programmer could also be an employee. 

If you mark an article private read and assign to it a role of 'Programmer', then contractor
managers and programmers will be able to access the entry. No one else will have access to
this article.

Note:

Users with administrator privilege have access to any article in any category.• 
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Create new user role

Roles control access to knowledgebase articles and files.
Some default roles have been created, but you can also create your own.

You must have administrator access to create new roles.

To create a new role:

Click on Users • 
Choose the Roles tab• 
Click Add New• 

The following are compulsory:

You must include the role name in the Title• 
The Parent role denotes where in the list of roles this role is placed. If you choose 'Top
Level' your new role becomes a top level role. Otherwise, choose the parent role for
your new role.

• 

You may also wish to:

Add a description to explain why this role has been set up and how it should be used• 
Change where in the role hierarchy the role is listed by changing the Order of the
group.

• 

Create new user role 216



Set Default User Roles

New users can be created two ways. They can be set up by the knowledgebase administrator,
or users can register themselves.

By default, KBPublisher creates registered users with no designated role. You can change this
so that new users are created with a specific role by:

First, ensure that the role exists. If it doesn't, create it first• 
From the Settings menu choose the Public Area -> Common tab• 
Go to the Security / Privacy / Registering section• 
Select the appropriate Role for new registered users from the drop-down list of roles• 
Click Save.• 

All users who register after this are created with the new default role.
You must have administrator access to change the settings.
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My Account

How to use My Account 

How do I change my password?

To change your password:

Log in to the knowledgebase• 
Click on My account, which is in the top right-hand corner of the knowledgebase
screen

• 

Click "Change Password"• 
Type in your Your Current Password if required• 
Type your new password into the New Password field• 
Retype the password in the Verify Password field• 
Click OK.• 
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How do I change my screen width?

The screen width is the width of the box that displays the knowledgebase, including any
menus. The width of the display is set up by the administrator but some people have narrower
screens and find that they have to keep scrolling to the right to read articles. Or they may have
wide screens and want the display to cover more of the screen.

You can personalize the width as follows:

Click on Admin Area if you are in the public view• 
Click on My Account, which is in the top right-hand corner of the knowledgebase
screen, underneath your login details

• 

Click on the Settings tab• 
Change the Box Width to the width you want KBPublisher displayed. You can use a set
width, in pixels (px), or use a percentage (e.g. 100%).  The default box width is the
width that the administrator has set up for the database.

• 

Click Save.• 

----------------------------------------------------------------------
This functionality works in version 3.5 and above
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How do I display more articles on a page?

Ten articles are listed on each screen by default is 10, and you have to click more to see the
next ten, and so on. The adminstrator can change this or everyone.

You can also personalize it for yourself, and display 20 or 40 records at a time instead:

Click on Admin Area if you are in the public view• 
Click on My Account, which is in the top right-hand corner of the knowledgebase
screen beneath your login details

• 

Click on the Settings tab• 
Choose 10, 20 or 40 records from the drop-down list for Number of records per page• 
Click Save.• 

----------------------------------------------------------------------
This functionality works in version 3.5 and above
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Change the order articles and files are displayed in

By default, articles and files in Admin Area are displayed in ascending date updated
order.  That is, the last article or file updated is at the top of the list, and the first one updated
is at the bottom.

Sometimes you want to see the list differently.  You can order by date added (newest date
first), date added (oldest date first), date modified (newest date first), date modified (oldest
date first) and in alphabetical order.

Click on Admin Area if you are in the public area• 
Click on My account, which is in the top right-hand corner of the knowledgebase
screen, beneath your login details

• 

Click on the Settings tab• 
To change the order that articles are sorted in, choose an appropriate order in Sort
Articles By

• 

To change the order that files are sorted in, choose an appropriate order in Sort Files
By

• 

Click Save.• 

----------------------------------------------------------------------
This functionality works in version 3.5 and above
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Subscriptions

Subscriptions allow you to be notified when:

A single article is changed• 
Any article in a specified category is changed, or when new articles are added to the
category

• 

A single file is changed• 
Any file in a specified category is changed, or when new files are added to the category• 
News is added or changed• 
A comment has been added to an article or file.• 

When you set up a subscription for a specified item or category, then KBPublisher sends you an
email when that file or category is changed.

You can see what you have subscribed to on the Subscriptions tab under My Account.

----------------------------------------------------------------------
This functionality works in version 3.5 and above
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Subscribe to an article

Subscribing to an article means that you receive email notification of any changes to that
article.

To subscribe to a single article

Open the article to read it• 
Click on Subscribe in the quick access panel on the right-hand side of the screen• 

The Subscribe option changes to Unsubscribe, and from now until you unsubscribe you will
receive notification whenever this article is edited.

To subscribe to all articles in a category

Click on My Account, which is in the top right-hand corner of the knowledgebase
screen

• 

Click on the Subscriptions tab• 
Click on Subscribe / Unsubscribe for Article Categories• 
Click on Add New• 
Select a category you wish to subscribe to and then click on the plus (+) button to the
right of the category list. This adds the category to the Selected Categories list. Note,
there is also an option to select all categories, if you wish

• 

Click OK to save your subscription.• 

You can see which articles you have subscribed to in the Subscriptions tab under My Account.

----------------------------------------------------------------------
This functionality works in version 3.5 and above
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Unsubscribe from an article

To unsubscribe direct from the article

Click on the article to read it • 
Click on Unsubscribe in the quick access panel on the right-hand side of the screen• 

To unsubscribe via the subscriptions list

You can unsubscribe from single files this way, and whole categories

Click on My account• 
Click on the Subscriptions tab• 
Click on Subscribe / Unsubscribe next to Articles if it's for a single file, or from
Article Categories if it's for the whole category

• 

Click unsubscribe for the article or category you wish to unsubscribe from• 
Click OK to the message that asks if you're sure• 

----------------------------------------------------------------------
This functionality works in version 3.5 and above
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Subscribe to a file

Subscribing to a file means that you receive email notification of any changes to that file.

To subscribe to a single file

Click on the Downloads tab to bring up the list of files• 
Browse for the file that you wish to subscribe to• 
Click on Subscribe in the file details box• 

The Subscribe option changes to Unsubscribe, and from now until you unsubscribe you will
receive notification whenever this file is changed.

To subscribe to all files in a category

Click on My account, which is in the top right-hand corner of the knowledgebase
screen

• 

Click on the Subscriptions tab• 
Click on Subscribe / Unsubscribe for File Categories• 
Click on Add New• 
Select a category you wish to subscribe to and then click on the plus (+) button to the
right of the category list. This adds the category to the Selected Categories list. Note,
there is also an option to select all categories, if you wish

• 

Click OK to save your subscription.• 

You can see which files you have subscribed to in the Subscriptions tab under My Account.

----------------------------------------------------------------------
This functionality works in version 3.5 and above
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Unsubscribe from a file

To unsubscribe direct from the file

Click on the Downloads tab to bring up the list of files• 
Browse for the file that you wish to unsubscribe from• 
Click on Unsubscribe in the file details box• 

To unsubscribe via subscriptions 

You can unsubscribe from single files here, or from whole categories

Click on My account• 
Click on the Subscriptions tab• 
Click on Subscribe / Unsubscribe next to Files if it's for a single file, or from File
Categories if it's for the whole category

• 

Click unsubscribe for the file or category you wish to unsubscribe from• 
Click OK to the message that asks if you're sure• 

----------------------------------------------------------------------
This functionality works in version 3.5 and above
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Subscribe to news

To be notified when news items are added to the knowledgebase:

Click on My Account• 
Click on the Subscriptions tab• 
Choose Subscribe/Unsubscribe for News.  This brings up a subscribe button.  • 
Click Subscribe• 

You will be notified daily of changes to news items.

----------------------------------------------------------------------
This functionality works in version 3.5 and above
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Unsubscribe from news

To no longer receive notifications about updates to the news area of the knowledgebase:

Click on My Account• 
Click on the Subscriptions tab• 
Choose Subscribe/Unsubscribe for News.  This brings up a subscribe button.  • 
Click Unsubscribe• 

----------------------------------------------------------------------
This functionality works in version 3.5 and above
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Reports
Reports functionality in KBPublisher 

The Usage Report Explained

Report Filter allows you to choose which statistics you want to report on. Check each
item you want statistics for

1. 

Range allows you to determine whether the stats are shown for each day, for a month
at a time or for a whole year.

2. 

Period is the time period over which the stats are to be listed for. The options here
depend on what you choose in the range. For example, if you choose monthly, then the
period options will be this week, previous week, this month or the previous month.
You can also select a custom period. If you choose this KBPublisher allows you to
choose a From date and a To date.

3. 

Once you have selected filters, a range and a time period, click the OK button to
produce the report.

4. 

The report is displayed as a graph--you can choose line, bar or pie charts5. 
And as a table on screen in the Report tab.6. 
You can click on a Date field to break it down even further.
For example, in the diagram above, clicking on July 2010 displays the statistics for each
day in July.

7. 

The statistics you requested are displayed as a table.8. 
If you wish, you can also Export the results.9. 

If you click on the Export tab, you get the option to export the results in XML, CSV or
Excel format.

10. 

Once you have chosen the appropriate format to export in, click on the Export button to
export the data. You will be asked if you want to open the file or save it.

11. 

Note:

Report functionality only works when scheduled tasks are turned on• 
Data collected is summary data. We do not break down data to individual user level, we• 

Reports 229

http://www.kbpublisher.com/images/image/manual/Reports/ReportsUsageScreenExplained_withNumbers_40.gif
http://www.kbpublisher.com/images/image/manual/Reports/ReportsUsageExportScreenExplained_withNumbers_40.gif


collect totals only.

----------------------------------------------------------------------
This functionality works in version 3.5 and above
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The Views Report Explained

The Views Report lets you review how often visitors are looking at each of your articles or
documents.

The main display shows you, for each document:

the document's ID• 
the title• 
the number of views (or "hits") the document has had in the current time span• 
what percentage of all views that number represents (in the "Rate" column)• 

If there are a lot of entries, the list at the right is broken up into pages, with the number of
entries displayed at the top left. Use the navigation options at the top right to move through
the list.

You can filter the display to simplify finding what you want. The Report filter is on the left of
the screen, and you can use one or all of these filter conditions:

Type -- Choose from the available options: Article Views, File Downloads, or News
Views.

• 

Period -- Choose a time period such as "This Week". If you choose "Custom", fields
appear where you specify the start and end dates for the custom period.

• 

Limit -- Indicate how many entries to display. If you select "__", KBPublisher displays all
entries for the type you selected.

• 

Category -- Choose a category to only display items from that category. Check the
checkbox to the right of the field to also display entries in sub-categories of the category
you selected.

• 

Entry ID -- You can enter one or more document IDs, if you know them, to restrict the
display to those documents only. If you enter multiple IDs, separate them with commas
(like "22, 40, 104, 10021").

• 

Click OK to display filtered search results. If there are no results, your search may be too
restrictive: remove or relax one filter and click OK again.

To see details about document use, check the checkbox at the left end of the row for one or
more documents, then click View Details. If you want to see details for just one document, you
can double-click its title.

The Details view appears. This view has a space for a chart at the top and two tabs below.

Details View
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The details view can display a chart of document use, and has tabs to report on daily use and to
export the information.

Chart

A chart of document views can help you analyze viewing and use patterns over time. You can
display the information about the selected document or documents as a Line, Bar, or Pie
chart; or you can opt to have no chart:

Report tab

The Report tab shows the number of views for the selected document for each day in the
selected period. Sundays appear in red so you can quickly see week-by-week information:

Export tab

You can export the views data for the documents you selected. See Export Reports.

To return to the full list of documents, locate the "breadcrumbs" entry at the top of the
display. Click either Article Views or Filtered views to close the details view.

Note:  Report functionality only works when scheduled tasks are turned on
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Export Reports

You can export your reports on document and file activity from the Usage and Views tabs of
the Reports menu item.

Each of these tabs has a pair of sub-tabs, Report and Export. Once you see the information
you want to export in the Report sub-tab, switch to the Export sub-tab to export it.

For XML or Excel, select that option and click Export.

For CSV export, accept the defaults for the options for the exported data, or set your own:

Fields terminated by -- The mark that indicates the end of data for the current field;
normally a comma.

• 

Fields optionally enclosed by -- You can opt to enclose data for each field in quotation
marks or another mark. This allows you to include commas in the data even if they are
also used as the field terminators.

• 

Lines terminated by -- For multi-line entries for a field, the mark that indicates when
to start a new line,

• 

Include field names row -- Check the checkbox to include the header row in the
export.

• 

Include total row -- Check the checkbox to include a "totals" row indicating a count of
the entries.

• 

When you are satisfied with the settings, click Export.

What happens next depends on your browser and your browser settings. In Internet Explorer
and Firefox a message panel appears asking if you want to open the file or save it. Google
Chrome automatically saves the file to your download folder and you can click on it there to
open it.

If you are using Internet Explorer

Click Open if you wish to open the file now• 
Click Save if you wish to save the file. Browse to a suitable directory, then click Save to
save the file.

• 

If you are using Firefox

Click Open with if you wish to open the file now.
The Open With options suggest a default program you might wish to open the exported
file. For example,the Firefox suggests using Excel (if it is installed) to open both CSV
and Excel files. If you wish to change the program to open it in click on the specified file
type (e.g. Excel) and choose Other from the list. Browse to find the program you want
the report to open in, select it, and OK to return to the message panel

• 

Choose Save File if you wish to save the file. This saves the file to your default
download directory (specified in Tools > Options in Firefox) and opens the download
panel so that you can open it if you wish

• 

If you are using Google Chrome, the export command automatically saves the file to the
download directory specified in your Chrome settings.

----------------------------------------------------------------------
This functionality works in version 3.5 and above
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Statistics

The statistics screen allows you to see

What are the most viewed articles• 
The articles with the highest rating• 
The articles with the lowest ratings• 
The articles with the most comments• 
The most downloaded files• 
The most popular search terms used, and the least popular• 
Plus general statistics about articles, files, news, feedback and users.• 

You can export the results as xml or csv files for use elsewhere.

Note:

We keep records at summary level only. We do not break data down into individual
users.

• 

----------------------------------------------------------------------
This functionality works in version 4.0 and above
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RSS
An explanation of RSS feeds and how to set them up 

Turn RSS feeds on or off

You must have administrator access to do this. 
Login to Admin Area.

To turn RSS feeds on

Click on Settings menu• 
Choose the Public Area -> Common tab• 
Go to the section titled RSS Feeds at the bottom of the screen• 
In the Generate RSS feeds field choose either One Channel for whole
knowledgebase, or Channel for every top category depending on whether you want
multiple feeds or one feed for the whole knowledgebase.

• 

Click Save to implement the changes.• 

To turn RSS feeds off

Click on Settings menu• 
Choose the Public Area -> Common tab• 
Go to the section titled RSS Feeds at the bottom of the screen• 
In the Generate RSS feeds field choose Do not generate any RSS feeds• 
Click Save to implement the changes.• 
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Change RSS feed from single feed to separate category feeds

By default, your knowledgebase is set up to display a single RSS feed for the whole
knowledgebase. You may, however, want to change this. You might want to turn it off
altogether. Or you might want to change it so that each top-level category has its own feed.

Separate feeds are useful when your users are only interested in information about specific
categories. For example,suppose your knowledgebase was about internet browsers. You have
three main categories: Internet Explorer (IE), Firefox and Sahara. People who use Sahara are
not interested in anything IE or Firefox related, they are only interested articles pertinent to
Sahara. Likewise, Firefox users do not generally use Internet Explorer. In this case, a separate
feed for each top category is ideal.

You require administrator access to do this.

Click on Settings menu• 
Choose the Public Area -> Common tab• 
Go to the section titled RSS Feeds at the bottom of the screen• 
In the Generate RSS feeds field choose Channel for every top category• 
Click Save to implement the changes.• 

Even when this is turned on, a user can still subscribe to the single feed if they wish to.

Note:

Articles designated as "private" are not shown in the RSS feed.
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Subscribe to RSS feed

KBPublisher produces an RSS feed which users can subscribe to by:

Click on the RSS feed image at the bottom of the screen ( )• 
This brings up a list of all feeds available.

If KBPublisher is using default settings, there will only be one option
available--Knowledgebase RSS.
If multiple feeds are set up, this list will also include a feed for each top-level category.

• 

Click on the RSS feed image to the right of the feed you wish to subscribe to to bring up
the RSS page.

• 

Click on Subscribe to this feed• 

If you are using Internet Explorer (IE), choose the RSS feed directory (Create
In) where you wish the feed to be displayed and click Subscribe.

• 

If you are using Firefox, select the application under which you wish to read the feed
from the Subscribe to this feed using list and click Subscribe now.  

• 

Note: Articles designated as 'private' are not shown in the RSS feed.
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Tools

Tags, Labels

What are Tags?

Tagging is another non-hierarchical way to group related articles together and to quickly tell
readers what they are reading about. Tag keywords and phrases so readers can easily find
articles related to specific topics.

Tags are similar to categories, but are more specific. The use of tags is optional.
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Tagging Content

Tagging an article, news, or file?

It's easy! When you create or update an article or a file, you can assign and/or add new tags to
it using the Meta Keywords/Tags field.

Click on the Add a tag link below the text editor.

You can add tags one at a time by hitting the Enter after typing each tag. Or you can add
multiple tags at a time by separating each with a space as you type. You can join 2 or more
words together in one tag by enclosing them in quotation marks.

To select a tag from your existing list (tags previously used in KBPublisher) click Choose from
your tags and select the tags you want to use.

You can select more tags, or all tags, by clicking on Get more tags or Get all tags links
respectively.

Note: Changes are not saved until you save an article.
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Bulk Add or Update Tags

To bulk add or update tags, log on to the Admin Area

If you are updating:1. 

an article's tags, click on the Articles menu• 
a file's tags, click on the Files menu• 
a news' tags, click on the News menu• 

Choose Set Tags from the Actions with selected drop-down2. 

a second drop-down will display the following options:• 

Remove any tags:

Choose Remove all tags from the second drop-down box♦ 
Click OK♦ 

Add tags:

Choose Add to existing to add tags and not remove existing ones or
Replace existing to remove old tags and assign new ones 

♦ 

Click Add a tag♦ 
Assign tags from choosing existing ones or add your own tags♦ 
Click OK to save the change♦ 
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Managing Tags

You must have administrator access to manage tags.

Login to Admin Area, click Tools, choose the Tags tab.
From here you can see all the tags used in KB.

Create or updating a tag 

The following are compulsory:

You must enter a tag name in Title• 
Check Visible to make tag visible to end users or uncheck so that it is hidden• 

You may also wish to:

Add a Description to explain why this tag has been set up and how it should be used
This information is displayed in Public Area, under Tags to help end users searching
for content

• 

What is a difference between visible and hidden tags?

A visible tag displays in the Tags of and article (below the article) in the Public Area. Although
hidden tags do not display in the Tags section, it is always used for searching.

Can I safely update or delete tags? 

Yes, you can. When you update a tag it will affects all entries already assigned.
Conversely, when you delete a tag, it will be deleted from all entries that is was assigned to.
Since the daily scheduled tasks are responsible for updating meta keywords updates it might
take some time for these changes to take effect.
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Tags in Public Area

The 3 uses of tags in the Public Area 

While viewing an article you can see all assigned tags below an article.
Click on a tag to display all articles with this tag. This function is the same for the News
section.

• 

The Tags section will list all tags.
Click a tag to be be redirected to search section displaying all articles with this tag.

• 

In Advanced Search you can search the knowledgebase by tags.
- Type keywords in Keywords field, you can type several keywords separated by comma
- In Search In choose Articles (tags, keywords) or Files (tags, keywords) or News
(tags, keywords)
- Click Search and KBPublisher will search in articles, files, or news respectively.

• 
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Custom fields

Custom Fields 

Custom Fields

You can customize your knowledgebase by adding custom fields.

These custom fields can be defined for:

Articles• 
Files• 
News items• 
Feedback form• 

For articles, the custom fields can:

Be displayed at the top of the article• 
Be displayed at the bottom of the article• 
Be displayed after the rating block• 
Or they can be hidden, for internal use only• 

For files, fields are for internal use only.  That is, you can see them when you add the file, but
the user cannot see them.

Depending on where the field is displayed, you can also include text around the field.  For
example, the field may be 'Department', and the valid value in the field might be 'Sales', but
the user might see this as 'Contact the Sales Department for further information'.

Bulk actions available depend on your user access.
For example if your privilege does not allow you to delete items, or allows you to only delete
articles that you have created, then there is no 'Delete' action in the list of options. If your
privilege does not allow you to update items, or allows you to only update items you have
created, then this menu will not be available for you at all.
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The Custom Fields Tab Explained

This screen allows you to create custom fields, and to place them in your knowledgebase.

The Custom Fields tab

The Custom Fields tab allows you create and manage the fields and to control which
categories or areas they are attached to. The Ranges tab allows you to create a set of
valid values which you can then assign to one or more custom fields.

1. 

Field type is a filter that allows you to view custom fields for a specified Field types.
Select your filter and then click the search/filter button to restrict the list.

2. 

Entry type is another filter. This allows you to view all custom fields associated to
articles, or to files, or to news items or to feedback. Use with the search/filter button to
show only fields of that type.

3. 

Status is a filter as well. This allows you to view custom fields ...4. 
Or you can also search on the name of the custom field by typing the name into the
Search fields and then clicking the search/filter button.

5. 

Clicking the Add New button allows you to create a new custom field. Note that you
can only create the field to go with a specific entry type. Thus If you want to add, say, a
Department field to both articles and files, then you would need to create two custom
fields.

6. 

The Title is the name that the user sees on the screen when they add or read an article7. 
The Field type denotes the type of field it is. Whether it's a checkbox, or a select box,
or even free-flowing text

8. 

The Entry type is which area of the knowledgebase this field is used in. That is,
whether it is used in articles, files, news items or feedback.

9. 

M denotes mandatory. When a field is mandatory the author creating the item cannot
leave this field blank.

10. 

If you want to see which articles contain values in the mandatory field, click View
entries. This takes you to a list of articles that have information in the selected custom
field

11. 

To turn the field on so that it is able to be filled in, ensure that it is Active. To hide it,
uncheck Active.

12. 

There are three Action fields: apply, edit and delete.
Apply allows you to set a value for all articles which match field criteria. This is
useful when you already have existing items and want to add a value to the old
items. Note that it only applies value to items that do not already have an
associated custom value, so you don't have to worry about overwriting items you
have already set.

♦ 

Edit allows you to edit the custom field. Note that you can also double-click
anywhere in the line on the field to edit as well.

♦ 

Delete allows you to delete the field. If you attempt to delete a field that is being
used you witll get a warning message telling you the field is being used and you

♦ 

13. 
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will need to decide if you still wish to delete the field after that.

The Ranges tab

The ranges are the valid values you can select from. For example, you may have a list of
departments, or a checkbox that allows you to denote whether extra information is required.

You can also re-use ranges. That list of departments might be a drop-down select box in your
FAQ category, and a radio-button select on the feedback form.

Add New here means add a new set of valid values14. 
Click on the Title to open the range set and add new values or edit existing ones,
including re-order the fields.

15. 

Description is a description of the field range. When a user is adding a custom field,
this is the text they see when they click on the inline help 

16. 

View takes you to a list of custom fields that contain this range17. 
The Action field has three options: load, edit and delete.

Load takes you to the range, so that you can edit, update or re-sort the
individual valid values

♦ 

Edit allows you to rename the range and update the description♦ 
Delete deletes the range. If the range is being used by custom fields, you will
not be able to delete it. Use View to see which fields contain the range.

♦ 

18. 

Bulk actions available depend on your user access.
For example if your privilege does not allow you to delete items, or allows you to only delete
articles that you have created, then there is no 'Delete' action in the list of options. If your
privilege does not allow you to update items, or allows you to only update items you have
created, then this menu will not be available for you at all.
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Add a new custom field

To add a new custom field

Click on Tools ->  Custom Fields tab• 
Click Add New• 
Choose your field type by clicking on one of the field types.
This takes you to the Entry Type tab.

• 

Choose where this custom field will appear by clicking on an Entry Type. Note that if
you want the field to appear for, say, both articles and files, you must create two
separate fields, although you can use the same range

• 

If you are adding the field to articles or files, you will then be taken to the Categories
tab and prompted for a category. Add any categories where the field is to be displayed.
If you want the field displayed in all categories, leave this blank

• 

Click Form Options to go to the next tab if you need to. If you chose an entry type of
news or feedback you should already be here

• 

Add the name of the field to the Title field• 
Add a tooltip if required• 
Check Mandatory if you want to force the user to fill in this field• 
Check Active if the field is to be used immediately i.e. if you want the field to appear on
the screen

• 

Click on the Range tab• 
Click on Set Range• 
If you wish to use an existing range click Assign to assign the range
If you wish to create a new range,click Add New and [add the new range], then click
Set Range to assign the range to the custom field

• 

Click on the Display Options tab• 
Use the drop-down Display field to choose where the field is to be displayed on the
screen.
Note that when you enter the field as part of creating the article, it is always displayed
under the article content. This display field define where the text is displayed in the
Public area

• 

If you wish you can also add some text around the field by adding it to the HTML
Template. For example if your custom field is 'Department' and the value you input is
'Sales' then:
{title}: {value} - displays Department: Sales
Welcome to the {value} team - displays Welcome to the Sales team
Note that this extra text is not displayed if you have chosen 'Hidden, not displayed in
Public Area' as the display option

• 

Click Save to create the field.• 

Note:

If you have existing articles or files, then you will be given the option to add a default
value to those items. If you wish to add a default value, select the value and click Add
Values.

• 

Bulk actions available depend on your user access.
For example if your privilege does not allow you to delete items, or allows you to only delete
articles that you have created, then there is no 'Delete' action in the list of options. If your
privilege does not allow you to update items, or allows you to only update items you have
created, then this menu will not be available for you at all.
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Add a new custom field range

What is a custom field range

A range is a list of valid values that you can use in your custom fields.  

Once you have set up a range you can re-use it as many times as you like.  For example, one
time you might have it as a drop-down option in an article category, another time you might
include it as a radio button list in the news area.

Create the range 

Click on Settings menu• 
Select the Custom Fields page• 
Choose Ranges tab• 
Add New• 
Add an appropriate name to the Title field, for example, Department.• 
We recommend that you add an appropriate description as well.• 
Click Save.
This adds the field and sets up ready to add each of the values.  Then, for each valid
value you wish to add:

Add the name of the value in the Title field♦ 
Add a number in the Order field to show where it will be placed in the list.  By
default this is numbered sequentially in the order that you add them

♦ 

Save if you wish to add another valid value.♦ 

• 

Bulk actions available depend on your user access.
For example if your privilege does not allow you to delete items, or allows you to only delete
articles that you have created, then there is no 'Delete' action in the list of options. If your
privilege does not allow you to update items, or allows you to only update items you have
created, then this menu will not be available for you at all.
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Update values in a custom field range

To update values in a custom field range

Click on Settings menu• 
Choose Custom Fields tab• 
Choose Ranges tab• 
Click on the name of the range that you wish to edit• 

From here you can

Add new values to the range by
Click Add New♦ 
Add a Title♦ 
Click Save♦ 

• 

Change the name of a valid value value by:
Click on the edit icon of the value you wish to change♦ 
Update the Title♦ 
Click Save♦ 

• 

Delete existing values
Click on the delete icon of the value you wish to change♦ 
Click Save to confirm that you really do want to delete the value♦ 

• 

Reorder the range
Click on the edit icon of the value you wish to change♦ 
Type the new order into the Order field♦ 
Click Save♦ 

• 

You will need to do this for each valid value in the range, as the other values do
not automatically re-order themselves.

Bulk actions available depend on your user access.
For example if your privilege does not allow you to delete items, or allows you to only delete
articles that you have created, then there is no 'Delete' action in the list of options. If your
privilege does not allow you to update items, or allows you to only update items you have
created, then this menu will not be available for you at all.

Update values in a custom field range 248



To see where a custom field is used

To see all items where a field is used

Click on Settings menu

Choose the Custom Fields tab• 
Click on View in the Entries column• 

To see where items with a specific valid value are used

This functionality works in a similar way for articles, files, news and feedback, even though the
example given here is for articles.

Log on to the Admin area• 
Click on Articles (if field is under Articles, or Files, News or Feedback if field is under,
respectively, files, news or feedback)

• 

Click on the '+' button to the left of the category drop-down

This brings up a list of all custom fields for articles (or files/news/feedback)

• 

Select the specific field and value that you are looking for• 
Click on Search.• 

This brings up a list of all articles with that particular custom field value.

Bulk actions available depend on your user access.
For example if your privilege does not allow you to delete items, or allows you to only delete
articles that you have created, then there is no 'Delete' action in the list of options. If your
privilege does not allow you to update items, or allows you to only update items you have
created, then this menu will not be available for you at all.
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Search in custom field in public area

You can search for data in both the Public Area and in the Admin Area.

To search in the Public Area

Click on Advanced Search• 
From the Search In drop-down box, choose Attachments and inline files• 
At the bottom of screen you will see an Extra Options section which contains all the
custom fields

• 

To search in the Admin Area

Click on Articles (if field is under Articles, or Files, News or Feedback if field is under,
respectively, files, news or feedback)

• 

Click on the '+' button to the left of the search area

This brings up a list of all custom fields for articles (or files/news/feedback)

The list of custom fields display by default is custom fields that are included in all
categories.  If you want custom fields that are listed only in a specific category, select
the category

• 

Once you have your list of custom fields

If necessary, choose a category.
Categories default to 'all' and will also search in sub-categories if you use the default
options

• 

Choose which field you wish to search on, and choose which data you wish to search for
If the field is a multi-choice field you will be presented with a list of drop-down
values to select from

♦ 
• 
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If the field is a checkbox, you will be able to check the value to choose items with
that flag set

♦ 

If the field is a text field, you will be able to type text into the field to search on♦ 
and so on.
Click Search to start the search.• 

This brings up a list of all articles with that particular custom field value.

Some working examples for search

Let's say you have a knowledgebase set up as follows:

Article Category Custom
field

Valid
values

for
custom

field

Custom
field

defined at
category

level

Value
in

custom
field

Teach
yourself

Photoshop
Product Extras

DVD
T-shirt
Game

No DVD

Nerds Rule Product Extras
DVD
T-shirt
Game

No T-shirt

How to
Make Cards Product Extras

DVD
T-shirt
Game

No -

Our London
Office Branches Retail

shop
Yes
No Yes Yes

Our Paris
Office Branches

Retail
shop

Yes
No Yes Yes

Extras
DVD
T-shirt
Game

No T-shirt

No valid value has been set for the article How to make cards. Also, Extras can be defined
anywhere.

If you click on search without defining any further parameters this brings back a list of
all articles which contain values in any custom field, hence it would return:

Teach Yourself Photoshop♦ 
Nerds Rule♦ 
Our London Office♦ 
Our Paris Office♦ 

• 

If you select T-shirt in the Extras custom field, and then click on search (still not having
defined any further parameters, or using All), this will bring back:

Nerds Rule♦ 
Our Paris Office♦ 

• 

If you select T-shirt in the Extras custom field, and choose the Product category, this
will bring back:

Nerds Rule♦ 

• 
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If you choose T-shirt in the Extras custom field, and Yes in the Retail Shop field, and
search all levels, then your search will return:

Nerds Rule♦ 
Our London Office♦ 
Our Paris Office♦ 

• 

This last is because it will search for either field, rather than both fields.
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Bulk add or update custom fields

To bulk add or update custom fields, log on to the and Admin area and then:

If you are updating:1. 

an article custom field, click on the Articles menu• 
a file custom field, click on the Files menu• 
a news custom field, click on the News menu• 
a feedback custom field, click on the Feedback menu• 

By default, the listing displays all custom fields that are not assigned for specfic
categories.
To see fields assigned to a specific category, select the category you wish to search on. 
This displays all custom fields for the category, plus any custom fields that are not
assigned to a specific category.

2. 

Select the items whose custom fields you wish to update.3. 
Choose Set custom fields from the Actions with selected drop-down.4. 
This brings up a second drop-down box for you to select from.5. 
If you wish to:6. 

Remove any custom fields set:

Choose remove all custom fields from the second drop-down box♦ 
Click OK♦ 

Update a single custom field:

Choose the custom field from the second drop-down box♦ 
This brings up the fields associated with the category beneath the
drop-down

♦ 

If the field is not currently associated with the item(s), this brings up a
check-box add to existing

♦ 

If you wish to add the field to the selected items, check this box♦ 
Update the field as required♦ 
Click OK to save the change♦ 
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Update all the custom fields at the one time:

Choose set all custom fields from the second drop-down box♦ 
This brings up the fields associated with the category beneath the
drop-down

♦ 

Update fields as required♦ 
Click OK to save the changes.♦ 
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Lists

The Lists Tab Explained

The Lists tab under the Settings menu allows you to:

Manage article statuses• 
Manage file statuses• 
Control article types• 
Manage user statues• 
Manage feedback subjects• 
Manage rating comments statuses• 

Article and file statuses

KBPublisher has four default article and file statuses: published, pending (approval required),
draft and not published.

Use the Lists tab to add new statuses and modify existing ones. You control:

The name of the status• 
The color denoting that status• 
Description• 
Where the status appears in the list of statuses• 
Whether the status is active• 
Whether or not this status is published (which means users can see it),• 

Once you add a new status this status appears in the drop-down status lists on the User
Privilege screen, so you can control whether or not users have access to the new status.

Add new article status tells you how to add a new status for an article.

Article types

Article types are used to group records for searching, to provide default template for the
articles and to control the display of the type.
Add new article type explains how to create new article types.

User statuses

KBPublisher has four default user statuses: active, pending (approval required), unconfirmed,
and not active.

Use the Lists tab to create new user statuses and modify existing ones. You control:

The name of the status• 
The color denoting that status• 
Description• 
Where the status appears in the list of user statuses• 
Whether the status is active.• 
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Feedback subjects

There is an option on the Ask a Question screen that allows the user to specify a feedback
subject from a drop-down list. You define these feedback subjects on the Lists tab. You control:

The title, which is what the user picks from the feedback subject list• 
Description• 
Who gets the feedback question (i.e. the specified supervisor)• 
Color associated with this feedback subject• 
Order it appears in the list• 
Whether the feedback subject is active.• 

Rating comment statuses

Rating comments have four intially-defined statuses: new, igore, in progress and
processed.  You control:

The name of the status• 
The color denoting that status• 
Description• 
Where the status appears in the list of statuses• 
Whether the status is active.• 
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Automations

Automations

Use automations (automated tasks) to check your content regularly and perform certain
actions as needed. You can make sure your articles are up to date, and alert staff to review
them when they are not. You can let authors know when articles have been approved for
publication, or let managers know when articles are ready for review.

To access your automations, select Tools from the menu bar. Then select the Automations
sub-tab.

Essential facts for automations

Automations are time-based: they act when a time-based event occurs, such as the time
since an article was edited exceeding a specified maximum time.

• 

Automations run daily, at midnight.• 
An automation must contain a condition that is true only once, or an action that nullifies
at least one of the conditions; otherwise, the automation will run daily, possibly sending
unwanted duplicate alerts every time it runs.

• 
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Manage Automations

To access your automations, select Tools from the menu bar. Then select the Automations
sub-tab:

The tab displays both your active and inactive automations for either articles or files. Switch
between the Articles and Files tabs to see all existing automations. If the list is long, enter a
keyword in the Filter field to display just the automations that have that keyword in their
titles. To restore the full list, remove all text from the Filter field.

For each automation, you can click the button in the Action column and select an action to
perform:

Change status - Select to change the status of the automation from active to inactive,
or  from inactive to active. A confirmation message appears to make sure you want to
change this status.

• 

Duplicate - Make a copy of the automation that you can then edit. This helps you
quickly create automations that are similar to existing ones.

• 

Edit - Edit the automation. See Creating or editing an automation.• 
Delete - Select to delete the automation. A confirmation message appears to confirm
you want to do this.

• 

Add an Automation

To create a new automation, click Add new. See Creating or editing an automation.

Reorder

To change the display order of the automations, click the [...] button and select Reorder. In the
form that appears, drag the automations higher or lower in the list until they are in the order
you want. Then click Save. 

This option only appears if you have at least one active automation, and is only relevant if you
have two or more active automations.

Important: Automations are applied in the order they appear in the "active" list. If the first
automation in the list applies and makes some changes to an article or file, the following
automations will evaluate the document or file in its updated state.
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Default automations

KBPublisher has some default automations that you can use as-is, or copy and customize to suit
your needs. For example, one default automation checks the number of days since the last time
each article was updated. If that number is greater than a set value (the default is 180 days),
the automation changes the article's status to "outdated" and sends an alert email requesting a
review and possible update of the article.

To restore the default automations, click the [...] button and select Set defaults. A message
appears to confirm you want to remove all existing automations, including the ones you have
created, and restore the default ones. Click Yes to continue this action.
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Creating or editing an automation (automated task)

To create a new automation (automated task), click Tools -> Automations tab make sure you
are on the sub-tab the automation will be for: Articles or Files. Then click Add new. See the
information below about completing the form that appears.

When you create a new automation, or update an existing one, you see the same form:

Complete the form in the following manner:

Title - Required. Provide a descriptive title for this automation. It should not be the
same as the title of an existing automation.

• 

Conditions - You must have at least one condition that the automation checks each
time it runs. You can have multiple conditions. Set the automation to perform its actions
if any or all of the conditions are true. Add a condition by clicking the + button; remove
a condition by clicking its - button.

• 

Actions - If the automation finds that the conditions in the previous field are met, it
performs the actions you set here. You can have multiple actions. Add an action by
clicking the + button; remove an action by clicking its - button.

• 

Each action will either set status or send emails to one or more recipients.
Set status - If you choose this action, in the next field specify the new status for
the article or file from the list of options shown above.

♦ 

Email - you can choose to send an email to yourself or another user, or to a user
group. You can opt to send one email for each item that matches the conditions,
or to bundle all the notices into a single email.
You need to prepare the email template in the fields that appear:

Title - Provide a title for the email.◊ 
Body - Provide the body of the email. You can use template tags to
customize the email: for instance, if you want to include the title of the
article in the email, you could write "This is an alert about the article
[article.title]." When the automation needs to send the email, it replaces
the template tag with the appropriate information.
To see the template tags that are available, click Show template tags.
To check that the email looks as it should, click Populate template to
see a preview. 

◊ 

♦ 

• 

Active - Select to activate this automation. It will run hourly until deactivated.• 

Click Save to save the automation. Click Cancel to abandon your edits and close the form.

Important: 
An active automation will run daily. Make sure that, when the automation finds an article or
file that meets its conditions, one of the actions invalidates for that item one of the conditions
of the automation.
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Workflows

Workflows

Workflows automate processes for reviewing, approving, and publishing articles. This can save
you time and make sure articles that may be ready to publish, but need approval, are not
overlooked. If the item requires review and approval before it is published, a workflow can
transfer the item to the worklist of the person who is responsible for approving it. That person
can approve the article or send it back for further edits.

Workflow Flowchart

The image below shows the path the draft of an article or file might have to follow if, after the
author has written or uploaded it, one or more people have to review and approve it before
publication.

Essential facts for workflows

Workflows are applied to drafts of articles and files only • 
You cannot delete or edit a workflow which in use (is applied to some drafts).• 
You can have as many approval steps in a workflow as your project's process requires.• 
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Manage Workflows

To access your workflows, select Tools from the menu bar. Then select
the Workflows sub-tab: 

The tab displays both your active and inactive workflows for either articles or files. Switch
between the Articles and Files tabs to see all existing workflows. If the list is long, enter a
keyword in the Filter field to display just the workflows that have that keyword in their titles.
To restore the full list, remove all text from the Filter field.

For each workflow, you can click the button in the Action column and select an action to
perform:

Change status - Select to change the status of the workflow from active to inactive, or
 from inactive to active. A confirmation message appears to make sure you want to
change this status.

• 

Duplicate - Make a copy of the workflow that you can then edit. This helps you quickly
create workflows that are similar to existing ones.

• 

Edit - Edit the workflow. See Creating or editing a workflow.• 
Delete - Select to delete the workflow. A confirmation message appears to confirm you
want to do this. 

• 

Note: You cannot delete or edit a workflow that is in use, First change the workflow's status to
"inactive". You can then edit it or delete it. If you edit the workflow, you can then change the
status back to "active" to put it back in use. 

Add a Workflow

To add a workflow, click Add new and complete the form. See Creating or editing a workflow.

Reorder

To change the display order of the workflows, click the [...] button and select Reorder. In the
form that appears, drag the workflows higher or lower in the list until they are in the order you
want. Then click Save. 
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This option only appears if you have at least one active workflow, and is only relevant if you
have two or more active workflows.

Important: Workflows are applied in the order they appear in the "active" list. If the first
workflow in the list applies to a draft, it will run for that draft and KBPublisher will evaluate
the draft in its new state to determine whether to apply any other workflows.

Default Workflows

KBPublisher provides a default workflow that you can use as-is, or copy and customize to suit
your needs.

To restore the default workflow, click the [...] button and select Set defaults. A message
appears to confirm you want to remove all existing workflows, including the ones you have
created, and restore the default one. Click Yes to continue this action.
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Creating or editing a workflow

To locate your workflows, select Tools from the menu bar and then select the Workflows tab. 

You can create your own workflow from scratch, or copy an existing workflow and adapt it to
your needs. You can create or edit a workflow for either articles or files.

To create a new workflow, click Add new to open the Workflow form.• 
To edit a workflow, click the gear icon in the workflow's row and select Edit.• 
To make a copy you can adapt, click the gear icon in the workflow's row and select
Copy.

• 

The workflow form appears, with blank fields if it is for a new workflow and with the existing
information if you are editing or copying an existing workflow.

Note: you can't edit an active workflow. First change the workflow's status to "inactive" and
then open it for editing. When you have completed the edits, you can change the status back to
"active".

Complete the fields in the form:

Title -- Provide a unique, distinctive title for this workflow.• 
Conditions -- Add one or more conditions that the workflow evaluates each time it runs.
You can set the workflow to take action if any of the conditions are true, or if all
conditions are true. In the example above the workflow conditions apply to articles that
have been published and where the author's privilege level is greater than "author" (the
author is also an editor, for example).

To add conditions, click the + button to the right of the field.♦ 
Each condition can apply to one of these:

Whether the draft is published or not.◊ 
The author's privilege level.◊ 
The author's identity.◊ 

♦ 

• 

Steps -- Provide one or more steps for the workflow to take if the Conditions section
evaluates to true.

Add steps by clicking the + button to the right of the field.♦ 
For each step, provide:

A title for the step.◊ 
The action to take (like "assign" the article or file).◊ 

♦ 

• 
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Where relevant, the person or role to assign the article or file to. Select
from the options provided.

◊ 

Active -- By default, each workflow is set as active. To deactivate it, uncheck this check
box. The workflow appears in the Inactive workflows list.

• 

Click Save to save the workflow and add it to the active or inactive list.
Click Cancel to abandon your edit and close the form.
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Workflow examples

Here are some examples of how to use workflows for drafts of material that need review and
approval before publication.

Simple, one-step approval 

When you have users with the "contributor" privilege adding a drafts, use a workflow like this
to alert the category supervisor when draft content is ready for review.

The workflow checks for draft content that has been submitted for review by a "contributor"
user and assigns such content to the appropriate supervisor. If the category has no supervisor
assigned, KBPublisher parses the category tree to find the appropriate supervisor. If no
category supervisor can be found, the system sends a message about the draft to the email
address defined in Settings > Email > Admin Email.

You should assign a supervisor at least for each top category (the same supervisor can be
responsible for multiple categories). See Can I route an Approval email based on the
category? for information about assigning category supervisors.

Assign to a specific approver

When you want a specific staff member to review draft submitted for publication, use a
workflow like this that identifies the specific user:
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When a user with the "author" or "moderator" privilege adds a draft, the draft will be assigned
for review to the person specified. In the example above, the person is the current logged-in
user; but you can assign any user to review the material.

Multiple-step approval 

If your workflow requires multiple approval steps before draft material is published, use a
workflow like this one:

In this example, when a contributor creates a new draft, the draft will be assigned for review to
a user with "editor" privileges. When the editor has approved the material for publication, the
draft is assigned to a user with "moderator" privileges for final review and approval. When the
moderator has approved the material, it is published.

You can add as many approval steps as your project's process requires.

As with the first example, if KBPublisher cannot find a user with "editor" or "moderator"
privileges, it sends a message about the draft material to the email address defined in
Settings > Email > Admin Email.
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Settings
An explanation of the Settings module and how it works 

The Admin Tab Explained

The Admin tab is the first tab under Settings. The fields on this tab control KBPublisher's
configuration. Only administrators can change the settings on this tab.

You can reduce the number of fields displayed by typing key words into the Filter field, making
it easier to find the fields you want. Restore the display by removing any entries from this field.

Click Save to save your edits; click Set Defaults to restore the original values for all fields.

International

Language - Select the language for field labels and other onscreen texts for
your KBPublisher.

• 

Date & Time

â��Time zone - Select the time zone to use. If your team is distributed across many
time zones, the time zone you select may not be the one for the area where you live, but
rather the one where the majority of your team lives and works.

• 

Security / Privacy

Session expires (in minutes) - controls how long before the user is automatically
logged out when they are not actively using the system. If you wish to turn automatic
logout off, set this to 0. 

• 

Enable visual confirmation to login - controls whether a user has to pass a
CAPTCHA test, typing the test displayed in an image, in order to log in. The displayed
image looks like this:

• 

Enable visual confirmation to reset password - controls whether a user has to pass
a CAPTCHA test, as described above, in order to reset the account password.

• 
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Old password required to change password - Select to require the user to provide
their current password as well as the new password they want to change to.

• 

API

Enable API access - Select to allow users access to the KBPubliher API.• 
Secure API connection - Select to require a secure API connection (the URL starts
with https:// instead of http://).

• 

Look & Feel

Box width - Required. Set the width of the frame for the administrator's screen in
pixels, like 980px, or as a percentage of the user's screen, like 90%.

• 

Number of records per page - Set the number of records displayed per page when a
user first goes to that page. The user can temporarily change the setting while on the
page.

• 

Sort articles by - Specify the initial sort order for articles, which the user can change
temporarily when working with a list of articles. The options are:

Title (sorted alphabetically)♦ 
Date added (newest first)♦ 
Date added (oldest first)♦ 
Date modified (newest first)♦ 
Date modified (oldest first)♦ 

• 

Sort files by - Specify the initial sort order for files, which the user can change
temporarily when working with a list of files. The options are the same as for the
previous field.

• 

HTML Editor

HTML editor file directory - Required. Provide the location for images you use in
articles or files that you link to. KBPublisher uses this location when you perform
actions like insert a picture into an article.

• 

Scheduled Tasks

Send critical messages to admin - Select to send the administrator an email alert of
critical errors in scheduled tasks so the administrator can respond quickly. Define the
email address to receive these messages in the Email settings tab.

• 

Tags

â��Allow to create tags - Select to let users create custom tags when adding a record.
If this is not selected, users can only choose from among the existing tags.

• 

Article

Maximum number of revisions - Specify how many past versions of a document are
stored. If you set this to 5, then when the document is changed and saved the sixth time
and after, the oldest revision is deleted so only the five most recent versions are

• 
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retained. If you don't want to keep article history at all, set this to 0.
Autosave recovery information every - Specify in minutes how often KBPublisher
should automatically save an article a user is editing. To turn autosave off, set this to 0.

• 

Default category - If you select a category for this field, all new articles will by default
be part of that category. Select None to disable this option.

• 

Files

Files directory - Required. Set the location where files are uploaded to, in this server
path format.

• 

Max file size - Set the maximum file size, in kb, that users can upload (1024 kb = 1
mb). The maximum you can set depends on your php settings: see Handling file uploads.

• 

Allowed extensions - You can specify the file types that can be uploaded, separated by
commas, such as "txt,png,doc,docx". Note: if you enter anything in this field,
KBPublisher ignores any entry in the following field.

• 

Denied extensions - Specify types of files that cannot be uploaded, separated by
commas, such as "php,exe,asp,cfm".

• 

Extract raw text - Select to have KBPublisher try to extract the text from PDFs and
similar files so it can include the content of the files when the user does a search.

• 

XPDF installation path - XPDF extracts content from PDF files to make that content
searchable. If you have XPDF installed, provide the relative path to it in the form
"/user/bin/". To disable this option, enter "off". 

• 

Catdoc installation path - Catdoc extracts content from .doc files to make that
content searchable. If you have Catdoc installed, provide the relative path to it in the
form "/user/bin/". To disable this option, enter "off". Note: You can use either Catdoc or
Antiword (below). You don't have to use both.

• 

Antiword installation path - Antiword extracts content from .doc files to make that
content searchable. If you have Antiword installed, provide the relative path to it in the
form "/user/bin/". To disable this option, enter "off".

• 

Spy Directory missing files policy - Select from the options provided what the
auto-load directory files functionality should do when it finds a file listed in the database
that is no longer on the server.

• 

Default category - If you select a category for this field, all new files will by default be
part of that category. Select None to disable this option.

• 
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The Public Area Tab Explained

The Public Area tab is the second tab under the Settings menu. The settings here apply to
the public view -- that is, to what users see.

Only an administrator can change the settings on this page.  The page is divided into three
further tabs:

Common, for settings which are common to the whole knowledgebase• 
Articles, for settings which are specific to articles• 
Files, for settings which are specific to files.• 

The filter field at the top of the screen allows you to reduce the number of fields displayed. For
example, typing Titles into the filter field while on the Common tab, restricts the fields shown
to those in the Titles/Meta/Navigation section.

Common settings

The Titles/Meta/Navigation section controls how the browser displays the
knowledgebase.

1. 

Site keywords (meta) and site description (meta) contain keywords used by search
engines to identify your site.

• 

The header title is the text displayed in the header,• 
The navigation title is the home page in the navigation bar• 
Extra items in navigation show any extra links in the navigation bar.
Extra links in the navigation are added as the name of the link (text to be displayed),
followed by a space, followed by a pipe (|) symbol, then another space, then the address.
For example, to add a link to your home page you would use 'Home |
http://mydomain.com'. You can add more than one extra link by adding a double pipe
(||), surrounded by spaces, between each link. e.g. 'Home | http://mydomain.com ||
Support | http://mydomain.com/support.

• 
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You can show or hide the article title in the breadcrumb trail at the top of the screen by
changing Display entry title in navigation

• 

You can choose whether or not users can see access downloaded files by setting the
Display 'Downloads' link in menu

• 

You can choose whether or not users can view the glossary by setting the Display
'Glossary' link in menu

• 

The search engine friendly URL controls what you type into the address line when
you want to jump direct to an item in the knowledgebase.

• 

The Security/Privacy/Registering section controls who can log on and how they do it.2. 

Access for registered only means that only people who are registered users can view
the knowledgebase. If this
is set then even if a user ends up on your site they will not be able to read articles
unless they are registered.

• 

Allow registration means that if a user does end up on your site and wants to view the
knowledgebase, they can request and (maybe) get access.
i.e. The user comes to the knowledgebase site, gets a message that he has to register to
use the site, and gets a registration form to register.

• 

If Allow registration is set, then two things can happen. If Approval required for
registration is not checked, then the user is automatically assigned a user ID and
access.
If Approval required for registration is set, then they cannot get access until the
administrator approves their request.

• 

When users register they take on the default privilege and default role assigned
here.

• 
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Enable visual confirmation to register means the user has to type in a confirmation
code before they can register. This is to stop scamming.

• 

Login policy determines whether a user gets a login option on the public view screen,
whether they don't get the login option but can still login (if they know the link to the
login page), or whether they cannot login at all.

• 

When a user has not used the public area for the number of minutes specified in the
Session expires in field they will be logged off. If you wish to turn automatic logout
off, set this value to 0.

• 

The private policy setting controls whether content that is locked because it is private
is displayed in the menu with a locked symbol, or whether it is simply not visible at all.
When this is set to Do not display entries then the user only sees items he can access.
When it is set to Display entries as 'locked' sign, then the user can see the entries
title but he cannot read them.

• 

Look and feel3. 

You can use the default knowledgebase template, or you can specify your own in
Template page to load. Your template can be pretty much any HTML, with a few extra
commands to display the content and RSS feeds. This article explains more about the
template.

• 

The View format allows you to set your knowledgebase up with a left menu or without.
The sample screen in section 1, above, shows a knowledgebase with the left menu set.

• 

The left menu type can be a standard menu tree, or it can be a follow-on menu that
allows users to click on one article after another to read them.

• 

If you choose not to display the header then the header title (specified in section 1,
above) is not be displayed.

Setting up the look and feel is covered in more detail in the article that explains how to
change the way articles are displayed.

• 

The Feedback section controls the Ask a Question area of your knowledgebase .4. 

You can set whether users can contact you using the Feedback facility through Allow
contact us. You can set this so that all users can contact you, only registered users can
contact you, or no users can.

• 

If enable visual confirmation for contact form is set then the user must type in a
visual code before they can add any feedback

• 

Unchecking enable quick response turns off the automatiac searching and turns the
form into a static feedback form. i.e. users type their message into the form and email it
to the supervisor, but KBPublisher doesn't do the search.

• 

Allow attachments says whether users can attach documents to their mail. The value
here is the number of files that can be attached. When this is set to 0, attachments
cannot be included.

• 
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Allowed extensions controls the type of files that can be attached.• 
Send attachments with e-mail must be set if a user is allowed to send attachments in
the Feedback form.

• 

The News section controls whether you have a news section, and if you do, how it is
displayed.

5. 

Enable news module turns news on or off. If this box is checked news items can be
added and users can see them. If it is not, there is no news functionality.

• 

If you select display news link in menu then there a News menu option will be
included in the knowledgebase main menu.

• 

You can control how many news items are displayed on the Public Area home page with
the number of news items on index page. You can display a maximum of five news
items, the last five items added. Set this to 0 to hide news items.

• 

The Search area controls search options6. 

You can set define whether the initial search searches the whole knowledges, just in
articles or just in files by setting the By default search in field. Note that this is can
always be overridden by the user in the advanced search.

• 

If you want users to see auto-suggestions of words as they start to type their word into
the search field, set search suggest. These searches are based on search results of
other users.

• 

Whether or not users can subscribe to articles is controlled by the Subscription
section.

7. 

Allow news subscription allows users to subscribe to the news section and get a daily
email when news is added

• 

Allow item subscription allows users to subscribe to be notified when articles and/or
files are changed or added.

• 

Lastly, the RSS settings control whether the knowledgebase is available as an RSS
feed and how the feed is set up.

8. 
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Channel Description is the description included in the tag in the RSS feed.• 

Articles

Look and feel (settings) control what the user sees and how he sees it.9. 

Articles can be sorted by alphabetical order, the date items were added or modified,
and by popularity.

• 

The number of articles displayed on the page is controlled by Default number of
articles.

• 

Whether or not people can see the latest articles that have been added is controlled by
Recent articles. If it is set to 0, recent articles are not shown,
otherwise the number of recent articles displayed is the number set here.

• 

Likewise whether or not people can see the most popular articles is set under Most
viewed articles.

• 

Whether or not people can see the featured articles is controlled by Featured articles.
If it is set to 0, featured articles are not shown,
otherwise the number of recent articles displayed is the number set here.

• 

Others in this category controls whether or not the 'Others in this category'
sub-heading is displayed at the bottom of the screen, and how many items are displayed
if it is

• 

Display prev/next navigation controls whether the user sees links to the next article
and previous article at the bottom of the screen.

• 

Category cols defines how how many columns the categories are displayed in on the
page in public view. If this is set to 0, no categories are displayed.

• 

You can add text to the front of an article heading using the Article title prefix
pattern. For example, if your article is named Keeping Pets, you can use the article title
prefix pattern to make this: Question: Keeping Pets. Even better, if you use types in
your knowledgebase, you can customize the article prefix to each type. Suppose, for
example, you have two types of articles. One is Facts, the other is General info. If you
wish you can change the title to include the type. e.g. Fact: Climate change is
happening and General info: What are greenhouse gases?.
You can include the article number as part of the article title prefix as well. e.g. Q: What

• 
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can I do to help?
If you choose to include the article number in an article title prefix, you can also say
how many digits the number will have by specifying an entry ID padding number. For
exaple, if you had 100 questions and chose an article title prefix of 'Q', by default they
would be numbered Q1...Q100.  If you would prefer it to be Q001: .. Q100 set the entry
ID padding to 3.

• 

You can show or hide files (Download area) using the Display 'files' link. You might
use this if you plan on creating articles only, and not uploading files to the
knowledgebase.

• 

You can show or hide the glossary using the Display 'glossary' link• 

The Comments section controls article comments.10. 

You can set whether comments are allowed and who can make comments through
Allow add comments. This can be set to all users, only registered users, or no users.

• 

Likewise, you can set it so that anyone who adds a comment must type a visual
confirmation code before they can send it.

• 

Whether or not comments are published immediately, or must be approved first is
controlled by the Comment approval policy.

• 

You can set the number of comments displayed per page to 10, 20, 30, 40 or 50.• 
And you can say whether to display comments on the article page, or set it so that
you must click on a comments link to read the comments.

• 

The Rating section controls user ratings and feedback for negative ratings.11. 

Allow rate articles lets the user rate articles in your knowledgebase. Ratings can be
text--helpful/not helpful--or you can use a star system where the user rates the article
out of five stars.

• 

You can also turn on allow comments, which brings up a feedback box when a user
rates an article so they can provide feedback on why they rated it the way they did.

• 

The way the article is displayed on the preview screen is defined in the Article preview
format section.

12. 

The number of characters displayed in the preview is controlled by the Article
Character Limit

• 

Whether the last date the article was updated is shown is controlled by Display
updated date

• 

You can also specify whether to display the rating, number of comments and
number of views.

• 
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This is where you define what to show the Detailed Article Block.

Note that if you are logged in and have edit rights, you will also see the edit options:
edit, quick edit and category listing. Plus, some of the information in this block is
controlled by other knowledgebase settings, particularly comments and subscriptions
(see points 6 and 9 above).

13. 

Display article block displays the article ID and when the article was last updated.• 
Display private block shows whether the article is public or private. If an article is
private, a user can hover his/her mouse over the key graphic to see which roles have
access.

• 

Display author block displays the date an article was created and the name of the
author. If the article has been updated since, it also displays the name of the person
who last updated it and when that was. The format of the author/updater's name is
controlled by the user format for author block.

• 

You can also choose to include PDF, print and send to friend links, and whether or
not to display the number times this article has been viewed.

• 

Files

Whether or not users can see uploaded files is controlled by the Display Files link on the
Knowledgebase tab, but if they can see files, then the Files tab under the Settings menu
controls what they see and how they see it.
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The Look & Feel section controls how files are displayed.14. 

How many files are displayed by default (number of entries per page).• 
Files can be sorted (sort files by) by alphabetical order, date files were added or
modified and popularity.

• 

Whether or not people can see a list of the latest files that have been added. This is
controlled by recently posted files. If this is set to 0, recent files are not shown,
otherwise the number of recent files displayed is the number set here.

• 

Likewise whether or not people can see the most popular files is set under most
downloaded files.

• 

Category columns defines the number of sub-categories displayed in the drop-down
category lists. If this is set to one, then only the top-level categories are displayed. If it
is set to 0, none are displayed.

• 

File preview format controls whether users see how many times the file has been
downloaded.

15. 
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The Email Tab Explained

The Email tab under the Settings controls who receives administration emails, and how the
email is set up.

The Support Email sections allows you to define system emails.1. 

Support mailer is the special email header• 
From Email/Support Email is the email address, or addresses, where the
administration emails are sent. Feedback emails are sent to this address. You can enter
more than one email address. Separate each email address with a comma.

• 

From Name/Support Name is the name the user sees when they receive an email
from KBPublisher. For example, if you reply to a feedback question, this is the name
that will be shown in the reply field

• 

The No Reply Email is the email address that sends automated information such as
subscription alerts, password enquiries and so on

• 

The person or persons assigned in the Admin Email receive system notifications,
warning messages and other messages that impact the running of your knowledgebase.

• 

The Email settings are where you set up the mail system.2. 

The mailer is the system you are using to send the emails. This defaults to the PHP
mail() function unless you change it.

• 

Sendmail path defines the location of sendmail files. Sendmail is a UNIX based mail
application. You would not normally change this.

• 

The other items here are specific to the SMTP mailer, and should only be filled in if you
have specified SMTP as the mailer.

• 

The Mass mailer controls how many emails, such as subscriptions, are sent by the
background task scheduling system.  This is done to limit the impact to users..

3. 

Email limit per hour controls how many emails are sent per hour.• 
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The Plugins tab explained

The Plugins screen explained

This screen allows controls add-on software (plugins) that you can purchase to enhance
KBPublisher functiontionality.

The filter field lets you filter on files on this screen. This is a standard field. We use it on
all of the Settings screens as some of them are long. Here, you probably won't use the
filter field at all, at least not until we have a few more plugins.

1. 

For release 4.0, the only plugin available is the file export facility, which allows you to
create PDF and HTML documents from your articles.

2. 

Plug-ins are purchased separately to KBPublisher itself. You need a plugin key for
them to work. You can download this from your Client Area at KBPublisher.

3. 

If you have a licensed version of KBPublisher, then you must have a valid key for the
plugin to work.

• 

If you are running the demo version, type demo here. We let you try it with the demo to
see how the system works. Note that demo documents have a 'trial' watermark on each
page.

• 

To produce PDFs and HTML pages, you need to install a program called HTMLDOC.
The HTMLDOC installation path lists where this program is installed. If you're not
sure of the format of the path, see How can I find my full server path?

If you you're not using this plugin, set this to off. 

4. 

Set the default text font for the text in the document by choosing a font face from the
drop-down list.

5. 

Set the default font size by typing the size, in points.6. 

Allow category exporting allows users to generate PDFs from the Public Area.7. 

Save obviously saves your changes, while Set Defaults restores everything on this
screen back to the default values that were shipped with KBPublisher.

8. 

----------------------------------------------------------------------
This functionality works in version 4.0 and above

The Plugins tab explained 280

http://www.kbpublisher.com/images/image/manual/Settings/PluginsTab_Explained_withNumbers_45.gif


The License tab explained

The license tab provides details of your KBPublisher customer number, the type of license you
purchased and when you purchased it.

When you purchase from KBPublisher your license key and software downloads are made
available under the My Licenses tab in the Client Area on the KBPublisher site.  After you
install KBPublisher, copy the license key provided in the Client Area here.
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Search engine friendly URLs

What is a search engine friendly URL?

KBPublisher records are stored in a database. When you wish to read an article, KBPublisher
sends a request to the database to get this record for you. This request is usually sent as a
query string, and in its native form it looks something like:

http://yoursitename.com/kb/index.php?view=entry&entryID=90.

This works well to get the record back, but most search engines, Google excepted, will not
index pages with question marks (?) or ampersands (&) in the name.

To get around this, we use a search engine friendly URL. This converts the query to
something more like:

1. http://yoursitename.com/kb/entry/90
2. http://yoursitename.com/kb/Search-engine-friendly-URLs_90.html

which contains only characters that search engines recognize, and therefore will the record
will be found by the search engine.

Not only that, when sending a link to someone else, it makes a lot more sense, and is a lot less
error prone, to send a link http://yoursitename.com/kb/entry/90 than to send
http://yoursitename/kb/index.php?view=entry&entryID=90.

How do I set up a search engine friendly URL?

Log onto KBPublisher as an administrator• 
Choose the Settings menu• 
Click on the Public Area -> Common tab• 
Go to the Titles / Meta section and choose an appropriate option from the Search
Engine Friendly URL drop down list.

• 

You have four options:

Automatic uses the default set up when KBPublisher was installed♦ 
Type 1: kb/entry/[article_id] gives the friendly URL -
http://yoursitename.com/kb/entry/90

♦ 

Type 2: kb/entry/[article_title]_[article_id].html gives the friendly URL -
http://yoursitename.com/kb/Search-engine-friendly-URLs_90.html

♦ 

Do not use search engine friendly URL means exactly what it says.
Your link to the article mentioned above would be
http://yoursitename.com/kb/index.php?view=entry&entryID=90

♦ 

• 

Note:

"Search Engine Friendly URL" works on Apache web server with mod_rewrite
enabled.

• 

On IIS you can set it up with IIS ModRewrite or similar tools.  • 
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Look and feel

Change the design 

Customizing article display options

You can customize how and where articles are displayed in the Settings > Public Area >
Articles tab.

Look & Feel

In this area you can specify

Number of articles per page - Set how many articles appear per page. If there are
more articles than the number you set, KBPublisher provides navigation so the reader
can move from page to page of the display.

• 

Sort articles by - Choose an option for the default order by which articles are sorted.• 
Recent articles - Set how many "recent articles" appear. By default this field is set to
5. Set the field to 0 to remove this feature.

• 

Most viewed articles -  Set how many "most viewed articles" appear. By default this
field is set to 5. Set the field to 0 to remove this feature.

• 

Featured articles -  Set how many "featured articles" appear. By default this field is set
to 5. Set the field to 0 to remove this feature.

• 

Featured articles in a category -  Set how many "featured articles" appear for each
category. Set the field to 0 to remove this feature.

• 

Display 'Also listed in' - Set to yes to show a list of other categories in which the
article is listed. Set to no to disable this feature.

• 

Others in this category - Set how many links to other articles in this article's category
to display when the user is reading the article. Set to "None" to disable the feature.

• 

Display Prev / Next navigation - Set whether and in what conditions you want to
display previous / next navigation for articles in this article's category.

• 

Category columns - Set how many columns to use to display the articles in a category.• 
Article ID zero padding - If you use an article title prefix (see the next field) you can
set here the number of zeros with which to pad a short ID. If you set the padding

• 
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number to 3, for example, and you have and article with ID 1000  ID 1 will show up as
0001 to provide a display that is easier to read.
Article title prefix pattern - You can opt to prefix each article title with a pattern that
can include the article's ID. For example, presume your article with ID 1 has the title
"Welcome to our knowledgebase":

'Q{$entry_id}:' would cause the article to appear in the list as "Q1: Welcome to
our knowledgebase".

♦ 

'Q{$entry_id}:' | Q{$entry_id} - {$entry_type}: ' would behave as above if the
article does not have an entry type. If its entry type were "intro", for example, it
would appear in the list as "Q1 - intro: Welcome to our knowledgebase".

♦ 

• 

Display tags - Check this check box to have the article's tags display when the user is
reading the article.

• 

Comments

In this section you can control whether and how comments display.

Allow add comments - Select whether to prevent comments, to let only registered
users add comments, or let all readers add comments. If you prevent comments in this
field, the rest of the fields in this section are ignored.

• 

Enable visual confirmation - Specify whether to use a CAPTCHA confirmation to
prevent robotic spam comments. You can require no CAPTCHA confirmation,
confirmation for non-registered users, or confirmation for all users adding comments.

• 

Comment approval policy - Specify whether comments must be approved before they
are added to the knowledgebase. YOu can accept all comments without approval,
require approval only for non-registered users' comments, or require approval of all
comments.

• 

Comment subscription - Specify whether registered users can request a notice to be
sent when a comment is added to a particular article.

• 

Number of comments per page - Select the number of comments to appear per page.
If the number of comments is larger than the number you specify here, navigation
allows readers to move through the pages of comments.

• 

Display comments on the article page - Check this check box to have comments
appear on the same page as the article. If this option is not selected, a link appears to a
separate comments page.

• 

Signature format for commenter - Specify how the commenter's signature appears
at the end of the comment. Options include [first_name], [last_name], [middle_name],
[short_first_name], [short_last_name], [short_middle_name], [username], [email],
[phone], [user_id]. You can use multiple tags to construct a signature, such as
"[first_name] - ID [user_id]".

• 

Rating

You can let users rate articles in your knowledgebase with these settings:

Allow rate articles - Check this check box to let users rate articles.• 
Allow comments - Check this check box to let users add a brief text comment to their
rating.

• 

Rating type - Set the type of rating display as stars or text.• 

Send to friend
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In this section specify whether and how users can share content with friends.

Allow 'Send to friend' option - You can prevent users from sharing links to comments
and articles, let only registered users share links, or let everyone share links.

• 

Allow attach article - Check this check box to let the user share a copy of the article,
not just a link to it in the knowledgebase.

• 

Enable visual confirmation -  Specify whether to use a CAPTCHA confirmation to
prevent robotic spamaction. You can require no CAPTCHA confirmation, confirmation
for non-registered users, or confirmation for all users.

• 

Article preview format

In this section set preview options for an article. This is what the user sees before clicking to
view the article itself.

Article character limit - Set how many text characters, starting from the start of the
first sentence in the article, display in the preview. Set this to 0 to display no extract
from the article.

• 

Display updated date - Select this option to display when the article was most recently
updated.

• 

Display rating - Select this option to display the article's rating.• 
Display number of comments - Select this option to display the number of comments
this article has.

• 

Display number of views - Select this option to display the number of views this
article has had.

• 

Detailed article block

In this section set the information that appears when the user opens the article.

Block position - Set whether the article information block, with information such as
the article's ID and when it was last updated, appears to the right or at the bottom of
the article.

• 

Display Article block - Select this option to display the article information block.• 
Display Private block - Select this option to display private, role-protected
information.

• 

Display author block - Select this option to display author information. Complete the
following field to format the information.

• 

Use format for author block - Format author information. For example, to display the
author's informal first name and last name, set this field to "[short_first_name]
[last_name]". Tags available include:  [first_name], [last_name], [middle_name],
[short_first_name], [short_last_name], [short_middle_name], [username], [email],
[phone], [id], [company].

• 

Display 'Print' link - Select this option to display an icon the user can click to print the
article.

• 

Display 'Export to PDF' link - Select this option to display an icon the user can click
to export the article as a PDF file.

• 

Print article block in PDF - Select this option to include the block of article
information in the exported PDF.

• 

Display number of views - Select this option to display the number of views the article
has had.

• 

Display 'Share' link - Select this option to allow users to share a link to this article on
social networking sites. If you select this option, complete the following field.

• 
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Social networking sites - Provide links to any social networking sites on which you
want users to be able to share links to knowledgebase content. Use a new line for each
site. The format for each line is: NAME OF NETWORK | URL with url of article | ICON
FOR SOCIAL NETWORK. For Twitter, for example, the entry would be: Twitter |
http://twitter.com/intent/tweet?url=[url] | icons/twitter.png

• 

Saving your settings

Click Save to save your settings. Click Set Defaults to remove any custom settings and
restore system defaults.
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Customizing Public Area

KBPublisher can be extensively customized and you can get some spectacular results if you
want to design your own site.

The default format of the KBPublisher Public Area is:

The standard header is controlled by the Header field.
Settings -> Public Area -> Common -> Header

1. 

You can:

Include the header by checking the Header field♦ 
Remove the Header by un-checking this field♦ 

If no header is assigned, a header is controlled by the Header title field,
Settings -> Public Area -> Common -> Header title

Likewise, the left menu is standard. The menu is controlled by the View Format field
which is under Look & Feel,
Settings -> Public Area -> Common -> View Format

2. 

The menu choices are either Browseable or Left Menu. 

Directly under the header are menu options and a breadcrumb trail.3. 

The menu options, which are extra links which can be included in the menu, are
displayed first. For example, you might want to include a "Home" link if the
knowledgebase is part of a larger site.

The menus are controlled by the Extra links in navigation field
Settings -> Public Area -> Common -> Extra items in navigation 

To include other links:
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Add the title to be displayed on the page followed by a single pipe (|),
then add the clickable URL

♦ 

Additional links can be added separated by a double pipe (||)♦ 
Example: Home | http://www.yourhomepage.com || Support|
http://www.yourhomepage.com/support.html
would display the following two links at the top of the page: "Home / Support".

The breadcrumb trail is displayed after any extra links. It reflects the article you
are currently viewing in the knowledgebase.

The News area of this page is optional.
Settings -> Public Area -> Common -> News

4. 

Enable News Module controls whether or not news displays not on the
Public Area home page

♦ 

Number of news on index page sets how many news items are
displayed

♦ 

Display 'News' link in menu determines whether or not there is a menu
option for news

♦ 

This area will changed depending on "View Format". The main page will display
knowledgebase categories, the most recent and the most popular articles.
Public Area -> Articles -> Recent articles, Public Area -> Articles -> Most viewed
articles and Public Area -> Articles -> Category columns settings

5. 
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Change KBPublisher Look and Feel (design integration)

You can brand the knowledgebase so that it matches the rest of your website. For example, you
can include your company logo and standard buttons on each knowledgebase page.

To set up custom template:

Log on to the knowledgebase• 
Go the Admin Area• 
Click on the Settings menu and choose the Public Area -> Common tab• 
Ð¡lick [...] button in the Page Template field which will open new window with page
settings

• 

Add a template to Header and Footer section respectively• 
Add custom Styles in the appropriate section • 
Click Save to save the changes• 
Go to Public Area to see/test your custome template settings• 

Notes:

You must be an administrator to do this• 

----------------------------------------------------------------------
This functionality works in version 5.0 and above
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[v4.5 and below] Change KBPublisher Look and Feel

The template page

If you want to brand the knowledgebase so that it matches the rest of your website. For
example, you can include your company logo and standard buttons on each knowledgebase
page.

To create and use custom template:

Create an HTML page based on this example. Remember that you can add as much as
you like around the various html tags, but you must include everything in the example
file.

• 

Upload the newly created page onto your server• 
Log on to the knowledgebase• 
Go the Admin area• 
Click on the Settings menu and choose the Public Area -> Common tab• 
In the Look & feel (format/template/style) section, change the Template Page To
Load to the full server path to the template
(e.g. /usr/www/html/ ..../your_template.html).

• 

Notes:

You must be an administrator to do this• 
If you prefer, you can set the Template Page to load field to the URL, i.e.
http://www.your_domain.com/your_template.html, rather than to the full server path,
i.e. /usr/www/html/ ..../your_template.html, if your PHP installation allows it. (On some
PHP installations this option is not allowed).

• 

Using the URL for the template path (http://www.your_domain.com/your_template.html)
cause extra lookups, which will may affect the performance a litte, hence we
recommend that you use the server path name if you can.

• 

If you need to execute php in your template, use the full URL for the template path.• 

Changing associated CSS

When you modify KBPublisher to fit your site design, you will probably also need to change
some css styles as well.

All cascading style sheets used in KB Publisher are in the kbp_directory/client/skin/ directory,
where kbp_directory is the name the directory under which you installed KBPublisher.  Most
styles for the public area are defined in kbp_directory/client/skin/common.css.

You are welcome to change these or to add your own. We do recommend, however, that you
create a new style sheet and include a link to the new style sheet in your custom template to
overwrite existing KBPublisher styles, rather than change common.css.
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User settings

Default user settings 

User defaults

The knowledgebase administrator sets user defaults when they create the knowledgebase, and
can update them at any time.

Security

User setup is part of the security section in the Settings menu:

From the Settings menu choose the Public Area -> Common tab• 
Go to the Security/Privacy/Registering section• 

Here you can:

Force users to register before they access the knowledgebase• 
Determine whether the registration must be approved by a moderator• 
Determine whether users must complete a visual confirmation code before their
registration is accepted

• 

Set the default privilege and role new registered users are created with• 
Show or hide articles users do not have access to• 
Set how long before KBPublisher logs an inactive user out.• 
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Set default user privileges

New users can be created two ways. They can be set up by the knowledgebase administrator,
or users can register themselves.

By default, when users register KBPublisher creates them with no privileges. You can change
this so that new users are created with a specific default privilege by:

From the Settings menu choose the Public Area tab• 
Go to the Security / Privacy / Registering section• 
Select the appropriate Privilege for new registered users from the drop-down list of
privileges

• 

Click Save.• 

All new users who register after this are created with the new default privilege.

You must have administrator access to change the settings.
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Set Default User Roles

New users can be created two ways. They can be set up by the knowledgebase administrator,
or users can register themselves.

By default, KBPublisher creates registered users with no designated role. You can change this
so that new users are created with a specific role by:

First, ensure that the role exists. If it doesn't, create it first• 
From the Settings menu choose the Public Area -> Common tab• 
Go to the Security / Privacy / Registering section• 
Select the appropriate Role for new registered users from the drop-down list of roles• 
Click Save.• 

All users who register after this are created with the new default role.
You must have administrator access to change the settings.
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Force users to log on

To force users to log on to even see the knowledgebase, let alone read articles:

From the Settings menu choose the Public Area -> Common tab• 
Go to the Security/Privacy/Registering section• 
Check access for registered users only.• 

To force users to log on before they can read specific sections of the knowledgebase:

From the Articles menu choose the Categories tab• 
Check each category you wish to force users to log on for• 
Choose set private from actions with selected at the bottom of the list of categories• 
This brings up privacy options for you to select from.  Check Read but do not select any
roles from the list

• 

To force users to log on before they can read specific articles in the knowledgebase:

From the Articles menu choose the Articles tab• 
Check each article you wish to force users to log on for• 
Choose set private from the actions with selected at the bottom of the list of articles• 
Check read but do not select any roles from the list• 

You can also set private read while you are creating or editing the category or article.

What is the difference between forcing a user to register and forcing them to log on?

When you force a user to register (access for registered users only) they must log on to the
knowledgebase before they can read articles, whether the articles are marked as private or
not.

When a user is not forced to register, they can always access the knowledgebase home page,
even if they are not registered. They can read articles that are not marked as private, even if
they do not log on. If an article is marked as private, however, then the user must register and
log on in order to read that specific article.
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Allow Users to Register

To set up your knowledgebase so that users register themselves:

From the Settings menu choose the Public Area -> Common tab• 
Go to the Security/Privacy/Registering section• 
Check Allow registration• 
Click Save to save the changes.• 

When a user comes to the site, they will see a Register option in the top-right-hand corner of
the screen (near login). They can click on Register and will be presented with a screen of
user details to fill in. What happens once they fill in the details on that screen depends on other
settings in the Security/Privacy/Registering section.

If you have specified that the user must provide visual confirmation before they can
register, the user will also get a code to type in as part of the registration process

• 

If you checked approval required for registration then the registration request is
sent to the administrator, who must approve it before the user can log in. If you did not
check this option, the user can log in immediately (or at least, as soon as they get the
automated confirmation message)

• 

If you specified a default privilege for new users, the user will be set up with that
privilege

• 

If you specified a default role for new users, the user will be set up with that role.• 
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Allow users to rate articles

You can set up KBPublisher so that users can rate articles.

From the Settings menu choose the Public Area -> Common tab• 
Check allow rate articles• 
If you want the user to add a comment when they give a negative rating, check
Allow Comments

• 

Click Save.• 

Even when users can rate articles, the rating does not have to be displayed on screen.

To display ratings on screen:

From the Settings menu choose the Public Area -> Articles tab• 
Go to the Article Preview format section• 
Check display rating• 
Click Save.• 
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Allow Users to Post Comments

You can set up KBPublisher so that user comments appear immediately, or so that they must
be approved first, or you can turn comment functionality off altogether. You may also identify
whether or not only registered users can add comments.

From the Settings menu choose the Public Area -> Articles tab• 
Go to the Comments section• 
Specify who can add comments via allow add comments• 
Specify whether the comments must approved before they appear via the comment
approval policy

• 

Specify whether a user must type in a visual confirmation code before they can send the
comment via enable visual confirmation to add comment

• 

Click Save.• 

You must have administrator access to change the settings.
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Email settings

Setting up emails and communication 

Letter Templates

Preformatted letters

The Letter Template tab is available from the Settings -> Email menu. It controls the
format of emails that are sent and received by the knowledgebase.

Letters with blue arrows are mails that are received by the knowledgebase administrator.
Examples of these include 'ask a question' emails or user registrations. Letters with red arrows
are mails that are sent to users. Examples of these include registration confirmation and
password reminders.

KBPublisher provides a set number of templates. You cannot add new ones. You can, however,
edit existing templates.

Editing letter templates

When you edit a letter template you are presented with an email form that you can modify to
suit your own requirements.
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You can include any text you wish.

You can include template fields anywhere in the email or in the header:

The actual fields you can include depend on the letter, but some common ones are:

[support_name] -- this is the name defined in the Support Name field on the Email tab• 
[support_email] -- this is the email defined in the Support Email field on the Email tab• 
[support_mailer] -- this is the name defined in the Support Mailer field on the Email
tab

• 

[noreply_email] -- the standard "Do not reply to this email" from address• 
[name] -- the name of the user to whom the mail is being sent or who it is from• 
[username] -- that person's user name• 
[first_name] -- their first name• 
[last_name] -- their surname• 
[middle_name] -- their middle name• 
[email] -- their email address• 
[link] -- a link to the page that this email is about.• 

The field name must be enclosed by square brackets.

Some email templates also have a field called to Category Supervisor. This field is shown
when the letter relates to a specific article. If you check to Category Supervisor, and the
category has a assigned supervisor, then the letter is emailed to the supervisor rather than to
the Support Mailer address.
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Set Who Receives Emails

System emails

You can designate a user, or users, to receive system emails.

From the Settings menu choose the Email -> Letter Template tab.• 
Type the email of the person who is to receive user communications into the From
E-mail / Support E-mail field. You can input more than one email. Separate each
email address with a comma. Everyone specified here will receive system emails.

• 

Type an appropriate name into the From Name / Support Name field. This is the
name the user sees in their 'from' field when they receive an email from KBPublisher.

• 

Add an email address for system-generated messages to users in the No reply email
field.

• 

Add the name of the person who will receive notification of all system errors,
notifications and warnings to the Admin Email field. This field also accepts multiple
email addresses. If you use multiple emails, separate each one with a comma.

• 

Click Save.• 

Category emails

You can also specify a user to receive notifications about articles/files/comments in specific
categories. This is used when articles or comments need to be approved.
The 5 letters that can be sent to a category supervisor are:

Approve article (to approver)• 
Approve file (to approver)• 
Approve comment (to approver)• 
New rating comment• 
Scheduled entry• 

First, you need to assign a person to receive the emails:

From the Articles or Files menu choose the Categories tab• 
Edit the category• 
Click on the add new Supervisor icon• 
Assign a user from the list of users• 
OK to save the assignment.• 

After this, you need to tell the system that the supervisor should receive the emails.

From the Settings menu choose the Letter Template tab.• 
Edit the letter that is to go to the supervisor• 
Check to Category Supervisor• 
OK to save.• 

Feedback supervisor emails

You can also determine who receives the emails when the user requests feedback through the
Ask a Question tab.

This is controlled by the feedback subjects list.
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From the Tools menu choose the Lists tab• 
Click on Feedback Subjects• 
Edit the subject for which you wish to change the email to be sent• 
Click on the add new Supervisor icon• 
Click on Assign for the person you wish to receive emails. You may assign more than
one person.  Click assign for each.  

• 

Close the assign user pop-up by clicking on the 'X' in the top right corner.• 
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Change text in emails

To change the text in emails sent from, or returned to, KBPublisher:

From the Settings menu choose the Email -> Letter Template tab• 
Choose the email you wish to change• 
Click on the edit icon in the Action column• 
Make the change you require. See E-mail Letter templates for an explanation of fields.• 
Click Save to save your changes.• 
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Logs
The Logs menu 

Track search queries

To track what searches users have used to find information in the knowledgebase:

Log in to the Admin Area• 
Click on the Logs menu• 
Click on the Search tab• 

The information displayed on this screen shows:

When the search was done• 
The string the user typed in • 
Categories they searched in• 
How many results were returned.• 

You can filter results on

Area of knowledgebase• 
How recently searches were made• 
Whether the search was successful or not• 
Or you can search on a specific search string.• 

Note: You must have administrator privileges to see log details.

----------------------------------------------------------------------
This functionality works in version 4.0 and above
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Track emails

To track what emails have been sent, and whether they succeeded or failed:

Log in to the Admin Area• 
Click on the Logs menu• 
Click on the Mail Pool tab• 

The information displayed on this screen shows:

Date and time the mail was created • 
Date and time it was sent (or tried to be sent) • 
Type of mail it was• 
How many times the system tried to send the mail • 
Whether or not the send was successful• 
The full log details. These are the details summarized on the mail pool tab, plus the
contents of the mail that was sent/tried to be sent. 

• 

Note: You must have administrator privileges to see mail log details.

----------------------------------------------------------------------
This functionality works in version 4.0 and above
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Track user logins

To track which users have logged in, and any bad logins:

Log in to the Admin Area• 
Click on the Logs menu• 
Click on the Logins tab• 

The information displayed on this screen shows:

Date and time user last logged in• 
User ID and username• 
IP address they logged in from• 
Type of login. Login types can be 'local', which is a standard login, 'remote', which is
when the user logs in using remote authentication, and 'login as other user', which is
when someone with access logs in as another user to test changes they have made

• 

Whether or not the login was successful• 
The full log details. If the login was successful, the full log details are pretty that
summarized on the logins tab. If the login was not successful, the full log details add
extra information about why the login failed.

• 

Note: You must have administrator privileges to see login details.

Remote authentication logins

For remote authentication every last login is logged to a file called last_remote_login.log in the
KBPublisher cache directory ($conf['cache_dir'] in file kb/admin/config.inc.php).
For example: /home/username/kb_cache/last_remote_login.log.

----------------------------------------------------------------------
This functionality works in version 3.5 and above
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Track scheduled tasks

To track whether a scheduled task has happened as expected, what the scheduled task did, and
whether there were any errors:

Log in to the Admin Area• 
Click on the Logs menu• 
Click on the Scheduled Tasks tab• 

The information displayed on this screen shows:

The scheduled task -- frequently, hourly, daily, monthly and weekly -- in the range
column

• 

The time it was last executed• 
Whether or not the task had errored (is error)• 
A link to the output of the most recent scheduled task of this type. Click on view to see
full details

• 

A link to all stored logs for tasks of this type (action). Click on the curved arrow in the
Action column to bring up a full list of logs for this scheduled task.

• 

Note: You must have administrator privileges to see the log details.

----------------------------------------------------------------------
This functionality works in version 3.5 and above
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Changes for release 5.0

Mobile View

Mobile View is specially optimized working with KBPublisher on your mobile devices -
smartphone or tablet. All news and articles are shown as a list to simplify access. Also you can
easily switch view mode from mobile version to full view. Mobile View is enabled for Public
Area only.

Some screenshots below.

The KBPublisher home page has two banners for navigation and to manage your
account: News and Recent Articles.

Main menu opens by clicking on first button. You can choose any module or return to home
page.
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Settings opens by clicking on second button. You can switch to the full view or go to your
account.

You can view articles within a category via Browse by category
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----------------------------------------------------------------------
This functionality works in version 5.0 and above
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Change KBPublisher Look and Feel (design integration)

You can brand the knowledgebase so that it matches the rest of your website. For example, you
can include your company logo and standard buttons on each knowledgebase page.

To set up custom template:

Log on to the knowledgebase• 
Go the Admin Area• 
Click on the Settings menu and choose the Public Area -> Common tab• 
Ð¡lick [...] button in the Page Template field which will open new window with page
settings

• 

Add a template to Header and Footer section respectively• 
Add custom Styles in the appropriate section • 
Click Save to save the changes• 
Go to Public Area to see/test your custome template settings• 

Notes:

You must be an administrator to do this• 

----------------------------------------------------------------------
This functionality works in version 5.0 and above
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Tags, Labels

What are Tags?

Tagging is another non-hierarchical way to group related articles together and to quickly tell
readers what they are reading about. Tag keywords and phrases so readers can easily find
articles related to specific topics.

Tags are similar to categories, but are more specific. The use of tags is optional.
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Tagging Content

Tagging an article, news, or file?

It's easy! When you create or update an article or a file, you can assign and/or add new tags to
it using the Meta Keywords/Tags field.

Click on the Add a tag link below the text editor.

You can add tags one at a time by hitting the Enter after typing each tag. Or you can add
multiple tags at a time by separating each with a space as you type. You can join 2 or more
words together in one tag by enclosing them in quotation marks.

To select a tag from your existing list (tags previously used in KBPublisher) click Choose from
your tags and select the tags you want to use.

You can select more tags, or all tags, by clicking on Get more tags or Get all tags links
respectively.

Note: Changes are not saved until you save an article.
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Bulk Add or Update Tags

To bulk add or update tags, log on to the Admin Area

If you are updating:1. 

an article's tags, click on the Articles menu• 
a file's tags, click on the Files menu• 
a news' tags, click on the News menu• 

Choose Set Tags from the Actions with selected drop-down2. 

a second drop-down will display the following options:• 

Remove any tags:

Choose Remove all tags from the second drop-down box♦ 
Click OK♦ 

Add tags:

Choose Add to existing to add tags and not remove existing ones or
Replace existing to remove old tags and assign new ones 

♦ 

Click Add a tag♦ 
Assign tags from choosing existing ones or add your own tags♦ 
Click OK to save the change♦ 
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LDAP Authentication

Setting up Remote Authentication

LDAP Authentication is accessible by administrator in Settings > Ldap Authentication tab in
Admin Area.

Settings

Remote Authentication. Enabled/disabled remote authentication and set the path to
file with remote settings. To enable remote authentication set $conf['auth_remote'] = 1; 
in file [kbp_dir]/admin/config.inc.php.

• 

LDAP Options. Identify host name of your LDAP server and the port for the protocols.
The default port for LDAP over SSL is 636, for LDAP over TCP, UDP, or for TLS it
is 389. You can specify Base DN for LDAP server and user DN and password. Leave
User DN and Password fields empty for anonymous binding.

• 

Configuration. Set up the IP addresses for local authentication, specify whether to
rewrite user data on login in "Rewrite user on login" field: 0 - once user created
the data in KB will never been updated; 1 - on every authentication request, the user
data in KB will be rewritten. You also can set up the options for updating user profiles
and reseting password.

• 

Configuration Auto Authentication. In this section you can determine whether or not
auto authentication is allowed and specify the path to the file where the auto
authentication is defined.

• 

Group Mapping. Here you can set up LDAP group mapping behavior.  LDAP groups
can be either static or dynamic. A static group entry contains a list of its users. A
dynamic group is where the user entry contains a list of groups it belongs to.

• 

User Mapping Fields. Define the LDAP attributes - first name, last name, email,
remote user id and attributes for privileges and roles (optional). In your expression use
the round bracket to identify the specific characters to parse out the records as the
field. 
For user's privilege and role mapping you can give users privileges based upon their
group attributes. Click [...] button to map LDAP groups to KBPublisher Privileges and/or
Roles. 

Please note, if you set mapping LDAP groups to the KBPublisher privileges, all matched
users will be assigned the specified privilege. In case you do not have an  Unlimited
license,  the number of allowed admin users could be exceeded and privilege will not be
assigned to user.

Important!  If you leave this field blank, roles and privileges assigned for users in
KBPublisher will not be updated upon login.

• 

Test / Debug Options (optional). Set up data to test / debug authentication for actual
LDAP user.

• 
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Using Auto Authentication

Auto authentication allows you to automatically authenticate users.

Steps to enable Auto Authentication

Set the setting Auto authentication to 1 - ON, user will be logged in
automatically  in the Settings > LDAP Authentication tab

• 

Set the setting File path to where your _remoteAutoAuth defined, set it to default for
default file (admin/lib/custom/remote_auth_auto.php) 

• 

Customize the _remoteAutoAuth function to catch current user data and return it• 
Rename the function _remoteAutoAuth to remoteAutoAuth• 

Customizing the remoteAutoAuth function

In your installation there is a folder admin/lib/custom. Within that folder is a file called
remote_auth.php. This file contains the _remoteAutoAuth function. Customize this function to
get the current user's credentials.

On success, the function remoteAutoAuth should return an associative array with keys
(username, password) for the user.  For example: array('username'=>'John',
'password'=>'Test').

Here is a simple example of the function customized using HTTP authentication:

function remoteAutoAuth() {

    $user = false;

    if(isset($_SERVER['PHP_AUTH_USER']) && isset($_SERVER['PHP_AUTH_PW'])) {
         $user = array();
         $user['username'] = $_SERVER['PHP_AUTH_USER'];
         $user['password'] = $_SERVER['PHP_AUTH_PW'];
    }                

    return $user; 
}

Debugging auto-remote authentication

You can debug auto-authentication by setting Auto authentication to 2 - ON, debug mode
in the Settings > LDAP Authentication tab, which allows you to continually try relogging in so
that you can fix any problems without having to start over every time.

Important: Don't forget to reset this back to 1 (or 0) when you have finished debugging.
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Using Remote Authentication

Remote authentication allows you to integrate your organization's authentication system with
KBPublisher.
Configuration requires only a few simple steps.

Steps to enable Remote Authentication

Set the config variable $conf['auth_remote'] in the file admin/config.inc.php to 1• 
Click on Settings• 
Click LDAP Authentication  • 
Set up LDAP settings and authentication options, see this article for details• 
In case if youy want to use Auto Authentication, you set it up, see this article for details• 

Quick summary of the process

End user goes to site• 
Remote Authentication checks for valid user credentials

If auto-authentication is set, does this automatically♦ 
If auto-authentication is not set, user logs in first♦ 

• 

KBPublisher authenticates the user .• 
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Tracking logins

You can see how your remote authentication works in logs Logs/Logins

For debugging every last login is logged to a file called last_remote_login.log in the
KBPublisher cache directory (APP_CACHE_DIR in admin/config.inc.php ).
For example: /home/username/ kb_cache/last_remote_login.log
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Changes for release 5.5

Drafts

The Drafts module lets users create new articles, or modify existing published articles, without
interfering with live publications. Users can create and modify drafts in a separate area until
each draft is finished and ready to go live.

The Drafts module lets you require specific contributors to create drafts that must be approved
before publication, rather than publishing their material directly.

To learn about creating and managing your drafts, see Manage drafts.

Essential facts about drafts

Users with admin privileges can create, approve, reject, or delete any draft at any stage
in the approval process. 

• 

If a draft has been sent for approval, the author cannot update it until the review is
complete. 

• 

Your knowledgebase records approval decisions in a log for future reference.• 

Drafts and Workflows

When a draft is ready to publish, an approval workflow can route the document or item to the
assignees, one or more people assigned to review such material before publication.

Assignees can approve the article for publication or send it back to the author for more work.
They can also provide feedback on an article. The feedback is compiled and sent to the person
who initiated the workflow.

Possible scenarios when a user adds a draft

There is a matching workflow
The author of a draft can save the draft repeatedly while working on it until the material
is ready to submit. When the user submits the draft for approval, the workflow assigns it
to appropriate assignees. The user has no further access to the draft until it is approved
for publication or returned for further edits.

1. 

There is no matching workflow and the user's privileges do not permit adding
articles
The author of a draft can save the draft repeatedly while working on it. However, the
user cannot publish the draft, and there is no way to send the draft for approval. 

2. 

There is no matching workflow, and the user's privileges permit adding articles
The author of a draft can save the draft repeatedly while working on it. When the draft
is ready to publish, the user can publish it. 
Once the draft is published it no longer appears on the list of drafts, and does appear on
the list of articles.

3. 
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Automations

Use automations (automated tasks) to check your content regularly and perform certain
actions as needed. You can make sure your articles are up to date, and alert staff to review
them when they are not. You can let authors know when articles have been approved for
publication, or let managers know when articles are ready for review.

To access your automations, select Tools from the menu bar. Then select the Automations
sub-tab.

Essential facts for automations

Automations are time-based: they act when a time-based event occurs, such as the time
since an article was edited exceeding a specified maximum time.

• 

Automations run daily, at midnight.• 
An automation must contain a condition that is true only once, or an action that nullifies
at least one of the conditions; otherwise, the automation will run daily, possibly sending
unwanted duplicate alerts every time it runs.

• 
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Workflows

Workflows automate processes for reviewing, approving, and publishing articles. This can save
you time and make sure articles that may be ready to publish, but need approval, are not
overlooked. If the item requires review and approval before it is published, a workflow can
transfer the item to the worklist of the person who is responsible for approving it. That person
can approve the article or send it back for further edits.

Workflow Flowchart

The image below shows the path the draft of an article or file might have to follow if, after the
author has written or uploaded it, one or more people have to review and approve it before
publication.

Essential facts for workflows

Workflows are applied to drafts of articles and files only • 
You cannot delete or edit a workflow which in use (is applied to some drafts).• 
You can have as many approval steps in a workflow as your project's process requires.• 
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Export Articles to CVS, Excel or XML

To find the Export Articles tab, select Export from the menu bar. Then select Export Articles
from the three tabs available:

What does export articles do?

The Export Articles tab lets you export the articles and information about the articles, in
spreadsheet form. You could then review and work with the material in Excel or any other
spreadsheet tool, or use the file to import the data into a database.

To manage your exports

The tab displays a list of your export templates. Click the Action button to the right of an entry
for the action options:

Details - Review the details of exports using this template, including the date and
status of the most recent export.

Click Generate beside any export type to regenerate the export files.♦ 
Click the export type name (CSV, EXCEL, or XML) to download a ZIP file of the
exported files.

♦ 

Click Update to move from here to the Update action, or click Back to return to
the list of export templates.

♦ 

• 

Update - Update the selections or description for the export, following the information
for creating a new export, below. Click Save to save your changes; click Save and
Generate to export the data for this export again; click Cancel to abandon your
changes and close the form. 

• 

Delete - When you select this option, a confirmation form appears to make sure you
really want to delete this export template. Click OK to remove the record; click Cancel
to keep the template and end the process.

• 

To create a new export template

To create a new export template, click Add new to open the Export options form. Complete
the form to export the articles you want, and the metadata about them you select.

Title - Required. Provide a title for this template.• 
Description - Optional. Provide a description for this template.• 
Category to export - You must select at least one category. Click the + button and
select from the options available. If you need to export all KB, choose "All categories (All
KB)".

• 
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Export for user - Some articles may be invisible to certain user types. Select the user
type to filter the categories you chose to include just the content that user type can see.
Options are:

Admin User - Export includes all content in the selected categories. The system
ignores any private attributes for the user.

♦ 

Not logged in user - Export includes content a user who is not logged in can
see.

♦ 

Logged in user - When you choose this option you can specify roles to limit the
export to the content a user with a selected role can see. To add a role, click the
+ button and select from the options. If you specify no role, then the export
includes all content a logged-in user can see.

♦ 

• 

Columns - Select the columns to include in the export by dragging the names of the
columns you want from the "Columns not included in table" list to the "Columns
included in table" list. To remove columns from the export, drag the column names back
to the left-side list. You can rearrange the columns in the export table by dragging the
column names higher or lower in the right-side list.

• 

Encode images - Select this option to encode any images included in the export in
base64 format.

• 

Export published articles only - Select this option to include in the export only
published articles.

• 

Document options - You can select one or more of the export options: CSV, XML, and
EXCEL.
For CSV you can accept the defaults for the following fields, or edit the field contents to
suit your needs:

Fields terminated by - Default is a comma (,).♦ 
Fields optionally enclosed by - This allows you to include the field terminator,
such as a comma, within the text of a field. The default is double quotation marks
(").

♦ 

Lines terminated by - The default is \n.♦ 
Include field names row - Select to include a header row of all field names.♦ 

• 

Click Save to save this template; click Save and Generate to save the template and generate
files in the formats you have selected with the required data; click Cancel to close the form
without creating a template.

...
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The Views Report Explained

The Views Report lets you review how often visitors are looking at each of your articles or
documents.

The main display shows you, for each document:

the document's ID• 
the title• 
the number of views (or "hits") the document has had in the current time span• 
what percentage of all views that number represents (in the "Rate" column)• 

If there are a lot of entries, the list at the right is broken up into pages, with the number of
entries displayed at the top left. Use the navigation options at the top right to move through
the list.

You can filter the display to simplify finding what you want. The Report filter is on the left of
the screen, and you can use one or all of these filter conditions:

Type -- Choose from the available options: Article Views, File Downloads, or News
Views.

• 

Period -- Choose a time period such as "This Week". If you choose "Custom", fields
appear where you specify the start and end dates for the custom period.

• 

Limit -- Indicate how many entries to display. If you select "__", KBPublisher displays all
entries for the type you selected.

• 

Category -- Choose a category to only display items from that category. Check the
checkbox to the right of the field to also display entries in sub-categories of the category
you selected.

• 

Entry ID -- You can enter one or more document IDs, if you know them, to restrict the
display to those documents only. If you enter multiple IDs, separate them with commas
(like "22, 40, 104, 10021").

• 

Click OK to display filtered search results. If there are no results, your search may be too
restrictive: remove or relax one filter and click OK again.

To see details about document use, check the checkbox at the left end of the row for one or
more documents, then click View Details. If you want to see details for just one document, you
can double-click its title.

The Details view appears. This view has a space for a chart at the top and two tabs below.

Details View
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The details view can display a chart of document use, and has tabs to report on daily use and to
export the information.

Chart

A chart of document views can help you analyze viewing and use patterns over time. You can
display the information about the selected document or documents as a Line, Bar, or Pie
chart; or you can opt to have no chart:

Report tab

The Report tab shows the number of views for the selected document for each day in the
selected period. Sundays appear in red so you can quickly see week-by-week information:

Export tab

You can export the views data for the documents you selected. See Export Reports.

To return to the full list of documents, locate the "breadcrumbs" entry at the top of the
display. Click either Article Views or Filtered views to close the details view.

Note:  Report functionality only works when scheduled tasks are turned on
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